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Welcome

Microsoft® Windows is an extension of the DOS operating system .
Windows allows you to integrate the different tasks you perform
on your personal computer, increasing your efficiency .
With Windows, you can work with several programs at once .
You can switch between programs with a couple of keystrokes or
a click of a mouse, reducing the time required to move from one
application to another . And since you never have to quit a pro-
gram, you can continue from where you left off .
Windows provides an easy way to transfer information between
applications. You can transfer text and even graphics between
applications designed especially for Windows. You can also trans-
fer information to your Windows applications from your standard
DOS applications, such as Microsoft Word and Multiplan® .

vii

Windows is powerful

Windows is versatile
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About Windows

With Windows, you can run several different applications at once,
and switch from one to another without quitting any of them .

ypw to Prepare Cappuccino

A Bit of History

Cappuccino is said to be named for the Capuchin monks who
felt that a meal was not complete without this dessert
coffee . Cappuccino in the strictest sense is made up of
espresso topped with foamed milk, but you may want to try
adding a bit of cinnamon, nutmeg, cocoa, or whatever else
suits your taste .

Before 4ou Start

Check to see that the steam nozzle has been swung around
to the right . This gives you more freedom to move the
pitcher as yuu foam the milk .

Use larger cups (4-6 oz . size) than you use for serving
espresso .
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Microsoft Windows gives you a new and more visual way of work-
ing by organizing your work in windows - rectangular areas on
your screen in which you use applications . Many standard applica-
tions and all Windows applications can appear in windows on the
screen at the same time .

. . . . . .. . . .. . . . . . . . . .. . . . . .. . . . .... . .. . . ... . . . . .. . . . . . . . .. . . ... .

tlultiplan
File Edit Search

t
To

	

: George
From : John
Date : 5-12-81
Re : Sales data

As you can by the recently compile
included below, the company increa
regions . The western region, hove
I think it would be appropriate to

Welcome ix

6 Sales by Region (1,000'5
7
8 Region 1985 1986

10 North 12i 133
11 South 51i 67
12 East 101 109
13 West i2 89

15 Total 321 398
16
17
18
19
20

COMMAND : u Blank Copy Delete Edit
ane Options Print Quit Run S

Select option or type conman letter
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Windows provides an easy method for running your applications,
including drop-down menus, icons, and the choice of using your
keyboard, a mouse, or both together .

115-DOS Executive
File

Run . . .
Load . .
Copy . . .
Get Info
Delete . . .
Print . . .
Rename . . .

DUIHI5 .IX!
HELUA .FON
MODERN .ION
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WAI

Exit
About MS-DOS Exec . .

WINZdD .111N
WIN2BO .OUL
WINOLDAP .GRB
WINOLDAP .MOD
WRITE .EXE

View Special

T
XE

N

\WINDOWS

XE
EXE

f

r 1

i

You can use the DIRECTION keys (uP, DOWN, RIGHT, LEFT

I to move around the window .
Or just point with the mouse and click .



windows provides several useful Desktop applications .

File Edit Uiew Card Search
Waua Irene's Flowers

Walden Travel, Inc .
LaPorte, Morton

Isabel Rose Daycare
Brass Enterprises

Barnett, d . (dentist)

MR

555-1215
188 Medical-Dental Bldg ., Sea

- Works fast
- Rates within insurance quid
- Call 3- weeks ahead
- Short wait in waiting room

magazines)

27588 .

	:	h::::
.ar~dfil.e_BUSCRROS

.: :C::::	

Calculator

Edit

Windows makes it easy to combine information from several
applications . You can work in one application,

Welcome xi
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You're Invited

Jesse and I are staging another cf our famous parties, this time in
our new home . We have a huge yard (which, thank goodness, the previous
owners put in), with lots of lawn for volleyball, croquet, or loafing
as suits your fancy .

Well11 provide hamburgers and hot dogs with all the tririToings, plus
soft drinks, plates, tableware, and such . Please bring a hot dish,
salad, or munchies, and anything else you want to drink . Particulars
are below ; we're off the beaten track so there's a map too .

Hope you can make it .

Date ; 6/27/87
Time ; noon to
Place, 123 Star Road, Snohamish (new here of Jesse & Rebecca ,)
Phone, 555-1215
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then you can open another application and work in it,

(nap not to
scale

1-S

Our house is about 1.2 piles fron turnoff.
Jatch for the trite sign
with our pane on it.

Exit 59-A

Highway 22 (east)

Star Road
Highway 9

stop
sign

(approx. 3 riles)

and finally, you can integrate the information from one application
into the other,

Write

	

PARTY .WRI

File Edit Search Character Paragraph Document

Time, noon to
Place : 1'' 3 Star R'sari, Sriohciii h ( new home of Je ; e & Re7_iecca ;~
Phone ; 555-1'15

(nap not to
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The Microsoft Windows Package

The Microsoft Windows package includes the following items :

∎ The Microsoft Windows Setup disk
∎ The Microsoft Windows Build disk
•

	

Microsoft Windows Displays disk
•

	

The Microsoft Windows Utilities disk(s), which contain printer
device drivers

•

	

The Microsoft Windows Fonts disk(s), which contain font files
for a variety of printers and graphics adapters

•

	

The Microsoft Windows Desktop Applications disk, which con-
tains Windows applications

•

	

The Microsoft Windows Write Program disk, which contains
the Windows Write writing program files

•

	

The Microsoft Windows User's Guide
•

	

The Microsoft Windows Desktop Applications User's Guide
•

	

The Microsoft Windows Paint User's Guide
•

	

The Microsoft Windows Write User's Guide
∎ The Microsoft Windows Quick Reference Guide

Program information (PIF) files for a number of DOS applications
are included on your Windows disks .

Note The number and names of disks included in your Windows
package may vary depending on the type of disk drives on your
computer .

What You Need

To use Microsoft Windows, you need the following :

•

	

A personal computer running the DOS operating system with
two double-sided disk drives or a hard disk (recommended)

•

	

At least 512 kilobytes (K) of memory (to run multiple applica-
tions, 640K of memory is recommended)

•

	

DOS 2 .0 or later version
•

	

A monochrome graphics monitor or color monitor
•

	

A graphics adapter card . Windows supports many different
graphics adapter cards; however, not all graphics adapter cards

Welcome xiii

What's in the
Microsoft Windows
package?

What you need to use
Microsoft Windows
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display Windows in color. For example, the IBM Color Graph-
ics Adapter (CGA) card does not display color in the high-
resolution mode required for Windows .

Using pointing

	

Windows supports a number of optional pointing devices (includ-
deviees and

	

ing the Microsoft Serial Mouse and Bus Mouse) and printers . The
printers

	

Setup program will list the available options . See the hardware
manual for your device for instructions on how to install it on
your microcomputer .

Using the

	

Note Be sure to read the README.TXT file on the Microsoft
README.TXT file

	

Windows Write Program disk . README.TXT contains updated
Windows information unavailable in this guide .

About This Guide

This guide is designed to help you explore and use Microsoft Win-
dows. The following list outlines the chapters in this guide and
their contents .

Chapter outline

	

∎ Chapter 1, "Getting Started," tells you how to set up and start
Windows on your computer. This chapter also explains the
parts of a window, and gives you some basicc pointers on using
a mouse .

s Chapter 2, "Learning Windows," gives you a step-by-step,
hands-on introduction to using Windows with the keyboard .

•

	

Chapter 3, "Learning Windows with the Mouse," gives you a
step-by-step, hands-on introduction to using Windows with the
mouse .

•

	

Chapter 4, "Techniques," outlines the way Windows functions
and describes the basic techniques you'll use in working with
Windows .

•

	

Chapter 5, "Using MS-DOS Executive," describes how you can
work in the MS-DOS Executive window to run applications ;
copy, print, or delete files ; create directories ; make a Windows
system disk; and have access to other DOS commands .

•

	

Chapter 6, "Using Clipboard," explains how Clipboard lets you
move or copy information within an application or between
applications .



• Chapter 7, "Using Control Panel," provides information on how
you can use Control Panel to adjust Windows system settings
such as date and time, printer assignments, and screen colors .

•

	

Chapter 8, "Using Spooler," describes how Spooler allows you
to print files and to view and control the jobs in the print
queue .

•

	

Chapter 9, "Using Standard Applications," provides information
on how to run applications that were not designed specifically
for Windows, such as Microsoft Word and Lotus 1-2-3 .

•

	

Chapter 10, "Using PIF Editor," describes how to use PIF Edi-
tor to create or revise program information (PIF) files so that
you can run standard applications with Windows in the most
efficient way .

•

	

Chapter 11, "Commands," describes some of the commands
you'll use most often in working with Windows .

•

	

Appendix A, "Customizing Your WIN.INI File," explains how to
work directly in your WIN.INI file to change system settings .

•

	

Appendix B, "System Messages," lists the messages that may
appear in the middle of your window to indicate that Windows
is having a problem in carrying out a specific action . A diagno-
sis of each message is given along with suggestions for solving
the problem .

•

	

Appendix C, "Speeding Up Windows with SMARTDrive,"
describes how to use the SMARTDrive disk-caching program
with your computer's expanded or extended memory to help
Windows work more efficiently .

•

	

Appendix D, "Using Special Characters," provides information
on how to use special characters such as fractions, accented
letters, or foreign currency symbols in the documents you
create with Windows .

•

	

Appendix E, "Special Notes on Running Windows," contains
additional information on using certain hardware and standard
applications, expanded memory, the CHKDSK program, and
SHIFT + PRINTSCREEN with Windows .

•

	

"Terms" contains definitions of some of the Windows, DOS,
and general computer terms used in this guide .

Welcome xv
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Notational Conventions

Understanding terms

	

Here are a few notes about the terms and typographic conven-
and typography

	

tions used in this manual .

Keynames

The names of keys are spelled out in this guide (for example,
ESCAPE, ENTER, CONTROL) and appear in small capital letters . On
your keyboard the key caps may abbreviate the names or
represent them a little differently .

Key Combinations and Sequences
A plus sign (+) used between two keynames indicates that those
keys must be pressed at the same time . For example, "Press
ALT + ESCAPE" means that you should press the ALT key and hold it
down while you press the ESCAPE key and release it. Then release
the ALT key .
A comma between two keynames indicates that those keys must
be pressed sequentially . For example, "Press ALT, SPACEBAR" means
that you should press the ALT key and release it, then press the
SPACEBAR and release it.

DIRECTION Keys
The DIRECTION keys are the four arrow keys on your computer's
keypad. The name of the individual DIRECTION key refers to the
direction the arrow points : the UP key, the DOWN key, the RIGHT

key, or the LEFT key. You use the DIRECTION keys to move the
selection, the pointer, or the insertion point on your screen .

What You Type

In this guide, anything that you should type verbatim is printed in
italic. For example, in a procedure, if you're asked to type a file
called MYLIST.TXT, what you actually type is shown in italic :
mylist. t, t. (This filename is also shown in lowercase letters since
it doesn't matter whether you type the letters in capitals or not .)

Syntax Statements

In later chapters you'll find examples of syntax statements, which
show you the format to use when you type a particular command
line. There are two kinds of information in a syntax statement, and
they're printed in this guide in two kinds of type . Everything that's
literal - that is, exactly as you would use it in a specific command
---is printed in italic. Everything that is a placeholder - a generic
word where a specific word would appear in an actual command
line (for example, the word "filename" instead of an actual, speci-
fic filename) - is printed in bold .



c: ldirectorylmemo . txt

The preceding example designates a pathname for the MEMO .TXT
file on a hard-disk drive (C:). Since directory is in bold, you
would need to provide your own name for the directory that you
want the MEMO.TXT file to be in; everything else is in italic, so
you would type it literally .

Mouse Procedures
In this guide, the mouse procedure for a particular task follows
the keyboard procedure . Mouse procedures are generally indi-
cated by a mouse icon that appears in the margin .

Terms
Many of the Windows, DOS, and general computer terms used in
this guide are defined in "Terms," which follows the appendixes .

Welcome xvii





1 Getting Started

Before you start using Microsoft® Windows, you should be familiar
with your computer and its user's manual . You need to know how
to turn the computer on, which disk drive is drive A, and what
keys you press to reset, or "boot," your computer .

1
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Setting up Windows
on a two-drive system

Making work disks

Setting Up Windows

You will use the Setup program to create a version of Windows
tailored to your computer . If you have a hard disk, Setup will put
this version of Windows in the directory you specify. If you have
two floppy-disk drives, Setup will put Windows on the floppy
disks you supply .

To Set Up Windows on a Two-Drive System

To set up Windows on a system with two floppy-disk drives, you
will need the following :

∎ Two blank, unformatted disks
•

	

Microsoft Windows Setup disk
•

	

Microsoft Windows Build disk
∎ Microsoft Windows Displays disk
•

	

Microsoft Windows Utilities disk(s)
•

	

Microsoft Windows Fonts disk(s)

To set up Windows, follow these steps :

Put the DOS disk in drive A and close the door .
j Turn on the computer. (If your computer is already on, you
can simply reboot it .)

3 Enter the date and time if DOS prompts for them .
CJ Replace the DOS disk with the Windows Setup disk .

Close the door.
Type setup and press the ENTER key.

] Follow the instructions on the screen .

The Setup program creates two disks, the startup disk and the sys-
tem disk. You'll use these disks to start and run Windows on your
two-drive system.
Setup also copies DOS to your startup disk. You may want to copy
other startup files, such as AUTOEXEC.BAT and CONFIG.SYS, to
this disk as well .
The Windows Desktop Applications disk contains applications for
you to use with Windows . When you start working in Windows,
you may want to have a work disk for each application that you
use (for example, Paint, Notepad, or Cardfile) . A work disk con-
tains a copy of a single application ; you can create and save files



for that application on the work disk . This gives you more room
to save files in each application . See Chapter 5, "Using MS-DOS®
Executive," for information on copying files .

To Set Up Windows on a Hard-Disk System

To set up Windows on a hard disk, you will need the following :

	

Setting up Windows
on a hard disk

•

	

Microsoft Windows Setup disk
∎ Microsoft Windows Build disk
∎ Microsoft Windows Displays disk
•

	

Microsoft Windows Utilities disk(s)
∎ Microsoft Windows Fonts disk(s)
•

	

Microsoft Windows Desktop Applications disk
•

	

Microsoft Windows Write Program disk

Here's how to set up Windows on a hard-disk system :

L1 Turn on the computer .
Enter the date and time if DOS prompts for them .
Put the Windows Setup disk in drive A and close the door .

L Type a. and press the ENTER key.
Type setup and press the ENTER key.
Follow the instructions on the screen .

After running Setup, store your original Windows disks in a safe
place; if Windows is ever damaged, you'll need to copy the disks
again .

Note Windows requires approximately 1 .5 megabytes of space
on your hard disk . Before you install Windows, use the DOS
CHKDSK command to see how many bytes of memory are avail-
able on your hard disk . (It is recommended that you not use
CHKDSK in Windows . See Appendix E, "Special Notes on Running
Windows," for more information on CHKDSK. )

If you make a mistake when you run Setup, such as selecting
the wrong graphics adapter, just start Setup again and repeat the
procedure.

L

L~

Chapter 1 : Getting Started 3

If you make a mistake
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You need to run the Setup program whenever you add new
hardware, such as a mouse card or a new graphics card, to your
computer system .

Setting Up Expanded Memory for Windows

If your computer has expanded memory, you may be able to use
it to store and run Windows and Windows applications . You can
use your computer's expanded memory with Windows if you have
an expanded memory manager that supports Windows. For more
information about expanded memory and how to use it with Win-
dows, see the section called "Using Expanded Memory with Win-
dows" in Appendix E, "Special Notes on Running Windows ."

Starting Windows

When you first start Windows on your two-drive system, your
screen should look something like this :

Once you have set up Microsoft Windows on your computer, you
can start learning to use Windows .

Starting Windows on

	

To start Windows on a two-drive system, follow these steps :
a two-drive system

11 Insert your Windows startup disk in drive A.
Insert your Windows system disk in drive B .
(Both disks are created with the Setup program .)
Turn on your computer .

4 Enter the date and time if you are prompted .
Type win and press the ENTER key.



MS-DOS Executive

B

WIN . CON

WIH2B0 .BIH

R :WIN STfRTUP 1

y[

M

To start Windows on a hard-disk system, do the following :

i Turn your computer on .
Lr_ Enter the date and time if you are prompted .
L3] At the system prompt, type cd and a space followed by the

pathname of the directory where you have set up your Win-
dows files, and press the ENTER key .

kJ Type win and press the ENTER key.

Your computer starts running Windows . Your screen will look
something like the following :

Chapter 1 : Getting Started 5

Starting Windows on
a hard disk
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Definitions

Highlighted selection

Control-menu box

Title bar

Disk-drive icons

Menu bar

Maximize box
Minimize box

Here are some terms that will help you learn about and use
Windows :

∎ The highlighted selection shows where you are on the
screen. If you have a mouse installed, you will also see an
arrow pointer .

∎ The work area displays the contents of a file, such as an appli-
cation, document, or drawing. The MS-DOS Executive window
runs automatically when you start Windows .

∎ The title bar displays the name of the application in that
window.

•

	

The menu bar contains the names of the command menus
in an application .

•

	

The Control-menu box can be used to display the Control
menu. This menu is common to all Windows applications .

∎ The Maximize box can enlarge your window if you have a
mouse. If you don't have a mouse, you use the Maximize com-
mand from the Control menu to do the same thing .

Work area



• The Minimize box can shrink your window to an icon if you
have a mouse. If you don't have a mouse, you use the Mini-
mize command from the Control menu to do the same thing .

•

	

The disk-drive icons represent your disk drives . The icon of
the currently-selected drive is highlighted .

•

	

Scroll bars may appear in windows that have more informa-
tion than can be displayed in the window . (See Chapter 4,
"Techniques," for an example of scroll bars and an explanation
of how to use them .)

You can find information on other Windows terms in "Terms" at
the end of this manual .
Your screens may look slightly different from those in the illustra-
tions, because Windows adapts to your computer system when
you run the Setup program .
When you start Windows for the first time, all files in your MS-
DoJS Executive window will be part of Microsoft Windows . Do
not delete or rename any of them . The files you need for the fol-
lowing exercises may appear in slightly di fferent places on your
screen than they do in the illustrations .

Chapter 1 ; Getting Started 7

Note As you run Windows, some applications may create tern-

	

Temporary files
porary files . These filenames generally begin with a tilde character
( ) and end with the .TMP extension. Do not delete these files
while Windows is running, because an application may be using
them. If you quit Windows using the End Session command, any
temporary files are automatically deleted . (They are also deleted if
you quit Windows by double-clicking the Control-menu box .) If
you quit Windows without using this command (for example,
turning off your computer while Windows is running), some tem-
porary files may remain ; you can safely delete these files.
You can change your DOS AUTOEXEC .BAT file so that these tern-
porary files are stored in a special directory . See Chapter 5, "Using
MS-DOS Executive," for more information on creating a directory
for temporary files .

Going On from Here

To learn how to work with Windows using the keyboard, go on to
Chapter 2, "Learning Windows ." To learn how to work with Win-
dows using the mouse, read the next section, "Using a Mouse with
Windows," then go on to Chapter 3, "Learning Windows with the
Mouse." If you just want a summary of the basic techniques and
features of Windows, see Chapter 4, "Techniques ."
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Using a Mouse with Windows

A mouse is a small pointing device designed to fit comfortably
under your hand. You use the mouse to move icons, expand and
shrink windows, and choose commands . Using the mouse is as
easy as pointing and clicking .

Which button

	

Microsoft Windows can be used with either a single-button or a
to press?

	

multiple-button mouse . If you have a mouse with more than one
button, use the leftmost button. The applications you use may
respond to the other buttons, but Windows uses only the leftmost
button. (You can change which button you use with Windows .
See Chapter 7, "Using Control Panel .")

Moving the

	

Moving the mouse across a flat surface moves the pointer, which
mouse

	

is the arrow on the screen .
If you run out of room for the mouse-by going off the edge of
the table, for instance-lift the mouse and put it back down
where you have more room . Lifting the mouse does not move the
pointer.
The following definitions will help you begin to use your mouse :

To

	

Do this
Mouse techniques

	

Point

	

Move the mouse until the tip of the
pointer rests on what you want to
point to .

Click

	

Quickly press and release the mouse
button .

Drag

	

Press the mouse button and hold it
down while moving the mouse .

Double-click

	

Click the mouse button twice in
rapid succession .

To click an object means to point to that object on the screen (an
icon or a menu name, for instance) and click the mouse button .

Mouse icon

	

In this manual, wherever procedures are given for both the key-
board and the mouse, the keyboard procedure comes first . The

~,

	

mouse procedure comes second, and you'll find a mouse icon in
the margin next to the beginning of the mouse procedure .
Now go on to Chapter 3, "Learning Windows with the Mouse," for
an introduction to working with Windows using your mouse .



2 Learning Windows

The exercises in this chapter will give you hands-on experience
using Microsoft Windows with a keyboard .
If you are a new user, you will find this chapter especially helpful .
The step-by-step instructions and the illustrations will tell you
exactly what to do . The chapter is divided into three exercises,
which you can complete all at once or one at a time . (If you have
a mouse, see Chapter 3, "Learning Windows with the Mouse," for
exercises designed for mouse users .)
If you're an experienced user, you'll probably want to read this
chapter to learn the new direct-access technique for selecting
menus and choosing commands with the keyboard .

9
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In this chapter, you will learn and practice the following skills :

∎ Selecting command menus
∎ Choosing commands from menus
•

	

Starting a Windows application
∎ Opening a file in Windows
•

	

Using dialog boxes
•

	

Saving an application document
•

	

Quitting an application
•

	

Moving between windows
∎ Changing the size of a window
∎ Moving windows on the screen
•

	

Shrinking a window to an icon
•

	

Ending your Windows session

Exercise 1 : Beginning a Windows Session

In this exercise, you'll learn the basics of how to select menus and
choose commands in any Windows application . Then you'll learn
the direct-access method that you can use with some Windows
applications .
First, start Windows . (If you need to review how to get started on
your system, see Chapter l, "Getting Started .")

If you have a

	

On a two-drive system, the files you need for the first exercise are
two-drive system

	

on the Windows startup disk that you created, and they appear in
your MS-DOS Executive window when you start Windows . Your
screen will look something like this :



,

	

.. . .ro:	< : ,	x.n	a.a	t . . . :. ., . . . :+~, . .. .

	

.	t	a. . ., ::.,~ . .,, ::	»•	hl	+~:. :. . .k. . .a.. . .~f.. .c ..smtwYtt••ff.CuffG~'t2s.C2•kt:?•:::!s~•.•:::~?::.,:~:::!sf:,	a	 i	t	::,	 :	:.5.:. . .!?,	 o

MS-DOS Executive

FFile Uiew Special

A B
. .

	

i

	

III

	

l

	

i

	

r

	

)

	

.

WI N .COM
WI N200 .BIN

t

On a hard-disk system, the files you need for these exercises are

	

If you have a
on your hard disk, and they appear in your MS-DOS Executive

	

hard-disk system
window when you start Windows . After you start Windows, your
screen will look something like this :

I1S DOS Executive

Ct C :CHRIS \WINDOWS

~~ REUERSI .EXE
ABC . TXT

	

ROMAN .FON
CALC .EXE

	

SCRIPT .FON
CALENDAR .EXE SPOOLER .EXE
CARDFILE .EXE TERMINAL .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA .FON
DOTHIS .TXT
HELUA .FON
MODERN .ION
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README .TXT

A :WIN STARTUP 1

TMSRA .FON
W IN .CO M
WIN . INI
WIN200 .0IN
WIN208 .OUL
WINOLDAP .GRB
WINOLDAP .MOD
WRITE .EXE

The first window you see is the MS-DOS Executive window .
MS-DOS Executive is the application program that you'll use to
start other applications, to organize your files and windows, and
to do things like change directories and format disks .

Chapter 2: Learning Windows 1 1
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The Control menu

All Windows commands are organized in menus on the menu bar .
A menu shows the names of a group of commands . Each applica-
tion has its own menus, but one, the Control menu, is common to
all applications . The action of picking a menu is called selecting
the menu. In Windows, you select the items that commands will
affect -for example, a filename or an area of the screen - and
you choose the commands that carry out the action .

Selecting the Control Menu

The Control menu is represented by a box in the upper-left
corner of every window. You use the Control menu's commands
to arrange windows on the screen. The commands allow you to
move the windows, change their size, and close them .

3aa

	

n	etssa is x	vr	r	r	r	m	ir	 k	r	r	 r	r., . •	ti	>X .

•

	

I~1S-DOS Executive ~ ~

File Uiew Special

R C C :CHRIS \WINDOWS

REUERSI .EXE
ABC .TXT
CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA .FON
DOTHIS .TXT
HELUA .FON
MODERN . ION
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README . TXT

ROMAN . ION
SCRIPT .FON
SPOOLER .EXE
TERMINAL .EXE
TMSRA JON
WI N .COM
WIN . IN!
WIN28B .BIN
WIN2O .OUL
WINOLDAP .GRB
WINOLDAP .MOD
WRITE .EXE

v.

	

Y

	

n n . . . .~n	t	 r	x	:	n.m.w	v. r

Highlighted selection

Control-menu box

The first step in selecting a menu is to press the ALT key. ALT is
the menu-access key - it lets Windows know that you are about
to select a menu. Selecting the Control menu is simple - just
press the SPACEBAR. Try it now :

El Press the ALT key .
Press the SPACEBAR.

Title bar Menu bar



The Control menu appears on your screen . The first command
in the list, Restore, is highlighted, to show that this command is
selected .

MS-DOS Executive

a

Close

CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON
DOTHIS .TXT
HELUA .ION
MODERN .FON
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README .TXT

Alt+F

ON
EXE
.EXE

TMSRA .FON
WI N .COM
WI N .IMI
WIN200 .BIN
WIN200 .OUL
WINOLDAP .GRB
WINOLDAP .MOD
WRITE .EXE

Here's how to cancel the Control menu, or any menu :

Press the ESCAPE key .

The menu disappears .

Selecting Menus and Choosing Commands
There are two ways to use the keyboard to select menus on the
menu bar and choose commands from the menus . First you'll be
introduced to the basic method that works with any Windows
application. Once you're familiar with the basic method, you'll
learn the direct-access method, which uses the underlined letters
you see in the command and menu names . You don't need to
memorize anything. Chapter 4, "Techniques," provides a reference
to both methods .
The basic method of selecting menus and choosing commands

	

The basic method
uses the DIRECTION keys to move across the Windows menu bar
and up and down the menus .

Chapter 2: Learning Windows 1 3

Canceling the Control
menu

The first step is always the same : press the ALT key. Then press

	

Moving across the
the RIGHT or LEFT keys to select a menu on the menu bar . Try this

	

menu bar
now:
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C Press the ALT key .
11 Press the RIGHT key to select each menu on the menu bar .
L Press the LEFT key to select the menus in reverse order .

Moving within a

	

To choose commands, you use the up and DOWN keys. Try select-
command list

	

ing a menu and using the up and DOWN keys to move up and down
the command list :

Choosing commands

ft
Fl
El

a

Press the ALT key.
Press the RIGHT or LEFT keys to select a menu on the menu bar .
Press the ENTER key to display the menu .

ft Press the UP or DOWN keys to move up or down the command
list .
Press the ESCAPE key to cancel the menu selection .

To choose a command from a menu, first you use the UP or DOWN
keys to select the command name, then you press the ENTER key .
Try using the View menu's Programs command . The commands
on the View menu let you change the way MS-DOS Executive
displays the files in your current directory . The viewing options
are divided into three groups, and the checkmarks show which
option in each group is in effect now . You can change an option
by choosing it from the menu .
Here's what to do :

El

Press the ALT key.
Press the RIGHT key until you select the View menu .
Press the ENTER key to display the menu .



Ills-DOS Executive

1 ShortA
Long

	

I .EX
ABC

	

ION
CALC . JAII

	

.FON
CALEN Partial . . .

	

R'.EXE
CARDF Programs

	

L .EXE
LIPS

	

ION
CLOCK 'By Mane

	

PI

CONTR By pate

	

I
COURA By Size

	

.BIN
DOTHI By Mind	 .OUL
HELUA .run

	

WinUL AP .GRB
MODERN .FON

	

WINOLDAP .MOD
MSDOS .EXE

	

WRITE .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README .TXT

®®
File Uiew Special

s ~a

	

w

	

:.

	

. . .

	

.	n . .ntr.n .~s	v .e.~ . :. . a ..J	w.. . . : . ...J . .. ..v$%te .'rh~txa . . :~i?v .7~}:...~.. . .('~t.SMe{r.SAY:. . .v!'~fx}~.'n'p$T ..fi'~n.n.}:~...nor}.J~.. .~{. .n.}~s . . .n ..tr}. . . .IVs.s ..$^Btu.~	~$}ss.. . .Xv. . .:0.51 .~ .nsvm .v~.}..r.:vxs}h . .. •	~ ..nr. .. .v .Inl. .:	:.. .J~:7	}. .t :. . . . :. . :}~.~.'}.: . . .•1k .

4 Press the DOWN key until the Programs command is selected .

Uiew
Short
Long

J R11
Partial . . .
Programs

y Na me
By Date
By Size
By Kind

RIS IW%MDOWS

View menu

To choose the Programs command, press the ENTER key.

The file listing in your MS-DOS Executive window changes, and
only files with a .EXE, .COM, or .BAT extension are displayed .

Chapter 2: Learning Windows 15
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If you have a two-drive system, your screen should look some-
thing like the following :

?'• .uK	k+Y, :::. . .»yS	a? . . . .t, . ...>tt?	S~,a .m., .N.N:. .. .~tGi.. . .t~,tNf:S?nR, ..?.

	

SFA	 :. :

	

,.

113-DDS Executive

If you have a hard-disk system, your screen should look something
like this :

.

	

i
MS-DOS Executive

File View Special

R t C

CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
MSDOS .EXE
HOTEPAD .EXE
PAINT .EXE
REUERSI .EXE
SPOOLER .EXE
IERMIHAL .EXE
UIH .CO11
WRITE .EXE

C :CHRIS \WINDOWS

The DIRECTION-key method works with any Windows application .



Now you'll learn the direct-access method for choosing com-
mands. This technique works with any Windows application that
shows the underlined letters in menu and command names .
With the direct-access method, you can select any of the menus

	

Selecting a menu
on the menu bar by using the ALT key with the underlined letter
in the menu name . (You select the Control menu the same way
as before.) For example, take a look at the File menu :

El

0

Press the ALT key.
Press the F key, the underlined letter in the File-menu name .

The File menu drops down from the menu bar .

File

Run . . .
Load . . .
Copy . . .

Get Info
Delete . . .

V

Rename . . .

Exit
About MS-DOS Exec . . .

Take a look at the other menus listed in the menu bar . Remember
to press the ESCAPE key to clear a menu from your screen .
Now try using the commands in the menus. After you have
selected a menu, just press the letter that is underlined in the

	

menus
command's name. To try this out, choose the All command from
the View menu to show all your files once again in the MS-DOS
Executive window:

Press the ALT key .
Press the underlined letter, V, to select the View menu .

Chapter 2: Learning Windows 1 7
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Fl

View
1 Short
Long

All
'Partial . . .
Prograns

Press the underlined letter, A, to choose the All command .

MS-DOS Executive now shows all your files, not just the program
files.

MS-DOS Executive

A -	C~-- I C :CHRIS 1WINDOWS

~ ~ REUERSI EtiE
ABC .TXT

	

ROI'IAN .FON

By Mane
By Date
By Size
By Kind

CALC .EXE

CALENDAR .EXE
CARDIILE .ESE

CLIPBRD .EXE
CLOCK .EXE

CONTROL .EtiE
COURA .FON
DOTHIS .TXT

HELUA .FON
I'10DERN .FON
I'ISDOS .EXE
NOTEPAD .EXE
PAIN1 .EXE

PRACTICE .WRI
READI'E .TXT

SCRIPT .ION

SPOOLER .EXE
TERh1I NAL .EtiE
TPISRA .ION
41IN .COI1

4IIN .INI
WIN200 .BIN
WIN200 .OUL

WINOLDAP .GRB
WINOLDAP .1'10D

'RITE .EXE

With the direct-access method, you press the underlined letter
in the menu name to select the menu, then you press the under-
lined letter in the command name to choose the command. Your
commands are started right away . You don't need to press the
ENTER key .



Ending Your Windows Session

You can end your Windows session now or go on to the next

	

Quitting Windows
exercise . Ending your session is as easy as choosing a command :

0
F'

Press the ALT key.
Press the S key to select the Special menu .

Special

End Session
Create Directory . . .
Change Directory . . .
Format Data Disk . . .
Make System Disk . . .
Set Uolume Mane . . .

C The End Session command is already selected . You can press E
or just press the ENTER key to choose it .

A message appears on your screen asking if you want to end the
session. The OK button is already selected .

t C

REUERSI .EXE
ROMAN .. ION
SCRIPT JON
SPOOLER .EXE

ABC .TX1
CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON
DOTHIS .TXT
HELUA JON
MOD ERN .FON
MSDOS .EXE

	

WRITE .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README .TXT

End Session

This will end your Windows session .

;Cancel

Chapter 2: Learning Windows 1 9
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If you want to end your Windows session now, here's what to do :

0 Press the ENTER key to choose the OK button .

If you want to go on to the next exercise, do this :

Press the ESCAPE key to cancel the command .

In this exercise, you've covered the basics of selecting menus and
choosing commands. In the next exercise, you'll sharpen these
skills, and you'll learn to start a Windows application, open a file,
use dialog boxes, and save a document .

Exercise 2 : Using Notepad

In this exercise, you'll start a Windows application, Notepad, and
use it to edit a sample file included on your Windows Desktop
Applications disk .
First start Windows, if you need to . (If you need a refresher, see
Chapter 1, "Getting Started .")

Two-drive system

	

If you have a two-drive system, you need to insert another disk
and select drive A to do this exercise :

U

4

Li

Remove the startup disk from drive A .
Insert the Windows Desktop Applications disk in drive A .
Press and hold down the CONTROL key.
Press the A key.
Release the CONTROL key.

The drive A icon is highlighted, which shows that this drive is
selected . MS-DOS Executive lists the files for the Desktop Applica-
tions disk.



MS-DOS Executive

x

File View Spec

B

CALEHDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
COHTROL .EXE
NOTEPAD .EXE
PAINT .EXE
REVERSI .EXE
TERh1INAL .EXE

t

i

:APPS 1

Drive icons

Chapter 2: Learning Windows 2 1

If you have a hard-disk system, the application file for Notepad

	

Hard-disk system
(and all the Windows applications) is on your hard disk and
appears in the MS-DOS Executive window .
Now you're ready to begin . Remember, if you select the wrong
menu or decide you don't want to choose a command, just press
the ESCAPE key and start over again .

Starting Notepad

You always start applications from the MS-DOS Executive window . Starting an
To start an application, you need to select the application file - in application
this case, NOTEPAD .EXE. When you first start Windows, the first
file listed in the MS-DOS Executive window is highlighted, which
shows that this file is selected . You use the DIRECTION keys -
RIGHT, LEFT, DOWN, and UP to select the filename you want. Try
starting Notepad :

0 Press the DIRECTION keys until the filename NOTEPAD .EXE is
selected .
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®®,
I4S-DOS Executive

File view Special

R C

PIF
ABC .TXT
CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON

C :CHRIS \WINDOWS

REUERSI .EXE
ROMAN . ION
SCRIPT .FOM
SPOOLER .EXE
TERMINAL .EXE
TMSRA JON
WIN .CO'1
WI N . 1111
WIN200 .BIN

DOTHIS .TXT

	

WIN200 .OUL
HELUA . FON

	

WI NOLDAP . GRB
MODERN .FON

	

WINOLDAP .MOD
MSDOS .EXE

	

WRITE .EXE

PAINT .EXE
PRACTICE WRI
README .TXT

Press the ENTER key .

Notepad appears in front of the MSDOS Executive window,
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Opening a File
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To open files for editing with Notepad, you choose the Open

	

Opening files
command from the File menu :

Li Press the ALT key.
Press F, the underlined letter in File, to select the File menu .

L3 Press the underlined letter, 0, to choose the Open command .

The Open command's dialog box is displayed on your screen .

	

The Open dialog box
Windows uses dialog boxes to give you messages and to ask you
for any additional information - in this case, a filename- needed
to carry out a command. You can type the name of the file you
want to open in the text box, or you can select the filename from
the list box .
The list box contains a list of all the Notepad files (files with a
.TXT extension) . It also shows the disk drives, the directory one
level up from your current directory (symbolized by [ . . ] ), and any
subdirectories (directories in your current directory) . You use
the Open button or the Cancel button to complete the Open
command.

List box Text box Current directory Command buttons

MS-DOS Executive

	

®0
Notepad - (untitled)

Files
Drives

Directory one level up

Subdirectory
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As with menus and commands, there are two ways to move and
select in dialog boxes: the basic keyboard method (which works
with any Windows application) and the direct-access method
(which works with applications that have underlined letters in
the names of the items in the dialog box) .

If you make a mistake If you make a mistake while completing the information in a dia-
log box, press the ESCAPE key, just as you would to cancel a menu .
The ESCAPE key cancels the dialog box and you can start over
again.
First, experiment with using the basic keyboard method :Using the basic

method

Using the direct-
access method

a Press the TAB key several times to move from area to area
in the dialog box .

Note that the area you select with the TAB key is always marked
- usually with a dotted box . The text box is marked by a flashing
vertical line. This is the insertion point, and it shows you where
you can begin typing text. The text box shows the filename
extension for a Notepad file, .TXT.
Now try the direct-access method :

0

4

Press and hold down the ALT key.
Press F, the underlined letter in the list-box title .

Open File Mane :

* .TXT

Files in C :WIMDOWS

(OILY . I I
tin .
README . TXT
[-A-]
[-C-]
[ . .]
[PIF]

t

r

Dotted box

Open

Cancel

Press N, the underlined letter in the text-box title .
Release the ALT key.



As you press the underlined letters, each area in turn is selected .
The direct-access method works with applications that show
underlined letters in names of the items in the dialog box .
You can use either method to move in dialog boxes . The exam-
ples in this exercise use the direct-access method, but you can
also use the TAB key. Don't worry about learning exact key
sequences now. You can refer to Chapter 4, "Techniques," if
you need a review later .
Now use the File menu's Open dialog box to open a sample file,

	

Opening a sample file
DOTHIS.TXT :

0

C

0
GI
0

Press and hold down the ALT key.
Press F to move to the list box, which shows the files in your
directory.J
Release the ALT key .
Press the DOWN key to select DOTHIS .TXT. When you select
a filename in the list box, the filename is highlighted, and it
also appears in the text box .

Press and hold down the ALT key.
Press 0, to choose the Open button .
Release the ALT key.

The sample text file, DOTHIS .TXT, appears in the Notepad win-
dow, and you're ready to edit it with Notepad .

Chapter 2: Learning Windows 25
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IS-DOS Executive

Notepad - DOTHIS .TXTF

R

P
CA
CA
CA
CL
CL
CO
CO
DO
HE
MO
MS
NO
PA
PR
RE
RE

File Edit Search
RD DO

	

PRIORITY
Shop for new suit

	

B
Phone dentist

	

C
Take car in for tuneup

	

A
Make plane reservation

	

B
Pick up theater tickets B

How much?
Contact realtor

	

B
Clean garage

	

C
Mow lawn

	

B
Plan spring garden

	

B
Schedule vacation

	

A
Read "War and Peace"

	

C
Write Grandma

	

C
Buy present for Martha

	

B
Talk to Fred

	

B

Working in a File

Inserting text

	

The insertion point shows where you can start working in the file .
When you start Notepad, the insertion point is at the top of the
file. To move the insertion point, use the DIRECTION keys. You can
move to any point in the file and start typing .
For example, move the insertion point to the third line in the file
and add another item to your list :

El Press the DOWN key twice to move the insertion point to the
line beginning "Phone dentist ."
Type your new item, Pay dentist.



;MS-DOS Executiue~,
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Notepad - DOTHIS .TST
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File Edit Search
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CA
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TO DO

	

PRIORITY
Shop for near suit

	

B
Pay dentist phone dentist

	

C
Take car in for tuneup

	

A
I1ake plane reservation

	

B
Pick up theater tickets B

Hour much?
Contact realtor

	

B
Clean garage

	

C
I4ow lawn

	

B
Plan spring garden

	

B
Schedule vacation

	

A
Read "War and Peace"

	

C
Write Grandma

	

C
Buy present for Martha

	

B
Talk to Fred

	

B

Use the SPACEBAR to move the insertion point over to the
right-hand column, and give the new item a priority of D .
Press the ENTER key to move the line beginning "Phone den-
tist" to the next line .

MS-DOS Executive

Notepad - DOTHISDOTHIS .TRTTRTNotepad

File Edit Search

TO DO

	

PRIORITY
Shop for new suit

	

B
Pay dentist

	

D
phone dentist

	

C
Take car in for tuneup

	

A
flake plane reservation

	

B
Pick up theater tickets B

How much?
Contact realtor
Clean garage
blow 1aroan
Plan spring garden
Schedule vacation
Read "War and Peace"
Write Grandna
Buy present for Martha

4-

t
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Selecting text to
delete

Now delete some of the tasks on your list . To do this, you need to
select the text that you want your command to affect . Try select-
ing and deleting the next four items on your list :

Use the DIRECTION keys to move the insertion point to the line
beginning "Clean garage ."

•

	

Press and hold down the SHIFT key.
•

	

Use the DIRECTION keys to move the insertion point up and
down and to the right and left .
As you move the insertion point, the selected text is
highlighted .
After you have selected all the text you want to delete, release
the SHIFT key.

El

4

0

0

MS-DOS Executive

Notepad - DOTHIS .TXT

I

E
110
MS
MO

F

can garage
Mow lawn
Plan spring garden
Schedule vacation
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lie Edit Search

TO DO

	

PRIORITY
Shop for new suit

	

B
Pay dentist

	

D
Phone dentist

	

C
Take car in for tuneup

	

A
Make plane reservation

	

B
Pick up theater tickets B

How much?
Contact realtor

e ace
Write Grandma
Buy present for Martha

If you make a mistake If you make a mistake in selecting the right text, it's easy to
correct :

After you release the SHIFT key, press any DIRECTION key .

The text is no longer selected .

Deleting selected text

	

Once you have selected the lines, delete them by choosing the
Edit menu's Cut command :

Press the ALT key.
•

	

Press the underlined letter, E, to select the Edit menu .
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Notepad - DOTHIS .TXT

UU
PI
CR Shop
CR Pay

	

Cut
CR Phon

	

Copy
CL Take
CL I1ake

	

Clear

	

Del
CO Pick

D
CO

	

Ho
O, . Conta

Select R11

ea

	

Tine/Date 15

Mow
Plan Word Wrap

Schedule vacation

140

HO
PR

RE
RE

File Edit Search

TO D

ea i

	

ar an' ' eace
Write Grandpa
Buy present for Martha

Shift+Del
Ctrl+Ins

Press the underlined letter, T, to choose the Cut command .

The selected lines are deleted from your file .

0 Press the ALT key .
Press F to select the File menu .
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After you complete your changes to the Notepad file, you need to Saving your changes
save your edited document . Notepad has two commands for sav-
ing files: Save and Save As . The Save command saves your edited
document under the existing filename . The Save As command
saves your version under a new name that you supply, while the
original version remains unchanged . (Windows uses the DOS file-
naming convention that limits filenames to eight characters .)
In this exercise, use the Save As command from the File menu :

	

Using the Save As
command
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To choose the Save As command, press the underlined
letter, A .
A dialog box appears. The current name of the file,
DOTHIS.TXT, is in the text box .

(1 Type the new filename, mylist. txt, in the text box .

Saue File Mane As :

	

C :\WIMDOWS

nylist .txt 0K

Cancel

Press the ENTER key .

Windows saves the revised file under the new name. The original
DOTHIS.TXT remains intact .

Quitting an

	

After you're finished working with an application, you can use
application

	

the Exit command to quit the application and return to MS-DOS
Executive . Use this command to quit Notepad :

0
Press F to select the File menu .
Press X, the underlined letter, to choose the Exit command .

The Notepad window closes and you can once again see the
entire MS-DOS Executive window .

In this exercise, you learned to start a Windows application, Note-
pad, and you used it to edit and save a file . You also learned how
to use a dialog box and how to quit an application, and you re-
viewed selecting menus and choosing commands .
You can end your Windows session now or go on to the final
exercise, in which you'll learn to move windows and change their
size .

Press the ALT key.
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121 Press the ENTER key.

Clock appears on your screen .

Exercise 3 : Using Clock

In this exercise, you'll start another Windows application, Clock,
and learn to arrange and manipulate the windows on your screen .
If you quit Windows at the end of the last exercise, start Windows
again.
If you have a two-drive system, insert the Desktop Applications

	

Two-drive system
disk in drive A, then press CONTROL + A to select drive A . (In this
manual, a plus sign (+) used with two or more keynames indi-
cates a key combination : you should press and hold down the first
key, then press the next key or keys . After pressing all the keys,
release the first key.)
If you have a hard-disk system, the file for Clock, CLOCK .EXE, is

	

Hard-disk system
on your hard disk and appears in your Windows directory in the
MS-DOS Executive window .
First, start Clock :

Use the DOWN key to select CLOCK .EXE in the MS-DOS Execu-
tine window.

-Executivee
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Selecting a window

>:I1S-DOS Ezecutiue

Clock

R

PI
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CA
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WIN2I .OUL
MODERN .FON

	

WINOLDRP .GRB

MSDOS .EXE

	

WINOLDRP .MOD

MYLIST .TXT

	

WRITE .EXE
NOTEPRD .EXE

PRINT .EXE
PRACTICE .WRI

. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Notice that the title bar of Clock is darkened . This shows that
Clock is the active window- the window that your commands
will affect . The title bar of the MS-DOS Executive window is gray,
showing that it is no longer active . When you have more than
one window open, you need to select one of them as your active
window.

Changing Active Windows
Try changing your active window to MS-DOS Executive :

a Press ALT + ESCAPE .
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P11
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CONTROL .EXE
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MS-DOS Executive appears in front of Clock, and its title bar is
darkened.

Each time you press ALT + ESCAPE, the next open window is brought
to the front . If you have several applications started, pressing
ALT + ESCAPE brings windows to the front in the order that they
were started in . The window that was active goes to the back .
If you have several windows sharing the screen, check the title
bar to see which one is dark. That's your active window .
Try switching back and forth several times between Clock and
MS-DOS Executive .

Changing a Window's Size
You can change the size of a window in several ways . First, bring
MS-DOS Executive to the front if it's not your active window :

a Press ALT + ESCAPE .

MS-DOS Executive appears in front of Clock, and its title bar is
darkened.
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Using the Size

	

One way to change the size of a window is by using the Size
command

	

command on the Control menu . Try this :

0 Press the ALT key and then the SPACEBAR .

Press S to choose the Size command .

The MS-DOS Executive borders darken and a four-headed arrow
appears in the middle of the window .

Four-headed arrow

b

File Uiew Special

A --

	

C -

	

C :CHRIS \WINDOWS
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14S-DOS Executive

Moving a border

	

Now use the DIRECTION keys to change the size of your window .
The first DIRECTION key you press selects the border you will
move. The DIRECTION keys move the selected border up and down,
to the right or to the left . Try moving the right border of MS-DOS
Executive :

0 Select the right border by pressing the RIGHT key .
Make the window narrower by pressing the LEFT key a few
times.
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Now press the DOWN key. The arrow pointer moves to the
lower-right corner.

118-DOS Executive

. . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . ... . . . .. . . . . .. . . . . . . . . . . . . . . . .. . . . . .. . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . .. . . . . . . . . . ... . . . .. . . . . . . . . . . . . . . .. . . . . . . . . . .. . . . . . . . . . . .. . . .. . . . . . .. . . . . . . ...

File View Special

A ---

	

C :CHRIS \WINDOWS

PIF

	

README .TXT
ABC .TXT

	

REUERSI .EXE
CALC .EXE

	

ROMAN.FON
CALENDAR .EXE SCRIPT .FON
CARDFILE .EXE SPOOLER .EXE
CLIPBRD .EXE

	

TERMINAL .EXE
TMSRA .ION

CONTROL .EXE

	

WIN .CO M
COURA .FON

	

WIN.INI
DOTHIS .TXT

	

WIN2O0.BIN
HELUA .FON

	

WIN2BO .OUL
MODERN .FON

	

WINOLDAP .GAB
MSDOS .EXE

	

WINOLDAP .MOD
MYLIST .TXT

	

WRITE .EXE
NOTEPAD .EXE
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Chapter 2: Learning Windows 35



36 Microsoft Windows User's Guide

4

You can now move the corner up and down or to the right
and to the left . (If, after you select a border, you decide that
you don't want to change your window size, it's easy to cancel
the Size command by pressing the ESCAPE key.)
Use the uP key to move the corner up .
When you finish moving the borders, press the ENTER key to
choose the new size .

Your window assumes the new size .

Experiment with the Size command to see how you can use it
to adjust the size of your window .

Shrinking a Window to an Icon

Using the Minimize

	

Another way you can change the size of a window is by using the
command

	

Minimize command . This command shrinks a window and turns it
into an icon. The application is still running but it doesn't take up
as much space on the screen . Try using the Minimize command
on Clock :

0
11

Press ALT±ESCAPE to select Clock as your active window .
Press ALT and then the SPACEBAR to select Clock's Control
menu .
Press N, the underlined letter in the Minimize command .

Clock becomes an icon in the lower-left corner of your screen .

f1S DOS Executive

P11 PAINT .EXE WRITE .EXE
ABC .TXT PRACTICE .WRI
CALC .EXE README .TXT
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HELUA .FON WIN .INI
MODERN .FON WIN20O .BIN
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MYLIST .TXT WINOLDAP .GRB
NOTEPAD .EXE WINOLDAP .MOD



Windows puts applications in the lower portion of the screen
when they have been shrunk to icons. Clock continues to run, and
the time is still visible .
You can select icons the same way you select windows, and you

	

Selecting an icon
can display the icons' menus as well . MS-DOS Executive is your
active window now. Select Clock :

Press ALT + ESCAPE .

The icon's title appears .

Moving a Window or an Icon

0

Another command in the Control menu, Move, lets you move
windows or icons on your screen .
Try using the Move command to move the Clock icon :

Select the Control menu by pressing ALT, SPACEBAR. (In this
manual, a keyname followed by a comma and another keyname
indicates a key sequence : you should press and release the first
key, then press and release the second key .)
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. . . . . .. . . . . . . . . . . . . . . . .. . . . . . . . .

Clock
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IS-DOS Executive ::

File View Special

A	

PIF
ABC .TXT
CALC .EXE
CALEHDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA .ION

Restore Alt+FS

Close

	

Alt+R
About Clock . . .

C :CHRIS \WINDOWS

PAIHT .EXE

	

WRITE .EXE
PRACTICE .WRI
README .TXT
REVERSI .EXE
ROMAN .FON
SCR IPT .FON
SPOOLER .EXE
TERMINAL .EXE
TMSRA .ION

Choose the Move command by pressing the underlined
letter, M .
Use the DIRECTION keys to move the icon on your screen .
(If, after you move the icon, you decide that you don't want
it moved after all, it's easy to cancel the Move command by
pressing the ESCAPE key.)
The icon becomes an empty rectangle while you move it .
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When you have positioned the icon where you want it, press
the ENTER key.
The title of the icon appears .

-DOS Executive:• •.•.
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Using the Maximize
command

Enlarging a Window

If you want to work in one window, you can use the Maximize
command to enlarge a window so that it fills the entire screen .
Try selecting the MS-DOS Executive's Control menu and choosing
the Maximize command :

El If you need to, press ALT + ESCAPE to select MS-DOS Executive
as your active window .

•

	

Press ALT, SPACEBAR to display the Control menu .
•

	

Press X, the underlined letter, to choose the Maximize
command .

MS-DOS Executive expands to take up your entire screen .

115-DOS Executive b
File
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Take a look at the Control menu :

•

	

Press ALT, SPACEBAR .



Restore R1t45
RIt+F?
Rlt+18

Minimize

	

Alt+F9

Moue
Size

Close

	

RIt+Ft

The Maximize command is grayed, showing that you can't use it
now. The Restore command is no longer grayed . This command
lets you restore a window to its previous size and location on the
screen .

Restoring a Window

Use the Restore command to reduce MS-DOS Executive to its pre- Using the Restore
commandvious size :

0 Press R or the ENTER key to choose the Restore command .

MS-DOS Executive shrinks to the size you made it when you used
the Size command.

f1S DOS Executive

t C t

b
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Restoring the Clock
window

Now use the Restore command to restore the Clock window :

1

LI

Select the Clock icon by pressing ALT + ESCAPE .

Select the Control menu by pressing ALT, SPACEBAR.

[1 Press R or the ENTER key to choose the Restore command .

Clock is restored to its previous size .



Now choose the End Session command from the Special menu

	

Ending your session
to end your Windows session :

0

0

Select the MS-DOS Executive window as your active window
by pressing ALT + ESCAPE .

Press ALT and then S to select the Special menu .

fIS DOS Executive b

n The End Session command is selected because it is listed first,
so press E or the ENTER key to choose it .

A dialog box appears, warning you that this will end your Win-
dows session .
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(
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The OK button is already selected . To end your session, do the
following :

a Press the ENTER key to choose OK.

If you want to continue working in Windows, do the following :

E1 Press the ESCAPE key .

In this exercise, you reviewed selecting menus, choosing com-
mands, and starting applications . You learned how to select the
active window when you have more than one application started .
You used the Move command. You also changed the size of win-
dows, using four different commands : Size, Minimize, Maximize,
and Restore .
You've mastered all the basic skills you need in order to use
Windows with the keyboard . Go ahead and start working with
Windows, or read further in this manual . The next chapter repeats
these exercises for users who have a mouse . Chapter 4, "Tech-
niques," reviews the things you've learned here, and provides
more advanced techniques and some shortcut commands for
accomplishing common tasks .



3 Learning Windows
with the Mouse

These exercises will give you hands-on experience using Micro-
soft Windows with a mouse . Using a mouse makes many tasks
faster and easier to learn .
If you are a new user, you will find this chapter especially helpful .
The step-by-step instructions and the illustrations will tell you
exactly what to do .
If you have a mouse installed, you can still use the keyboard tech-
niques. See Chapter 2, "Learning Windows," for more information
on working from the keyboard.
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If you have a
two-drive system

In this chapter, you will learn and practice the following skills :

•

	

Using the mouse
•

	

Selecting command menus
•

	

Choosing commands from menus
∎ Starting a Windows application
•

	

Opening a file in Windows
•

	

Using dialog boxes
•

	

Saving an application document
•

	

Quitting an application
∎ Moving between windows
•

	

Changing the size of a window
•

	

Moving windows on the screen
•

	

Shrinking a window to an icon
•

	

Ending your Windows session

Exercise 1 : Beginning a Windows Session

In this exercise, you'll learn the basics of how to select menus and
choose commands in any Windows application .
First, start Windows . (If you need to review how to get started on
your system or how to use your mouse, see Chapter 1, "Getting
Started.")
On a two-drive system, the files you need for the first exercise are
on the Windows startup disk that you created, and they appear in
your MS-DOS Executive window when you start Windows . Your
screen will look something like this :



I1S-DOS Executive

File Uiew Special

B

WI H .COH
WIH200 .BIH

f

A :WIN STARTUP 1

On a hard-disk system, the files you need for these exercises are
on your hard disk, and they appear in your MS-DOS Executive
window when you start Windows. After you start Windows, your
screen will look something like this :
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TI'ISRA JON

WI H .CO11
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WI NOLDAP .I90D
WRITE .EXE

The first window you see is the MS-DOS Executive window .
MS-DOS Executive is the application program that you'll use to
start other applications, to organize your files and windows, and
to do things like change directories and format disks .
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The Control menu

All Windows commands are organized in menus on the menu
bar. A menu shows the names of a group of commands . Each
application has it own menus, but one, the Control menu, is com-
mon to all applications . The act of picking a menu is called select-
ing the menu. In Windows, you select the items that a command
will affect - for example, a filename or an area of the screen -
and you choose the commands that carry out the action .

Selecting the Control Menu

The Control menu is represented by a box in the upper-left
corner of every window. You use the Control menu's commands
to arrange windows on the screen. The commands allow you to
move the windows, change their size, and close them .

Here's how to select the Control menu :

Point to the Control-menu box .
Click the menu box.

The Control menu appears on your screen . The first command
in the list, Restore, is highlighted, to show that this command is
selected .

Highlighted selection
Control-menu box

	

Title bar

	

Menu

MS-DOS Executive

bar
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MS-DOS Executive
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Try canceling the Control-menu display :

U Point to a blank part of the screen outside the menu .
L Click the mouse button .

The Control menu disappears . You can also cancel menu displays
by pressing the ESCAPE key.

Selecting Menus and Choosing Commands

You use the same technique to select menus on the menu bar .
Try selecting the View menu :

ITI Point to the View menu on the menu bar . (Just point to any
part of the word "View.")

J Click the menu name .
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MS-DOS Executive

	

®~

File Uiei.'j Special

A

ABC .
CALC .
CALF
CARD
CLIP
CLOG
CONT
COUR
00TH I
HELUA .
110DERN .ION
f'1SDOS .ESE
NOTEPAD .ESE
PAINT .EXE
PRACTICE .WRI
READf4E . TXT

HRIS 1WINDOWS

SI .ESE
•

	

ION
T .IOM
ER .ESE
NAL .EXE

•

	

ION
011
MI
O .BIN
O .OUL
DAP .GRB

WINLDAP .1100
WRITE .EXE

Short
Long

'All
Partial . . .
Programs

'By Name
By Date
By Size
By Kind

The View menu lets you choose how MS-DOS Executive displays
your current directory. Try selecting the other menus on the
menu bar. To make a menu disappear, click anywhere outside
the menu .

Choosing commands Choosing commands from menus is simple . Try choosing the
Programs command from the View menu :

0 Point to the Programs command .
Click the command name .

The file listing in your MS-DOS Executive window changes, and
only files with a .EXE, .COM, or .BAT extension are displayed .

If you have a two-drive system, your screen should look some-
thing like the following :



. i~':~YFf~ir'D.O:	Y.7. :	 o	r	~t.s	~ . . . .al	•n , .~,+k	~•	nvs	(~,. . . .r,,. .f...v~	v. . . .;s: ..i ..fn	~t<d. ..~•. .f. . ..K! . . .:.}YN.!':•:•fr. .4.. .!M .f:':~•	JY.d:,,a,:,yKd;Yffgm, .:f:Yfy4«f .::. •.,; .~.

I1S-DOS Executive

If you have a hard-disk system, your MS-DOS Executive window
should look something like this :

•

	

• tftQY{~/Yl,+:~f~A~'odR~f~C~kYch'LOd?:b~hY{fRk }~y~,YQ.'n }Y%f~: •̀~Ykv~7~. ~:r.!a`4fkr •, ~', ~rYC, •̀

MS-DOS Executive

t C

CALC .EXE
CALENDAR .EXE
CARDI I LE .EXE
CLIPBRD .ESE
CLOCK .EXE
CONTROL .EXE
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
REUERSI .EXE
SPOOLER .EXE
TERt1INAL .EXE
'IIH .CON
WRITE .EXE

C :CHRIS \WINDOWS

Experiment by choosing some of the other commands in the
View menu .
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Quitting Windows

Ending Your Windows Session

You can end your Windows session now or go on to the next
exercise . Ending your session is as easy as choosing a command :

Lii Point to the Special menu .
(1 Click the menu name.

:Q

	

MS-DOS Executive

End Session
Create Directory . . .
Change Directory . . .

File View

Format Data Disk . . .
Make System Disk . . .
Set Volume Name . . .

4

CALC .EXE
CRLENDAR .Ed
CARDFILE .E
CLIPBRD .EX
CLOCK .EXE
CONTROL .EXE
14SDOS .EXE
NOTEPRD .EXE
PRIN1 .EXE
REUERSI .EXE
SPOOLER .EXE
TERI'IINRL .ESE
WI N .CO11
WRITE .EXE

Point to the End Session command .
Click the command name .

A message appears on your screen asking if you want to end the
session .



t C

CALC .EXE
CALENDAR .EXE
CARDIILE .EXE
CLIPBRD .ESE
CLOCK .EXE
CONTROL .EXE
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
REUERSI .EXE
SPOOLER .EXE
TEHI'll NAL .ESE
WI N . CON
WRITE .EXE

C :CHRIS \WINDOWS

End Session

This will end your Windows session .

Cancel '1

If you want to end your Windows session, here's what to do :

G Point to the OK button .
C Click the button .

If you want to go on to the next exercise, do this :

C Point to the Cancel button .
Li Click the button .

In this exercise, you've covered the basics of selecting menus and
choosing commands with the mouse . In the next exercise, you'll
sharpen these skills, and you'll learn to start a Windows applica-
tion, open a file, use dialog boxes, and save a document .
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Exercise 2 : Using Notepad

In this exercise, you'll start a Windows application, Notepad, and
use it to edit a sample file included on your Windows Desktop
Applications disk .
First start Windows, if you need to. (If you need a refresher, see
Chapter 1, "Getting Started .")

Two-drive system

	

If you have a two-drive system, you need to insert another disk
to do this exercise :

U Remove the startup disk from drive A .
12 i Insert the Windows Desktop Applications disk in drive A .
[1 Click the drive A icon .

MS-DOS Executive displays the directory listing for the Desktop
Applications disk in drive A . The drive A icon is highlighted,
showing that it is selected . Your screen should look like this :

MS-DOS Executive
File Uiew Special

R t) B -- R :APPS 1

CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
DOTHIS .TXT
NOTEPAD .EXE
PAINT .EXE
REUERSI .EXE
TERIlINRL .EXE



MS DOS Executive

	

®0
File Uiew Special

R t C t C :CHRIS \WINDOWS

REUERSI .EXE
ABC .TXT

	

ROI'IAN .FON

CRLC .EXE

	

SCRIPT .FON

CALENDAR .EXE SPOOLER .EXE

CARDFILE .EXE TERI'lINAL .EXE
CLIPBRD .EXE

CLOCK .EXE

CONTROL .EXE

COURA .FON
DOTHIS .TXT
HELUA .FON

t'10DERN .ION
t4SDOS .EXE
NOTEPAD .EXE

PAINT .EXE
PRACTICE .4IRI

READI4E .TXT

TI'lSRA .FON
'IIN .CO11

''I IN . INI

4JIH200 .BIN
WIN200 .OUL
WINOLDAP .GRB

WINOLDAP .IIOD
4IRITE .EXE

If you did not quit Windows at the end of the last lesson, then the
directory listing in your MS-DOS Executive window will still show
only the program files . You can use the View menu's All command
to display the full directory list .
Now you're ready to begin . Remember, if you select the wrong
menu or decide you don't want to choose a command, just point
to the screen area outside the menu and click the mouse button .
The menu disappears and you can start over again .

Starting Notepad
You always start applications from the MS-DOS Executive window . Starting an
You can use the mouse to start applications . Start Notepad now :

	

application

L!i Double-click the application filename, NOTEPAD .EXE .
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If you have a hard-disk system, the application file for Notepad

	

Hard-disk system
(and all the Windows applications) is on your hard disk and
appears in the MS-DOS Executive window . The drive C icon is
highlighted, showing that it is selected . If you quit Windows at the
end of the last lesson, your screen should look something like the
following :
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145-DOS Executive

REUERSI .EXE
ABC .TXT

	

ROMAN .FON
CALC .EXE

	

SCRIPT .FON
CALENDAR .EXE SPOOLER .EXE
CARDFILE .EXE 1ERMINAL .EXE
CLIPBRD .EXE

	

T14SRA .FON
CLOCK .EXE

	

WIN .CO M
CONTROL .EXE

	

WIN.INI
COURA .FON

	

WIN200 .BIN
DOTHIS .TXT

	

WIN200 .OU1
HELUA .FON

	

4IINOLDAP .GRB
MODERN .FON

	

WINOLDAP .MOD
MSDOS .EXE

	

WRITE .EXE
NOTEPAD .EXE `,
PAINT .EXE

	

`r
PRACTICE .WRI
README .TXT

Mouse pointer
Notepad filename

Notepad appears in front of the MS-DOS Executive window .

~at~t4S0

	

<4:f46t8~9AR~Y.~:~t:~tR>i3:'t:~F!ax:. ' h'

~,

	

-DOS Executive `

Notepad - (untitled)
A

PI
AB
CA
CA
CA
CL
CL
CO
CO
DO
HE
110
14S
NO
PA
PR
RE

File Edit Search



Opening a File

To open files for editing, you select the File menu and choose
the Open command :

LL Click the File menu .
Click the Open command .

The Open command's dialog box is displayed on your screen .
Windows uses dialog boxes to send you messages and to ask you
for additional information - in this case, a filename - needed to
carry out a command. You can use your mouse to supply the
information to Windows .

List box

.V

	

~	

NAW

	

'

§ ~GA'bA~A4e~:
~MS-DOS >: ixecutue(

otepad

	

(untitle

File Edit Search

Open File Mane :

Files in

	

C :\WIMDOWS

ABC .TXT
DOTHIS .TXT
README .TXT
[-A-]
[-C-]
[ . .]
PIF]

	

~,

t
(	Open

Cancel

Text box Current directory Command buttons

Files
s

Drives
Directory one level up

Subdirectory

The list box contains a list of all the Notepad files (files with a
.TXT extension), It also shows the disk drives, the directory one
level up from your current directory (symbolized by [ . .]), and any
subdirectories (directories in your current directory) . You use
the Open button or the Cancel button to complete the Open
command .
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Opening a sample file Here's how to select the file you want to open from the dialog
box :

F Click the filename DOTHIS .TXT in the list box .
The filename is highlighted, to show that it's selected, and it is
surrounded by a dotted box, to show that the list box itself is
selected . DOTHIS.TXT now appears in the Open File Name
text box, too .

Dotted box

MS-DOS Executive

Hotepad - (untitled
File Edit Search

. :::::::.~. :s::•:: ::,	:	a,	v. ..m . :. . .w	:	}•	•	o. . . . •. . •	r.,•	:M,	•	or	:AS	M	:	r.?	: .,.?J.:4;.,•r.,,•:r:.f,J	•:	•r	~a•7. .,•77 x~s•7:., . .

r Click the Open button .

The sample text file, DOTHIS .TXT, appears in the Notepad
window, and you're ready to edit it with Notepad .



Insertion point

4 .

> -

	

Executive

Notepad - DOTHIS .TtiT

	

~

File Edit Search

PI

RB

CA

CA

CR

CL

CL

CO

CO

DO

HE

MO

MS

NO

PR

PR

RE

t

Working in a File

Move your pointer around in the Notepad screen . Notice that

	

Inserting text
when the mouse pointer is in the work area, it changes from an
arrow to an I-beam . The flashing vertical line at the top of the file
is the insertion point, the point at which new text can be typed .
You can move the insertion point to any place in the file with
your mouse .
For example, move the insertion point to the third line in the file
and add another item to your list :

Ii Click the line beginning "Phone dentist ."
Type your new item, Pay dentist.
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Use the SPACEBAR to move the insertion point over to the
right-hand column, and give the new item a priority of D .
Press the ENTER key to move the line "Phone dentist" to the
next line .

{ ~r . .. .

	

„

	

LY ff.•.• L• R :•:•: `kfRS+i^f ~'t '

	

a.•k4X ~.• a4Ck) .

MS-DOS Executive

r Notepad - DOTHIS .TXT
A File Edit Search
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TO DO
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D
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C
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C
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110

Mow lawn
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Plan spring garden

	

B
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C
present for Martha

	

B

4 +

k

L;OiL• .{S'~2ti 	 . .f~4:ofa:> 'QG~i~ifA:iS:RK9A<%i^?.^~iYINPA:!K'f.~:kYS:S{~iYfiR??ffGOt~#,~+7R•~.:AY~4CdR? . :

	

4'Y:GiO~f<f: 9i%RFC?3~ASSRtYQ~

	

kX

	

(G~t>Yl.¢t~RUCB101~f:R

	

?~•{LAS'AtLkY+.'tiic~ti~C&1Livx~}t!' :2.Yt~knbn0

rRS•f a.ki•YA`}~QX'arixSFrki~AdL$Y.̂G. :

	

j.".-'' c:: 'p'
•

•,
:i{4a;~;}:•}:•:ao~2.kv,{xd"n\lifr';v{!;Y4~.^L,?xfK:2K:?~~n~f.'•: :laa,:;'fx,' :7tfSA{f:iEf

VMS-DOS Executive

Notepad - DOTHISJXT

R File_ Edit Search
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AB
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HO
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R
plane reservation
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B
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B
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B
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Now delete some of the tasks on your list . To do this, you need to Selecting text to
select the text that you want your command to affect . Try select-

	

delete
ing and deleting the next four items on your list :

Ii Point to the line beginning "Phone dentist ."
t Drag the I-beam pointer down five lines .
3 Release the mouse button.

As you drag the I-beam pointer, the selected text is highlighted .

115-DOS Executive

Notepad - DOTHIS .TXT

A File Edit Search

CA

CA
CL
CL

CO
CO ontact realtor B
DO Clean garage c

HE Mow lawn B

MO Plan spring garden B

MS Schedule vacation A
MO Read "War and Peace" C

PA Write Grandma C

PR Buy present for Martha

	

B

RE

one entist
Take car in for tuneup A
Make plane reservation B
Pick up theater tickets B

How much?

4-

If you make a mistake, it's easy to correct :

!J Click the mouse button .

The text is no longer selected .

Once you have selected the lines, delete them by choosing the
Edit menu's Cut command :

W Click the Edit menu .
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Using the Save As
command

C Click the Cut command

The lines you selected are deleted from your file .

Saving your changes

	

The next step is to save the changes you made with Notepad .
Notepad has two commands to save documents: Save and Save As .
The Save command saves the edited version of your document
under the existing filename. The Save As command saves your
edited version under a new filename, while the original version
remains unchanged. (Windows uses the DOS file-naming conven-
tion that limits filenames to eight characters .)
In this exercise, use the Save As command from the File menu :

Click the File menu .

File

New
Open . . .
Save
Save As . . .
Print

Exit
About Notepad . . .

MS DOS. nw. .a . . Executive ~,

	

,

Notepad - DOTHIS .TXT

A File

P1 TO DI

Search

AB Shop
CA Pay '
CA

	

one
CA Take
CL Make
CL Pick

CO

	

oHta

DO Clea
HE Mow
MO Plan
MS Schedule
MO Read
PA Write
PR Buy present
RE D,

'Dr%'AOtkri?~.t

	

W ki~l~7cxQ+.i

Cut
Copy

Clear
-

Select

Word

"War and
Grandma

T ime /D a t e

vacation

AbX~Y:W?~f~f~f~a

Shift+Del
[.;r

	

Ctrl+Ins

Del

All

15

Wrap

A
Peace"

	

C
C

for Martha

	

B

`A'Rs%YRi~Ri~'PxR~k.4;4d~S~.2~t41o2~P'i~OR~SG f6.+ )F:R~~310"t~t ''

	

. . .
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[ Click the Save As command.
A dialog box appears . The current name of the file,
DOTHIS.TXT, is in the text box .
Type the new filename, mylist. txt, in the text box .

Saue File Mane As :

	

C :\WIMDOWS

n list . txt OK

Cancel

11 Click the OK button .

Windows saves the revised file under the new name. The original
DOTHIS.TXT remains intact.

After you're finished working with an application, you can use
the Exit command to quit the application and return to MS-DOS
Executive . Use this command to quit Notepad :

Click the File menu .

I

	

DOS Executiue < : :.:

Notepad - MYLIST .TXT

R

PI

AD

CA

CA

CA

CL

CL

CO

CO

DO

HE

MO

MS

MO

PA

PR

RE
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Two-drive system

Hard-disk system

Starting Clock

'v

	

4

® Click the Exit command .

The Notepad window closes and you can once again see the
entire MS-DOS Executive window .

In this exercise, you learned to start a Windows application,
Notepad, and you used it to edit and save a file. You also learned
how to use a dialog box and how to quit an application, and you
reviewed selecting menus and choosing commands .
You can end your Windows session now or go on to the final
exercise, in which you'll learn to move windows and change
their size .

'exercise 3 : Using Clock

in this exercise, you'll start another Windows application, Clock,
and learn to arrange and manipulate windows on your screen .
If you quit Windows at the end of the last exercise, start Windows
again.
If you have a two-drive system, insert the Desktop Applications
disk in drive A . To select drive A, click the drive A icon .
If you have a hard-disk system, the file for Clock, CLOCK .EXE,
appears in your Windows directory in the MS-DOS Executive
window.
The first step is to start Clock :

Double-click the application filename for Clock, CLOCK.EXE .

Clock appears on your screen .



Active-window title bar
. . . .. . .. . . . . . .. . . . . . . . . .. . . . . .. . . . .. . . . . . . . .. . . . . . ... .

CO
CO
DO
HELUA JON
MODE RN .ION
MSDOS .EXE
MY LIST .TXT
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WAI

WI N28 .OUL
WINOLDAP .GAB
WINOLDAP .MOD
WAITE .EXE

	:	:	:.:	:	
Clock b

t DOS Executive

Notice that the title bar is darkened. This shows that Clock is
the active window - the window that your commands will affect .
The title bar of the MS-DOS Executive window is gray, showing
that the window is no longer active . When you have more than
one window open, you need to select one of them as your active
window.

Changing the Active Window

Try changing your active window to MS-DOS Executive :

Click a blank area in the MS-DOS Executive window .
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113-DOS Executive

File View Special

A --

	

C :CHRIS \WINDOWS

PIF

	

README .TXT
ABC .TXT

	

REUERSI .EXE
CALC .EXE

	

ROMAN.FON
CALENDAR .EXE SCRIPT .FON
CARDFILE .EXE SPOOLER .EXE
CLIPBRD .EXE

	

TERMINAL .EXE
I r

	

TMSRA .10H
CONTROL .EXE

	

WIN .CO M
COURA .FON

	

WIN.INI
DOTHIS .TXT

	

WIN2BO .BIN
HELUA .FOM

	

WIN200 .OUL
MODERN .FON

	

WINOLDAP .GRB
MSDOS .EXE WINOLDAP .MOD

b

MYLIST .TXT

	

WRITE .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI

MS-DOS Executive appears in front of Clock, and its title bar is
darkened .

Changing a Window's Size

If you want to select a window with the mouse, part of the win-
dow must be visible on the screen . You can make Clock visible by
moving the borders of the MS-DOS Executive window. Moving the
borders with the mouse is also an easy way to change a window's
size .

Moving a window's

	

To move the window's borders and select Clock, do this :
borders

	

Point to the left border of the window . The pointer becomes
a two-headed arrow .
Drag the border to the right until Clock is revealed .
Release the mouse button .



11S DOS Executive b
File View Special

R --- C { C :CHRIS \WINDOWS

P11

	

README . TXT
ABC .TXT

	

REVERSI .EXE
CALC .EXE

	

ROMAN.FON
CALENDAR .EXE SCRIPT .FON
CARDFILE .EXE SPOOLER .EXE
CLIPBRD .EXE

	

TERMINAL .EXE
~~ TMSRA.ION
CONTROL .EXE

	

W IN .CO M
COURA .FON

	

WIN.INI
DOTHIS .TXT

	

WIN200 .BIN
HELUA .FON

	

WIN200 .OUL
MODERN .FON

	

WINOLDAP .ORB
MSDOS .EXE

	

WINOLDAP .MOD
MYLIST .TXT

	

WRITE .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI

Click the Clock window .

Clock appears in front of MS-DOS Executive, and its title bar is
darkened.

. . . . .. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
.1 -DOS Executive

∎

Clock
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Another way to select An alternative way to select the active window is to use the key-
a window

	

board. Try this technique to select MS-DOS Executive :

[ii Press and hold down the ALT key.
[1 Press the ESCAPE key.

Release the ALT key .

MS-DOS Executive appears in front of Clock .

h1S-DOS Executive

N

If your windows overlap, the one in front is the active window .
If you have several windows sharing the screen, check the title
bar to see which one is dark. That's your active window .

Moving the corners

	

You can change the size of a window in several ways . One way
of a window

	

is to drag the window borders, as you did with the MS-DOS Exec-
utive window. You can also move the corners of the window .
Try making MS-DOS Executive smaller by moving the lower-left
corner :

[i1 Point to the lower-left corner . The mouse pointer becomes
a two-headed arrow .
Drag the corner up and to the right .
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PI
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PA

	

EXE
PR

R I

Uiew Special

C :CHRIS \WINDOWS

Two-headed arrow

Release the mouse button .

Your window assumes the new size .

Shrinking a Window to an Icon

Another way you can change the size of a window is by using the Using the Minimize
Minimize box to shrink the window and turn it into an icon. The

	

box
application is still running but it doesn't take up as much space on
the screen. Try using Clock's Minimize box :

[ Select Clock with the mouse (click anywhere inside the Clock
window).

Li Click the Minimize box .
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j Minimize box

Clock

DOS Executive 4 .

CHRIS \WINDOWS

NT .EXE

	

WRITE .EXE
CT ICE .WRI
DME .TXT
ERSI .EXE
AM . ION
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OLER .EXE
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WIN200 .BIN
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Clock becomes an icon .
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Windows puts applications in the lower portion of the screen
when they are shrunk to icons . Clock continues to run, and the
time is still visible .

Moving a Window or an Icon

You can move icons and windows to any part of the screen .

	

Moving icons
Here's how to move the Clock icon :

Point to the Clock icon .
Drag the icon up the left side of the screen. The icon becomes
an empty rectangle when you drag it .

0

Release the mouse button .
The title bar appears underneath the Clock icon, showing that
the icon is selected .
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>t' . .

.-DOS Executive

t C

Moving windows

	

You move windows in a different way, by pointing to the title bar
and dragging it . Move the MS-DOS Executive window down the
screen :

II Point to the title bar .



DOS Executive .:

Drag the title bar down the screen .
You can see the new location of the window outlined as you
move .
Release the mouse button .

MS-DOS Executive is displayed in its new location.

A

	

C :CHRIS \WIHDOWS
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Enlarging a Window

Using the Maximize

	

If you want to work in one window, you can use the Maximize
box

	

box to expand a window to fill the entire screen . The Maximize
box is in the upper-right corner of a window, and you use it in
much the same way you use the Minimize box . (Some applica-
tions with windows of a fixed size have no Maximize box .) Try
using the Maximize box in the MS-DOS Executive window :

Click the Maximize box.

Maximize box

r

MS-DOS Executive enlarges to fill your entire screen. The Maxi-
mize box is gone and is replaced by a box with an up and a down
arrow. This is the Restore box .



MS`--DOS Executive

File

A

a

t C :CHRIS \WINDOWS

PIF

	

SPOOLER .EXE
ABC .TXT

	

TERMINAL .EXE
CALC .EXE

	

TMSRA .FON
CALENDAR .EXE W IN .CO M
CARDFILE .EXE WIN .INI
CLIPBRD .EXE

	

WIN2OO .BIN
r
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WIN2O9 .OUL
CONTROL .EXE

	

WINOLDAP .GRB
COURA .FON

	

WINOLDAP .MOD
DOTHIS .TXT

	

WRITE .EXE
HELUA .FON
MODERN . ION
MSDOS .EXE
MYLIST .TXT
NOTEPAD .EXE
PAIMT .EXE
PRACTICE .WRI
README .TXT
REUERSI .EXE
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SCRIPT .FON
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Restore box

b

Restoring a Window
The Restore box restores your window to its previous size and

	

Using the Restore
location. You can restore a window after you've enlarged it to its

	

box
maximum size or after you've shrunk it to an icon . The procedure
is slightly different for each case .
First, use the Restore box in MS-DOS Executive :

	

Restoring a window

Click the Restore box .

MS-DOS Executive is restored to its previous size and location
on the screen .
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a

Restoring an icon

	

To restore an icon, you double-click it. Try this with the Clock
icon :

Double-click the Clock icon .

Clock is restored to its original size and location .
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Now choose the End Session command from the Special menu,

	

Ending your session
to end your Windows session :

0

4

I

Click the MS-DOS Executive window.
Click the Special menu .

Special

End Session
Create Directory . . .
Change Directory...
Format Data Disk . . .
Make System Disk . . .

Set Volume Name . . .

Click the End Session command .
A dialog box appears warning you that this will end your
Windows session .

Click the OK button to end your Windows session, or
click the Cancel button if you want to continue working
in Windows .
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In this exercise, you reviewed selecting menus, choosing com-
mands, and starting and closing applications. You learned how to
select the active window when you have more than one window
open and to move windows and icons . You also practiced dif-
ferent ways of changing the size of windows : moving borders,
moving corners, and using the boxes on the window's title bar .
You've mastered all the basic skills you need in order to use
Windows with a mouse. Go ahead and start working with Win-
dows, or read further in this manual . Chapter 4, "Techniques,"
reviews the things you've learned here, and provides more
advanced techniques and some shortcuts for accomplishing
common tasks .



4 Techniques

This chapter describes basic techniques for working with
Microsoft Windows and gives information about some Windows
features .
Applications designed for Windows may have additional or alter-
nate ways of doing some tasks . Some Windows applications have
shortcuts for commands, options, and procedures . See your
application's manual for details .
If you have a mouse, you can mix mouse and keyboard techniques
to find the easiest way to perform a task .

79
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If you have a
two-drive system

If you have a
hard-disk system

Starting Windows

To start Windows, you use the WIN command . If you have a two-
drive system, do the following :

El

4

11

If your computer is a hard-disk system, do the following :

Turn on your computer .
•

	

Type the date and time if you are prompted to .
Type cd and a space, followed by the pathname of the direc-
tory that your Windows files are in. (The Setup program
created a directory named WINDOWS unless you specified
another directory.)
Type win and press the ENTER key.

0

4

Insert your Windows startup disk in drive A .
Insert your Windows system disk in drive B .

•

	

Turn on your computer .
Type the date and time if you are prompted to .
Type win and press the ENTER key.

When you start Windows, MS-DOS Executive is displayed on your
screen .

Starting an Application

Usually you start an application program from the MS-DOS Execu-
tive window. (If you have a two-drive system, you should insert
your application disk in drive A.)

Starting applications

	

To start an application with the keyboard, follow these steps :

El Use the DIRECTION keys to move to the filename in the MS-DOS
Executive window. (The filename will probably have a .EXE or
.COM extension.)

•

	

Press the ENTER key .

The application window appears on your screen .



To start an application with a mouse, do the following :

D Double-click the filename of the application you want to run .
(This filename usually has a .EXE or .COM extension .)

The application window appears on your screen .

Note Windows uses the leftmost mouse button . You can switch
this function to the right button by using Control Panel . See Chap-
ter 7, "Using Control Panel," for instructions .

See Chapter 5, "Using MS-DOS Executive," for information on the
different ways you can run applications .

Selecting

In Windows, you always have to select what your next action is
going to affect. You select a window and then work in it, you
select a command and then execute it, you select an area within
a file and then do something to it . The way you select varies, de-
pending on what you're doing and in what context, and the way
Windows shows that something is selected also varies . But it's use-
ful to remember the basic concept : first you select, then you do
something to what you've selected .
Windows will always show you in some way what you've selected .
For example, if you've selected a filename in MS-DOS Executive,
the filename will appear highlighted. If you've selected an icon,
the icon's Control menu will appear and its title bar will be visi-
ble. If you've selected a window, the window's title bar will be
darkened.

Selecting the Active Window or Icon

If you have started more than one application, you need to select
the one that you want your commands to affect . The selected
application's window is your active window (or icon-you select
windows and icons the same way) . You can tell which window is
active : its title bar is darkened and it is in front of any other win-
dows you have opened .
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Notepad - DOTHIS .TXT

-DOS Executive

A

PI PTO DO

	

PRIORITY
AB Shop for new suit

	

B
CA Phone dentist

	

C
CA Take car in for tuneup

	

A
CA Make plane reservation

	

B
Pick up theater tickets B

CL

	

How much?
CO Contact realtor

	

B
CO Clean garage

	

C
DO Mote lawn

	

B
HE Plan spring garden

	

B
MO Schedule vacation

	

A
MS Read "War and Peace"

	

C
HO Write Grandma

	

C
PA Buy present for Martha

	

B
PR Talk to Fred

	

B
RE ~, 1

If you select an icon rather than a window, the icon's Control
menu appears and its title bar is visible .

115-DOS Executive

File Uiew Special

A	

P11
ABC .TXT
CALC .EKE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON

Restore Alt+FS

Close
About Clock . . .

C :CHRIS \WINDOWS

PAIHT .EXE

	

WRITE .EXE
PRACTICE .WRI
README .TXT
REUERSI .EXE
ROMAN . ION
SCRIPT . ION
SPOOLER .EXE
TERMINAL .EXE
TMSRA .ION

ock

Alt+FLi

{y
0



You can select a window or icon using either the keyboard or the
mouse .
To select your next active window or icon with the keyboard, just Selecting windows or
do this :

	

icons

0 Press ALT + ESCAPE . (In this manual, a plus sign (+) used with
two or more keynames indicates a key combination: you
should press and hold down the first key, then press the next
key or keys. After pressing all the keys, release the first key .)

Repeat this step until the window or icon you want appears in
front. Windows and icons are selected in the order in which you
started them .

You can use the SHIFT key to select windows in reverse :

0

Here's how to select windows or icons with the mouse :

0

Press ALT + SHIFT + ESCAPE .

Click anywhere within the window or icon .

If the window you want to select isn't visible, you can either use
the keyboard method, or move or size the other windows until
the window you want becomes visible .

Previewing Windows or Icons

You can also preview the windows and icons you've started,
without selecting them . The frame and title bar of each applica-
tion appear, but you don't have to wait for the entire window to
appear. This is useful if you have some windows or icons hidden
by other windows or icons, and you want to flip through them
quickly without taking the time to select each one in turn .
To preview the windows and icons on your screen, do this :

	

Previewing

0 Press and hold down the ALT key.
Press the TAB key to preview each active window or icon in
order .
When you reach the window or icon you want to select,
release ALT .

The rest of your active window fills in, and the window appears
in front of the other windows . If it's an icon that you selected, the
icon is restored to its previous size and position as a window.
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When you preview windows and icons, they appear in the order
in which they were started . If you want to preview them in
reverse order, do the same thing but use the SHIFT key as well :

0 Press and hold down the ALT key and the SHIFT key.
Press the TAIL key to preview each window and icon .
When you find the window or icon you want to select, release
ALT and SHIFT.

Choosing Commands from Menus

Windows commands are organized into menus . Each application
has its own menus, and one --- the Control menu -- is common to
all applications . The Control menu is symbolized by a box at the
upper-left corner of each window ; all the other menus are repre-
sented by their names in the menu bar, which runs across the top
of each window underneath its title bar .
In Windows, you select a menu, then choose a command from
that menu. Choosing the command carries out the action . (Some
applications use a shortcut method of referring to commands that
reflects this process: the "File Open command," for instance,
refers to the Open command from the File menu .)

Menu names
Control-menu box Menu bar

c MS-DOS Executive

File Uiew Special

R C C :CHRIS 1WINOOWS

~ REUERSI .EXE
ABC .TXT

	

ROMAN.FON
CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA .IOM
DOTHIS .TXT
HELUA JON
I1ODERN .FON
MSDOS .EXE
NOTEPAD .EXE
PRINT .EXE
PRACTICE .WRI
README .TXT

SCRIPT JON
SPOOLER .EXE
TERMINAL .EXE
TMSRA .FON
WI N .CO11
WI N .INI
WIN200 .BIN
WIN200 .OUL
WINOLDAP .GRB
WI NOLDAP .MOD
WRITE .EXE



Choosing a Command

If you're using the keyboard, you have two ways to choose com-
mands from menus : the basic method, which works for all Win-
dows applications, and the direct-access method .
The basic method uses the DIRECTION keys. To choose a command Basic method
using the DIRECTION keys, do this :

0

4

11

Press the ALT key. (You can use the Flo key instead of the ALT

key.)
Use the LEFT or RIGHT keys to select a menu name on the
menu bar.
Press the ENTER key to display the menu .
Use the UP or DOWN keys to select the command you want .
Press ENTER to choose the command .
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If your application shows underlined letters in command and

	

Direct-access method
menu names, you can use the direct-access method . To choose
a command using the direct-access method, follow these steps :

0 Press the ALT key .
Press the underlined letter in the menu name

	:: • . •	ns,	s	n.A:: .n . .A.:11 .n .'.~	?$•x ...a	Z	n	4n . . . :.m	n,	v., .n, .S, . . . .}	Q	s	h . . .4	:,	:	'C:.Arn'~:x::'Lf:4:4}'•:•n•.: •.
	 • ~ • h1S-DOS Executive x

11
3

File Uiew

R

RBC .TXT
CRLC .EXE
CALENDAR .E
CRRDFILE .E
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURR .FON
DOTHIS .TXT
HELUR .FON
MODE RN .FON
MSDOS .EXE
NOTEPRD .EXE
PA INT .EXE
PRRCTICE .WRI
RERDME .TXT

Make System Disk . . .
Set Uolume Name . . .

TMSRR .FON
WI N .CO11
WIN . 1111
WI N208 .BIN
WIN288 .OU1
WINOLDRP .GRB
WINOLDRP .MOD
WA ITE .EXE
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Canceling a menu

Choosing a command If you're using the mouse, it's easy to choose a command from a
menu :

Click the menu name on the menu bar .
Click the command name .

Canceling a menu

C Press the underlined letter in the command name .

Note If more than one command or menu share the same under-
lined letter, Windows will select the first menu or command
listed. Press the underlined letter again to select the next menu
or command. To display the menu or choose the command, press
the ENTER key .

If you decide after you've selected the menu that you don't want
to choose a command, you can cancel the menu :

a Press ESCAPE .

If you decide after you've selected the menu that you don't want
to choose a command, you can cancel the menu :

Click anywhere outside the menu .

Clicking in a blank area of the window is best, so that you don't
select something else in the window without meaning to .

Checked options

	

Some menus show commands that you choose in order to set
options. Checkmarks in the menu indicate which options are
active .



j Active options

JShort
Long

\ 11A
Partial . . .

\ Programs

~By Name
By Date
By Size
By Hind

The Control Menu

In addition to the menus for each application, the Control menu
appears in all windows, and you select it a little differently . You
use its commands to manipulate windows - for example, to
change their size or move them on the screen . (Some dialog
boxes also have Control menus .)
Although you choose commands from the Control menu as you
would from any other, you select the Control menu in a different
way .

I'1S-DOS Executive

1

}t..

1
t
k

Moue Alt 17
Size Alt+18
Mininize Alt+F9
Maxinize

	

Alt+11O
0
F

CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA .FON
DOTHIS .TXT
HELUR JON
MODERN . ION
MSDOS .EXE
NOTEPAD .EXE
PRINT .EE
PRACTICE .WRI
README . TXT

TI'ISRA .ION
W IN . CO M
WIN . INI
WIN2OO .BIN
WIN2OO .OUL
WINOLDAP .GAB
WINOLDAP .MOD
WRITE .EXE
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Using the Control
menu

To select the Control menu from the keyboard, do this :

0

0

Press ALT, SPACEBAR. (In this manual, a keyname followed by a
comma and another keyname indicates a key sequence : you
should press the first key, then press the second key .)
You can use SHIFT + ESCAPE instead of ALT, SPACEBAR.

You can then use either the basic method or the direct-access
method to choose the command you want .
To select the Control menu with the mouse, do this :

In a window, click the Control-menu box, in the upper-left
corner of the window; in an icon, just click the icon.

You can then simply click the name of the command you want to
choose, as you would on any other menu .
If you choose the Size or Move commands with the mouse, you
have to complete the command by moving or sizing the window .

Inactive Commands

Inactive commands

	

When you see a command name grayed on the menu, it means
that the command is inactive and you can't currently use it .

MODERM .FOM

	

WIMOLDAP .GRB
MSDOS .EXE

	

WIMOLDAP .MOD
MOTEPAD .EXE

	

WRITE .EXE
PR IMT .EXE
PRACTICE .WRI



You may have to select something before you can use the com-
mand, or it may be that the command cannot be used with your
application - for example, the Calculator window has a fixed size,
so you can't use the Maximize or Size commands on the Control
menu .

Shortcut Keys

Some menus have shortcut keys, usually listed to the right of the

	

Shortcut keys
command name . Often these keys are combinations of the ALT or
CONTROL keys and a function key. You use these keys to choose a
command without selecting the command's menu. The following
list shows the shortcut keys for the Control menu :

Command

Restore
Move
Size
Minimize
Maximize
Close

For example, if you wanted to use the shortcut keys to enlarge a
window with the Maximize command, you would simply select
the window and press ALT + F l o .

Using a Dialog Box

Windows displays a dialog box when it needs additional infor-
mation to carry out a command . The dialog box contains areas
where you enter the information; there are different kinds of
areas depending on what kind of information is needed .

Shortcut key

ALT + F5

ALT + F7

ALT + FS

ALT + F9

ALT +F10

ALT + F4
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List box

Open File Name

Text box

Files in C :\WIMDOWS

RBC . TXT t
DOTHIS .TXT
RERDME . TXT
[-R- ]
[ - C - ]
[ . .]
[PIF] }~

(	Open

Cancel

Files

Drives
Directory one level up

Subdirectory

Current directory

Dialog-box areas

	

Here are some definitions and descriptions of the different areas
that a dialog box may have :

•

	

The text box is where you type information . The text you
type appears to the left of the insertion point, a flashing verti-
cal line, which pushes any existing text to the right as you
type .

•

	

The list box contains the names of available choices - in the
preceding illustration, the names of files and directories on the
disk, and the disk drives . Files in a dialog box are listed by
filename. Drives and subdirectories are indicated with brack-
ets; hyphens distinguish drives from directories . For example,
[-A-] represents drive A; [PIF] represents a subdirectory named
PIF. The parent directory (one level up) is represented by two
periods within brackets ([ . . ] ) . The list box may have scroll bars
if all available choices don't fit in the list box .

•

	

Command buttons carry out commands when they are
chosen; these buttons have labels - OK, Cancel, Open, Reset,
for example - to indicate what the buttons do .



Terminal Settings

LII New Line

Text size

Lines in Buffer

Translation :

Dotted box

Terminal Type c U S2

OK

* Large

58

•

	

Circular option buttons let you select options for a particu-
lar command . In a group of option buttons, only one option
at a time can be selected . Windows treats the whole group
of option buttons as a single area within the dialog box .

•

	

Square check boxes also let you select options for a particular
command. In a group of options with check boxes, several
options can be selected at the same time . Windows treats each
check box as a separate area within the dialog box .

•

	

Grayed commands or options are inactive, which means
that you can't currently use them .

Often a dialog box appears with information already in it reflect-
ing what you've selected on the screen (for example, a filename
from your MS-DOS Executive window). It can also display options
you selected earlier, or the default options preset in Windows .

Moving in a Dialog Box

Check box
Option button

~ ANSI

E Local Echo

	

Auto Wraparound

C' Small

Cancel

Command buttons

Scroll bar
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Moving from one area of a dialog box to another selects that area .

	

Moving in dialog
The area you select is always marked somehow - most often with boxes
a dotted box.
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In some cases, you'll move within an area in order to select one
of a group of items within that area - for instance, a filename
within a list box, or one option button in a group of option
buttons .

Selecting Areas with the Keyboard

The basic method

	

If you're using the keyboard, you can use either of two methods,
depending on your application. Just as you do with menus and
commands, you can use a basic keyboard method that works with
any Windows application :

[11 Press the TAB key to move from area to area in a dialog box .

You can use the same method in reverse :

0

The direct-access

	

If the items in your dialog box show underlined letters in their
method

	

names, you can use the direct-access method to move directly to
them :

D

Press SHIFT +'1 AB to move through the dialog box in the oppo-
site direction .

Press and hold down the ALT key .
Press the underlined letter in the item name .
Release the ALT key .

Selecting Areas with the Mouse

If you're using a mouse, you can select any area in a dialog box
easily :

0 Click the area .

When the area has a number of items within it, the item you click
will be selected .

Selecting Items Within an Area

Moving within an area in a dialog box is a little different from
moving between areas :

0 Use the DIRECTION keys to move from item to item within an
area.



If you've selected an item in an area and you then move to
another area, the item remains selected .
The following are the areas that you may want to move in .

Text Box

In a text box, you use the DIRECTION keys to move to the right or

	

Moving in a text box
to the left in the line . The HOME key moves to the beginning of
the line; the END key moves to the end of the line .
Moving and selecting in a text box are not the same thing. To
select text in a text box, do this :

D

You can use the mouse with the keyboard to select text in a
text box :

0

Press and hold down the SHIFT key and use a DIRECTION key to
extend the selection . Selected text is highlighted .

Press and hold down the SHIFT key.
Drag the pointer across the text you want to select .
Release SHIFT .

List Box

In a list box, you use the DIRECTION keys to move up and down in
the list . As you move in a list box, the item you move to is high-
lighted, to show that it's selected .
The HOME key moves to the top of the list and selects the first
item; the END key moves to the bottom of the list and selects the
last item .
You can also use the PAGE UP and PAGE DOWN keys to move within
a list box. These keys will move the list up or down by the
"page"- that is, as much as will fit in the visible portion of the
list box at one time - without selecting a new item. When you're
moving through the list using the PAGE UP and PAGE DOWN keys,
you may not be able to see the item that's actually selected, if it
isn't in the "page" that's visible .
To select an item that you've moved to, just do this :

	

Selecting in a list box

0 Press the SPACEBAR.

When you move to another area in the dialog box, whatever item
you selected in the list box remains selected .
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Moving in a list box
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Selecting in a list

	

You can use the mouse to select items in a list box :
box

Click the item you want to select .

If the item isn't visible, use the scroll bar to make it visible .

Group of Option Buttons

Moving in a group of

	

You can use the DIRECTION keys to move through a group of
option buttons

	

option buttons . Windows treats a group of option buttons as a
single area in the dialog box, and only one option button in the
group can be selected at a time. Moving to an item selects that
item.
You can select an option button easily with the mouse by clicking
the option button .

Choosing a Command Button

Command buttons with bold borders are defaults - options that
you're most likely to want to choose .

End Session

This will end your Windows session .

CancelC [UK. l

Choosing the default

	

You can automatically choose the default command button :
command button

Press the ENTER key.

Note Even if you have moved to another area of the dialog box,
pressing the ENTER key will still choose the default .

You can also choose a command button with the mouse :

Click the command button .



Some dialog boxes have Control menus . You can use the Close
command from the Control menu to close a dialog box that has
no OK or Cancel button .
You can always cancel a dialog box :

Press the ESCAPE key.

Moving a Window or an Icon

You can move a window or an icon using your keyboard or your
mouse.
Here's how to move a window or icon using the keyboard :

t Select the window or icon you want to move by pressing
ALT + ESCAPE or ALT + TAB .

I1 Select the Control menu by pressing ALT, SPACEBAR .

[ii Press M to choose the Move command . A four-headed arrow
appears in your window .

L Use the DIRECTION keys to move the window .
An outline of the window borders moves as you press the
DIRECTION keys.
After you have moved the window to its new location, press
the ENTER key to complete the move .
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Canceling dialog
boxes

Moving windows and
icons

Follow these steps to move a window with the mouse :

	

Moving windows

Point to the title bar of the window you want to move .
n Drag the title bar . The highlighted borders mark the position

of the window .
C After you have moved the window to its new location, release

the mouse button .

You move an icon with a mouse differently :

	

Moving icons

Point to the icon you want to move . (Point at the icon itself,
not the title bar.)

C Drag the icon to the new location on the screen .
EIiI Release the mouse button .
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Changing the Size of a Window

There are several easy ways to arrange the windows on your
screen. If you're using the keyboard, the Control-menu commands
let you change the size and shape of your windows . If you're
using a mouse, you can directly manipulate each window border
to change sizes. (You can also manipulate windows by using the
Maximize, Minimize, and Restore boxes, which are explained later
in this chapter.)

Maximize box
Control-menu box

	

'Window border

	

Minimize box

u S-DOS Executive

File Uiew Special

Note Some applications, such as Calculator and Control Panel,
have a fixed size . The Size and Maximize commands appear grayed
on the Control menu . The application window doesn't have a
Maximize box or adjustable borders . You can only shrink these
applications to icons and restore them .

R - C~ - C :CHRIS \WINDOWS

ABC .TXT
REUERSI .EXE
ROMAN .FON

CALC .EXE
CALENDAR
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
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COURA .ION
DOTHIS .TXT
HELUA .FON
MODERN . ION
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README .TXT

.EXE
SCRIPT .ION
SPOOLER .EXE
TERMINAL .EXE
TMSRA JON
WI N .COM
WIN . INI
WIN200 .BIN
WIN200 .OUL
WINOLDAP .GRB

	

f

WINOLDAP .MOD
WRITE .EXE



Fixed-size window

C
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CALC .EXE
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CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA .FON
DOTHIS .TXT
HELUA .FON
MODERN . ION
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NOTEPAD .EXE
PAINT .EXE
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README .TXT
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You can change the size and shape of your windows by using the

	

Changing windows'
Size command or by directly moving the borders with a mouse .

	

sizes
If you're using the keyboard, the Size command lets you change
the size of your windows. Here's what to do ;

a Select the active window by pressing ALT + ESCAPE or ALT + TAB .

Select the Control menu by pressing ALT, SPACEBAR .

[1 Press S to choose the Size command .
A four-headed arrow appears in the middle of your window .

Four-headed arrow



98 Microsoft Windows User's Guide

4

s

0

Press one of the DIRECTION keys to select the border you want
to move .
Use the DIRECTION keys to move the border up and down, or
right and left .
When you finish adjusting the border, press the ENTER key .

The window assumes its new size .

You can directly adjust the size of any window with borders byChanging windows'
sizes

	

using the mouse. Follow these steps :

Select the window you want to size .
Point to a border or corner that you want to move . The mouse
pointer becomes a two-headed arrow .

Two-headed arrow

4

Drag the corner or border until the window is the size you
want .
Release the mouse button .

Using the Size command or moving the borders of the windows
allows you to reduce your window to almost the size of its title
bar or to enlarge it to fill almost the entire screen .



Enlarging a Window or an Icon

You can enlarge windows and icons to fill the entire screen .

R
1ERMINAL .EXE

ABC .TXT

	

1h1SRA .FON
CALC .ESE W IN .CO M

CALENDAR .EXE WIN .INI
CARDFILE .E,XE W1N288 .BIN
CLIPBRD .EXE

	

4JIN288 .OUL

CLOCK .EXE

	

WINOLDAP .GRB
CONTROL .EXE

	

WINOLDAP .I40D
COURA .ION

	

WRITE .EXE
DOTHIS .TIT

HELUA .ION
I40DERN .ION

MSDOS .EXE
NOTEPAD .EXE

PAINT .EXE
PRACTICE .WRI

README .TXT

REUERSI .EXE
ROhIAN .ION

SCRIPT .1GM

SPOOLER .EXE

If you're using the keyboard, use the Maximize command from the Enlarging windows
and iconsControl menu. Here's what to do :

0

t C t C :CHRIS \WINDOWS

Select the window or icon you want to enlarge by pressing
ALT + ESCAPE or ALT + TAB .

Press ALT, SPACEBAR to select the Control menu .
Press X to choose the Maximize command .

Your window enlarges to fill the entire screen .

Here's how to enlarge a window to its maximum size with the
mouse :

0 Select the window you want to enlarge .
Click the Maximize box in the upper-right corner of the
window.
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Enlarging an icon

. .
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MS-DOS Executive
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i]C:CHRIS \WINDOWS

~

	

REUERSI .EXE
ABC .TXT

	

ROMAN .FON
CALC .EXE

	

SCRIPT .FON
CALENDAR .ESE SPOOLER .EXE

.

	

I

CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON
DOTHIS .TXT
HELUA JON
h10DERN . FON
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README . TXT

TI'SRA .ION
WI N .COH
WI N .INI
WIN2O0 .BIN
UIN200 .OU1
WINOLDAP .GRB
WINOLDAP .MOD
WRITE .EXE

The window fills your entire screen. Note that the Maximize box
has disappeared and the Restore box has taken its place .

You enlarge an icon with the mouse a little differently :

El Click the icon you want to enlarge .
The Control menu appears .
Click the Maximize command.

The application window fills the entire screen .

Maximize box



Shrinking a Window to an Icon

You shrink a window to an icon when you are finished working
with it, but want it easily available to use later . The application is
still running in memory (represented by the icon), but it's not
taking up space in your work area . You can do many of the same
things with an icon that you can do with a window, such as
selecting it or moving it on the screen . And when you want to
work in the window again, you can use the Maximize or Restore
commands to enlarge it . You can shrink windows to icons using
either the keyboard or the mouse .
If you are using a keyboard, follow these steps to shrink your win- Shrinking windows
dow to an icon :

	

to icons

a Select the window you want to shrink by pressing ALT + ESCAPE .

Select the Control menu by pressing ALT, SPACEBAR.

Choose the Minimize command by pressing N .

To shrink a window with the mouse, use the Minimize box in the
upper right-corner of the window . Here's how to do it :

0 Select the window you want to shrink .
Click the Minimize box .

X:7»:x•.4:•i 4:?'•~	+.~ :.i . .XTt . .i. .A	:Y	4Y.,f	xY,	i . .:.w4	A' . .?. .SA'	h.:. . :a~i	k',7f ::S:•".•:Y'•iiba:•:%:•".•:'t•:•:•::•::Ca•:•:	S. . .i	!R :	H. . :..7	~tAtt~R;~ek;k: :: •.,,•~;~:` ;:•' •: .
MS-DOS Executive

i
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File View Special

t C ({) C :CHRIS \WINDOWS

~~ REUERSI .EXE
ABC . TST

	

ROMAN . FON

R

CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA .FON
DOTHIS .TXT
HELVA .FON
MO DE RN .ION
MSDOS .EXE
NOTEPAD .EXE
PA INT .EXE
PRACTICE .WRI
README .TXT

SCRIPT .1011
SPOOLER .EXE
TERMINAL .EXE
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WI N .INI
WIN200 .BIH
WIN280 .OUL
WINOLDAP .GRB
WINOLDAP .MOD
URITE .EXE

Minimize box
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Restoring windows
and icons

Restoring a Window or an Icon

You can restore a window to its previous size and place on your
screen with the Restore command (if you're using the keyboard)
or with the Restore box (if you're using a mouse). Restore returns
your window to its original size, or to the size you last made it .
The Restore command also returns your window to its original
place on the screen, or to the place you last moved it to .
If you're using the keyboard, follow these steps to choose the
Restore command :

0

0

Select the window that you want to restore by pressing
ALT + ESCAPE or ALT + TAB . (Selecting an icon with ALT + TAB

automatically restores it.)
Select the Control menu by pressing ALT, SPACEBAR.

Restore

	

Alt+FS
Alt+F1
Alt+18

Mininize

	

Alt+F9

Moue
Size

Close

	

Alt+F

The Restore command is highlighted when you select the Con-
trol menu, so you can either press R or press the ENTER key to
choose it.

You can use the Restore box to return a window to its previous
size if you're using a mouse. Follow these steps :

Select the window that you want to restore to its original size .
The Restore box is in the upper-right corner of the window .



File

C :CHRIS \WINDOWS

~~ TERI1INAL .ESE
ABC .TXT

	

1I1SRA .FON
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C

CALC .EXE
CALENDAR .EXE

CARDFILE .EXE

CLIPBRD .EXE
CLOCK .ERE
CONTROL .EXE

COURA .FON

DOTHIS .TXT
HELUA .FON
I1ODERN .FON

MSDOS .ESE
NOTEPAD .EXE
PAINT .EXE

PRACTICE .4IRI

READI1E .TXT
REUERSI .EXE

ROIIAN .FUN

SCRIPT . ION
SPOOLER .EXE

a

Special

WIN .CO11
4)IN .INI

WI N2O .BIN

WIN200 .OUL
WINOLDAP .GRB
WI NOLDAP .I90D

l)RITE .EXE

Click the Restore box .

To restore an icon to its previous size, do the following :

Double-click the icon .

Using Scroll Bars

Some application windows and dialog boxes have scroll bars,
which let you view information that won't fit in the window .

i
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Scrolling

0

Scroll box
Left scroll arrow

Scroll box
Up scroll arrow

Right scroll arrow
Down scroll arrow

If you're using the keyboard, here's how to scroll after you have
reached the last character or item in the window :

Press the DIRECTION key in the direction you want to scroll .

For example, to scroll right, go to the rightmost character or item
on the screen and keep pressing the RIGHT key .
In addition, some applications allow you to scroll by the screenful
(that is, as much as will fit in the window or dialog box at one
time). The following list shows keys that you can use in some
applications to move in a file or dialog box . Not all applications
use these keys in the same way, so it's best to try them out in
each case .

File Edit Search

TO DO

	

PRIORITY
Shop for new suit

	

B
Phone dentist

	

C
Take car in for tuneup

	

A
Make plane reservation

	

B
Pick up theater tickets B

How much?
Contact realtor

	

B
Clean garage

	

C
11ow lawn

	

B
Plan spring garden

	

B
Schedule vacation

	

A
Read "War and Peace"

	

C
Write Grandma

	

C
3 Buy present for Martha

	

B
Talk to Fred

	

B
Take out garbage

	

B

1 Q



To scroll

	

Press

Up one screen

	

PAGE UP

Down one screen

	

PAGE DOWN

Left one screen

	

CONTROL + PAGE UP

Right one screen

	

CONTROL + PAGE DOWN

You can use the mouse to scroll to a general location in a file or
dialog box :

0 Drag the small white box (the scroll box) in the scroll bar to a
position in the scroll bar that corresponds to the general loca-
tion you want (beginning, middle, or end of the file or dialog
box).

1 Release the mouse button .

The following list details how to scroll more precisely with the
mouse :

To scroll

One line at a time

One screen at a time

Do this

Click the scroll arrows at either
end of the scroll bar .
Click the scroll bar on either
side of the scroll box .

Messages from an Inactive Window

When an inactive application needs to send you status or error

	

Messages from
information, you hear a beep ; the application then flashes its title

	

inactive windows
bar or icon. To receive the message, do the following :

Press ALT + ESCAPE or use the mouse to select the window or
icon .

The message appears as soon as you select the window or icon .
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Using the Exit
command

Quitting an Application

You quit an application - remove it from memory when you
are finished with it . To work with it again, you need to run the
application from the MS-DOS Executive window .
To quit an application, use the Exit command . This command is
usually on the first menu on the application's menu bar .

~t0t•R•~A~R??%%~..a ..?a . . .i	~	5 f	S:C.R .S,R .

MS-DOS Executive

File Uiew Special

Run . . .

Load . . .

Copy . . .

Get Info

Delete . . .

Print . . .

Rename . . .

0

0

Exit

About 115-DOS Exec . . . N
UUINI5 .IX1

	

U111Zdd .UUL

HELUA .FON

	

WINOLDAP .GRB
1'10DERN .FON

	

4IINOLDAP .MOD

14SDOS .EXE

	

WRITE .EXE

NOIEPAD .EXE
PAINT .EXE

PRACIICE .WRI

RE AD t4E .1X1

Follow these steps to quit an application using the keyboard :

Select the window of the application you want to quit by
pressing ALT + ESCAPE or ALT + TAB .

Select the first menu on the left by pressing ALT and then the
underlined letter .

•

	

Choose the Exit command by pressing X .

To use the Exit command with the mouse, do the following :

Click the window of the application you want to quit .
•

	

Click the first menu name on the left of the menu bar .
•

	

Click the Exit command .



If the application does not have an Exit command, use the Control Using the Close
menu's Close command . The Close command closes a window,

	

command
Some applications may have secondary windows or dialog boxes
with Control menus (for example, MS-DOS Executive's Get Info
command). You can use the Close command to close these secon-
dary windows, but the main window remains open and the appli-
cation continues to run. If your application has only one window
open, the Close command closes that window and removes the
application from memory .
To use the Close command with the keyboard, do the following :

El

Here's how to close an application window with a mouse :

0

Ending a Windows Session

0

2

Select the Control menu by pressing ALT, SPACEBAR.

Choose the Close command by pressing C .

Double-click the Control-menu box .

Select the Special menu with your mouse or by pressing the
ALT key and then S .
Choose the End Session command .
A dialog box asks you to confirm that you want to end the
session .
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If you close the MS-DOS Executive window and no other MS-DOS Shortcut to end your
Executive windows are on the screen, your Windows session

	

Windows session
ends .

When you end a Windows session, you quit Windows and return
to DOS. If you have applications running and files open when you
end the session, you may be prompted to save your files .
To end a session, follow these steps :

	

Ending a session
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"' f~1S-DOS Executive

t C

P11
ABC .TXT
CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON
DOTHIS .TXT
HELUA .ION
MODERN .FOH
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WAI
README .TXT

C :CHRIS \WINDOWS

REUERSI .EXE
ROMAN . ION
SCRIPT JON
SPOOLER .EXE

End Session

This will end your Windows session .

Cancel )

WRITE .EXE

l

Choose the OK button to end your session, or choose the
Cancel button to cancel the command .

Your Windows session ends and you're returned to DOS .



5 Using MS-DOS Executive

MS-DOS Executive runs automatically when you start Microsoft
Windows. MS-DOS Executive gives you access to DOS commands
so that you can run applications, copy and print files, and rename
and delete files and directories. You can also use MS-DOS Execu-
tive to create directories to organize your files into convenient
groups .
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Running MS-DOS
Executive

When you start Windows, the MS-DOS Executive window appears
on your screen .

Highlighted selection
Drive icon

Current drive

~

	

i4~'&
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MS-DOS Executive

	

®0
ViewFile

A		C :CHRIS \WINDOWS

1 I

	

REUERSI .ESE
ABC .TXT

	

RO14AN .FON

CALC .EXE

	

SCRIPT .FON
CALENDRR .EXE SPOOLER .EIE

CARDFILE .EXE TERh1INAL .EXE
CLIPBRD .EXE

CLOCK .EXE
CONTROL .EXE

COURR .FON
DOTHIS .TIT

HELUA .FON
MODERN . ION

I'SDOS .EXE
NOTEPAD .EXE

PAINT .EXE

PRACTICE .WRI
READI'1E .1XT

Special

11I1SRA .ION

4lIN .COIl

WI N .INI

WI N200 .BIN
WIN200 .OUL

WINOLDAP .GRB
WINOLDAP .MOD

WRITE .EXE

Title bar Menu bar

Current directory pathname

The MS-DOS Executive window contains the following parts :

∎ The title bar displays the application name .
•

	

The menu bar contains the names of the MS-DOS Executive
menus .

•

	

The drive icons represent the disk drives of your computer .
The current drive is selected .

•

	

The pathname shows what directory you are working in (the
current directory). The pathname consists of the drive letter,
followed by the volume name (if there is one) and the direc-
tory name. If the current directory is a subdirectory, you will
see several directory names separated from each other by
backslashes .

•

	

The directory listing shows the directories and files in the
current directory .

•

	

The highlighted selection is the item (for example, a file or
directory) that will be affected by the next command you
choose .



If the entire directory listing can't fit in the window, MS-DOS
Executive displays a scroll bar . See Chapter 4, "Techniques," for
more information on scrolling .
For detailed information on DOS directory structure and files, see
the DOS manuals provided with your computer .

Making a Selection

When you work with Windows, you must select the item that the
next command or action will affect . The selected item is high-
lighted.

Selecting a File, Directory, or Drive Icon

You use the DIRECTION keys to select a file or directory (direc-
tories are shown in bold) in the MS-DOS Executive window . You
can also select a file or directory by typing the first letter of the
filename or directory name ; for example, if you type S, you select
the first filename or directory name beginning with "S ." Typing S
again selects the second filename or directory name beginning
with "S," and so on .
The following list describes how to make selections :

	

Selecting an item

To select

	

Press

A filename or directory name

	

DIRECTION keys or initial letter
A drive icon

	

CONTROL + drive letter

Here's how to select an item with the mouse :

0 Click the drive icon, filename, or directory name you want to
select .

Note You can press the SPACEBAR to cancel a filename or direc-
tory name selection . Pressing the SPACEBAR again reselects the
filename or directory name . If you have a mouse, you can press
and hold down the SHIFT key, click the selected filename, then
release the SHIFT key to cancel a selection .
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Selecting a block
of files

Extending a Selection
Whether you use the keyboard or the mouse, you can extend a
selection to include more than one item . You can select a block
of files-files that are next to each other-or you can select files
that are scattered throughout the directory listing .
To select a block of files, follow these steps :

Use the DIRECTION keys to select the first file in the block .
•

	

Press and hold down the SHIFT key and press the DIRECTION
keys to select the rest of the files in the block .

•

	

Release the SHIFT key when you are finished selecting .

0
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Special
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ABC .TXT
CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON
DOTHIS .TXT
HELUA JON
LETTERI .TXT
LETTER2 .TX1

MODERN . ION
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE

C :CHRIS \WINDOWS

PRACTICE .WRI
README .TXT
REUERSI .EXE
ROMAN . ION
SCRIPT JON
SPOOLER .EXE
TERMINAL .EXE
TMSRA .FDN
WI N .COH
WI N .INI
WIN280 .BIN
WIN280 .OU1
WINOLDAP .GRB
WINOLDAP .MOD
WRITE .EXE

To select a block of files with the mouse, do the following :

a Press and hold down the SHIFT key and click all the files you
want to select .

•

	

Release the SHIFT key when you have selected the desired files .

Selecting scattered

	

To select files that are scattered throughout the directory listing,
files

	

follow these steps :

El Press and hold down the CONTROL, key and press the DIRECTION
keys until a dotted box surrounds a file you want to select .



4

Release the CONTROL key.
~ Press the sPACEBAR to select the file .

Repeat steps l, 2, and 3 to select all desired files .

0

	

MS-DOS Executive
File

R

Uie~~~ Special

C ~~ C :CHRIS 14IIND04~S

RERDh1E .TtiT

REUERSI .EtiE

ROh1RN .FON
SCRIPI .FON

SPOOLER .EtiE
TERh1INRl .EtiE

1h1SRR .FON
4JIN .COf4

4~IN .INI
4~IN288 .BIN

fIEIUR .FON

	

4JIN288 .OU1
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' ,~,~ 4~INOLDRP .GRB

f~10DERN .FON

	

4~INOlDRP .f~10D

h1SDOS .EtiE

	

4~RITE .EtiE

NOTEPRD .EtiE

PRINT .EtiE
PRRCTICE .4IRI

PIF
RBC .TXT
CRLC .ESE
CRLENDRR .EtiE

CRRDFILE .EtiE
CLIPBRD .EtiE

CLOCH . EtiE
CONTROL .ESE

COURR .FON

DOTNIS .TXT

To select scattered files with the mouse, follow these steps :

Press and hold down the sHIFT key and click each file you want
to select.

C Release the sHIFT key .

Starting an Application

You start applications from the MS-DOS Executive window . Start-
ing an application loads the application file into a window that
appears in front of the MS-DOS Executive window .
An application file usually has the name of the program and a .EXE
or .CUM extension as its filename. For example, the file contain-
ing the Calendar program has the filename CALENDAR .EXE.
You can start applications that are in the current directory or in
any other Windows directory .
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Starting applications
in the current
directory

Starting applications
in other directories

Starting an Application in the Current Directory

Follow this step to start an application in the current directory :

a

0

El

Select the application filename and press the ENTER key.
The application window is displayed in front of the MS-DOS
Executive window.

Here's how to start an application in the current directory with
the mouse :

Double-click the application filename .

Starting an Application in Another Directory

You can start an application that is not in the current directory by
using the File menu's Run command . The Run command lets you
supply additional information, such as a pathname or a command-
line argument .
To start an application in a different directory, follow these steps :

Select the File menu and choose the Run command . A dialog
box appears .

Run :

(OK) Cancel 7

Type the application's pathname, including the .EXE or .COM
filename extension, in the text box . Include more information
(such as an additional filename) if you need to .
Choose the OK button .

Starting an Application as an Icon

You can start an application as an icon rather than running it in
a window so that the application is ready for use but takes up
minimal space on your screen .



Follow this step to run an application as an icon :

∎ Select the filename and press SHIFT + ENTER .

The application icon appears in the icon area .

To run an application as an icon with the mouse, do the
following :

Press and hold down the SHIFT key and double-click the appli-
cation filename. Release the SHIFT key.

If you want to run an application as an icon but need to supply

	

Loading applications
additional information (such as a pathname or parameters), use

	

to run as icons
the File menu's Load command :

C Select the File menu and choose the Load command . A dialog
box appears .

Load :

(OK) Cancel 1

[I Type the application filename (or pathname if necessary),
including the .EXE or .COM extension, in the text box. Include
additional information (such as parameters) if you need to .

I1 Choose the OK button .

Starting an Application by Opening a File

Many applications supply a particular filename extension to the
files you create with them. For example, the files you create with
Notepad have a .TXT extension . With applications of this type,
you can start an application by opening one of the files you
created with it.
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Running applications
as icons

To start an application by opening one of its files, do the

	

Running applications
following :

	

by opening files

Select the name of the file you want to open in the MS-DOS
Executive window .
Press the ENTER key.
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Running applications

	

If you have a mouse, you can open the file and start the applica
by opening files

Duplicating files

tion by following this step :

El Double-click the filename .

Working with Files

A file can contain an application, graphics, or lines of text . Files in
Windows use DOS flenaming conventions . See your DOS manual
for information on naming files and directories . Since many appli-
cations automatically supply a filename extension to files you
create with them, you don't have to supply one unless you want
to. When deleting files, however, you must supply the entire
filename, including any extension .

Copying a File

You can copy a file under a new name or create a copy in a dif-
ferent directory or on another disk by using the File menu's Copy
command .
To copy a file, do the following:

Select the file you want to copy .0
C Select the File menu and choose the Copy command . A

dialog box appears . The selected filename appears in the
Copy text box .

4

Copy

To :

DOTHIS .TXT

HEW1ILE .TXT

(OK) Cancel

Type the new filename, or the pathname of the directory you
want to copy the file to, in the To text box .
If you have a two-drive system and are copying the file to
another disk, put the destination disk in drive B . (After you
finish copying, reinsert the system disk in drive B .)
Choose the OK button .



Copying a Group of Files

You can copy a group of files to a directory in one procedure .
To copy several files at once, follow these steps :

	

Duplicating a group
of files

Select all the files you want to copy.
For details on selecting groups of files, see the section called
"Extending a Selection" earlier in this chapter .

•

	

Select the File menu and choose the Copy command . A dialog
box appears. You will see the selected filenames in the Copy
text box. If you select many files, there may not be room for
all the filenames to appear in the Copy text box ; however, all
the files you've selected will still be copied .

•

	

In the To text box, type the pathname of the directory that
you want the files copied to .
If you have a two-drive system and are copying the files to
another disk, put the destination disk in drive B . (After you
finish copying, reinsert the system disk in drive B .)
Choose the OK button .

a

4

0

Note You cannot copy more than one file to a single file . You
can copy multiple files to a directory only .

Printing a File

Most applications have a command that prints files you create
with that application. You should use that command whenever
possible . However, if you want to print text files from the MS-DOS
Executive window, you can use the File menu's Print command .
You can print files from the MS-DOS Executive window by follow- Printing files
ing these steps :

Select the file you want to print .
•

	

Select the File menu and choose the Print command . A dialog
box appears with the name of the selected file in the text box .

•

	

Choose the OK button .
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Renaming files

Using the Print command creates a print-spool file that is sent to
the Spooler program. See Chapter 8, "Using Spooler" for more
information on Spooler .

Note See the hardware manual for your printer for instructions
on connecting the printer to your computer . For details on setting
up, adding, or removing a printer, see Chapter 7, "Using Control
Panel ."

Changing a Filename

If you want to change the name of a file, you can do so by using
the File menu's Rename command .
Follow these steps to rename a file :

El

a

Select the file you want to rename .
Select the File menu and choose the Rename command . A
dialog box appears with the name of the selected file in the
Rename text box .

Type the new filename in the To text box .
Choose the OK button .

Getting Information About a File

If you want more information about a particular file or group of
files, you can use the File menu's Get Info command . When you
choose Get Info, Windows displays a dialog box showing the
filename, size in bytes, and the date and time the file was created
or last changed .



Follow these steps to get information about a file :

Select the files you want information about .
•

	

Select the File menu and choose the Get Info command . The
Get Info dialog box appears. This dialog box has a Control
menu, a title bar, and if necessary, a scroll bar . If you have
selected many files, you may need to scroll to see all the infor-
mation in the dialog box .

0

Get Info

Filename

Deleting a File

0

3

Size in
bytes

When a file is no longer useful, you can delete it to make room
for other files. When you delete a file, you remove it from the
disk permanently. You delete files with the File menu's Delete
command.
To remove a file, do the following:

Date and time created
or last changed

•

	

When you are finished looking at the dialog box, select the
Control menu in the dialog box and choose the Close com-
mand, or press the ESCAPE key .

Select the file you want to delete .
•

	

Select the File menu and choose the Delete command .
A dialog box displays the name of the selected file .
Choose the OK button .

To delete more than one file at a time, select all the files you
want to delete, then follow steps 2 and 3 of the preceding pro-
cedure. If you select many files, there may not be room in the
dialog box's text box for all the filenames to appear ; however,
all the files you've selected will still be deleted .
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Removing files

LETTERI .TXT 1128 Ls/20/81

	

2 :03PM
LETTER2 .TXT 115 Li12L+l81

	

9 :21RM
TODD .TXT 193 1il2181

	

9 :33RM
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Note Do not delete temporary files while you are running Win-
dows applications other than MS-DOS Executive ; an application
may be using the temporary files . You can recognize a temporary
file by its filename : it usually begins with a tilde () and ends with
a .TMP extension . See the following section, "Organizing Tem-
porary Files," for more information .

Organizing Temporary Files

Some applications that run with Windows create temporary files .
The filename of a temporary file usually begins with a tilde char-
acter (") and ends with a .TMP extension. If you quit Windows
without using the End Session command, some temporary files
may remain in your root (\) directory . (Using the End Session
command automatically deletes temporary files at the end of each
Windows session.) You should not delete temporary files while
you are running applications other than MS-DOS Executive
because the applications may be using them . After you close
all applications except MS-DOS Executive, you can safely delete
these temporary files .
You can have Windows put all temporary files your programs
create into a special directory ; then you can quickly locate and,
if you want, delete them. If you don't specify an alternate direc-
tory, Windows places the .TMP files in your root directory .

Putting temporary

	

Follow these steps to specify where you want Windows to place
files in a directory

	

the temporary ( .TMP) files :

11 Create a directory for your temporary files . See the following
section, "Working with Directories," for information on how to
create a directory .
Add the following line to your DOS AUTOEXEC .BAT file :

set TEMP = pathname

For example, if you had created the directory TEMPDIR on drive
C, you would add the following line to your AUTOEXEC .BAT file .

set TEI'1P=c :Atenpdir

Be sure to create the directory . If you specify a directory that
doesn't exist, applications that create .TMP files will not run .



Working with Directories

You can use directories to organize your files into groups . You
can also create subdirectories within a directory .
The name of the current directory (the one you are working in)
is always shown in the pathname at the top of the MS-DOS Execu-
tive window. A pathname contains the drive letter, the volume
name (if there is one), and a sequence of directory names with
backslashes separating the names .
In the directory listing, directories are listed first . These are sub-
directories of the current directory. Directory names appear in
bold letters when the listing is in short form, as shown in the fol-
lowing example .

Directory names

	

'Current directory pathname

	:	!s	~c. :. . ..~	tin	:. ., .t . . ..w .. . .s	w	:.,r.•::::,•..za,: . .~v:	~	!:r	~	,	t~. •	:	:	s,x•	:	}	>. . ..~t .. . .h . .:. .xa:•:, . ..< . . . :. . . rr , ::

I'S-DOS Executive

File Uiew Special

R t

IEI Js

ABC .TXT

CALC .EXE
CALENDAR .EKE

CARDFILE .EXE
CLIPBRD .EXE

CLOCK .EXE
CONTROL .EXE
COURA .FON
DOTHIS .TXT
HELUA JON

MODERN .FUN
MSDOS .EXE

NOTEPAD .EXE
PAINT .EXE

PRACTICE .WRI

C :CHRIS WINDOWS

README .TXT

REUERSI .EXE
ROMAN .ION

SCRIPT .IOM

SPOOLER .EXE
TERMINAL .EXE

TMSRA .FON
WI N .COM

WIN . INI
WI N208 .BIN
WIN200 .OUL
WI NOLDAP . GRB
WINOLDAP .MOD
WRITE .EXE

Creating a Directory

You must create a directory before you can put files in it :

Select the Special menu and choose the Create Directory
command. A dialog box appears .

rl Type the new directory name in the text box .
[1 Choose the OK button.
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Once you create a directory, you can use the File menu's Copy
command to copy files into it . See the section called "Copying a
File" earlier in this chapter for details . You also can use an applica-
tion to create new files for the directory .

Changing the Directory-Listing Display

When you start Windows, the MS-DOS Executive directory listing
is displayed in alphabetical order with directory names listed first .
However, you may want to see the directory listing displayed in a
different way. You may want to see the files listed in order of
their size, or by the date they were created or changed . Or you
may want to see only files that have the same extension .
You can change the order in which files are listed by using com-
mands from the View menu .

Using the View Menu

The commands in the View menu are divided into three groups .
One command in each of the three groups has a checkmark
beside it, indicating that the command is in effect .
You can choose a command from each group in the View menu
to list your files in different ways. When you choose a command
from the View menu, it affects only the directory you are display-
ing at that time. All commands except Partial take effect as soon
as you choose them. No matter which command you choose,
directories will always be listed first .
You choose from two commands in the first group :

•

	

The Short command displays the listing in multiple columns by
filename only.

•

	

The Long command displays a one-column list containing each
file's name, extension, and size in bytes, and the date and time
it was created or last changed . Directory names are followed
by <DIR> .

You choose from three commands in the second group :

•

	

The All command lists all files in the directory .
•

	

The Partial command lets you specify a subset of the directory
to display. A description of the Partial command follows this
list of View menu commands .

•

	

The Programs command displays filenames with .EXE, .COM,
or .BAT extensions only .



You choose from four commands in the third group :

•

	

The By Name command displays the listing alphabetically by
filename .

•

	

The By Date command displays the listing by the date and
time each file was created or last changed, beginning with
the most recent date and time .

•

	

The By Size command lists files according to their size in
bytes, sorting them from largest to smallest .

•

	

The By Kind command lists files alphabetically by filename
extension .

Displaying Part of a Directory

You may not always want to see a listing of all the files in a three-

	

Using the Partial
tort', preferring instead to see only a particular group of files . For

	

command
example, you may want to see only files with the .EXh extension .
Use the Partial command to specify the kind of files you want to
display :

Select the View menu and choose the Partial command . A
dialog box appears .

0

Partial :

Cancel

In the text box, type the filenames you want to see . Use "wild-
card" characters to tell Windows which kind of file to display ;
for example, type *.EXE to display all filenames with the .EXE
extension .
Wildcard characters represent other characters in a filename .
See your DOS manual for details on using wildcard characters
to specify filenames or directory names .

LI Choose the OK button .

Changing Directories

You change directories when you want to see what is in another
directory or when you want to work with the files in another
directory. You can move from one directory to another with the
Special menu's Change Directory command .
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Moving to another
directory

Follow these steps to move to another directory :

0

El

1 Type the directory you want to go to, including a pathname if
necessary .
Choose the OK button .

Directory-changing

	

Here's how to quickly change to a subdirectory of your current
shortcuts

	

directory :

A

The ACCOUNTS directory is selected .

Select the Special menu and choose the Change Directory
command. A dialog box appears . The text box contains the
name of the directory you are working in .

Change To 1~Q~~i1i1i14~y

(OK) fCancel 1

Select the name of the directory you want to move to .

~'

	

RERDt4E .T'T

P11

	

REUERSI .EXE
BUSINESS .CRD ROhlfH .FON

CRLC .EXE

	

SCRIPT .FON

Press the ENTER key .
The MS-DOS Executive window now lists the selected
directory's contents .

ACCOUNTS directory listing

I1S DOS Executive

t C t C :CHRIS IWINDOWSIRCCOUNTS

ACCOUNTS directory pathname

JONES .CAL

LETTERS .TXT
ORDERS .TXT

- - - - - - - - - - - - - - - - - - - - - -



Here's another useful shortcut for changing directories :

0 No matter where you are or what you have selected in the
MS-DOS Executive window, you can go to the next higher
directory by pressing the BACKSPACE key.
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If you're using the mouse, you can do the following to change to

	

Changing directories
a subdirectory of your current directory :

~.0

0

Double-click the name of the directory you want to move to.

You can quickly change to a higher directory with the mouse by
following these steps :

In the pathname at the top of the MS-DOS Executive window,
click the name of the directory you want to move to . A dialog
box appears. The pathname to the left of the place you clicked
appears in the text box (you can type a different directory
pathname if you want) .

t
Uiei'i Special

C t

CLIENTSre1)
JONE S
LETTE

	

Change To :

ORDER

MS-DOS Executive

(OK)

J

Click the OK button .

Cancel

. . . to display this directory .



126 Microsoft Windows User's Guide

Shortcut

Exiting from an
MS-DOS Executive
copy

You can double-click part of the pathname at the top of the MS-
DOS Executive window to go to that directory without seeing a
dialog box .

Displaying Two Directories Simultaneously

Displaying several

	

To display two different directories at the same time, run a
directories at once

	

second MS-DOS Executive window and select a different direc-
tory or disk icon in each window :

0

Follow this step to display the contents of another disk :

D

If you're using the mouse, you can display the contents of another
disk by following this step :

0

Each copy of the MS-DOS Executive window acts independently
of the other, so you can display and work with different direc-
tories in each window .
To exit from a copy of MS-DOS Executive without ending your
Windows session, follow this step :

0

Select MSDOS.EXE (on a two-drive system, MS-DOS .EXE is
located on the Windows system disk) and press the ENTER key
to run MS-DOS Executive as another window .
In the new MS-DOS Executive window, display the directory
that you want to see by using one of the previously described
procedures .

Press and hold down the CONTROL key, press the drive letter,
then release the CONTROL key to choose a drive icon ; this
displays the directory listing for the disk in that drive .

Click the desired drive icon .

Select the File menu and choose the Exit command .



Printing a Directory Listing
You can print a subdirectory listing by following these steps :

II

a

To print the current directory listing, follow these steps :

II

Deleting a Directory
Before you can delete a directory, you must first delete all files in
the directory. Windows will not delete a directory that contains
files. This feature protects you from losing files should you unin-
tentionally try to delete a directory .
To delete a directory, do the following :

Select all the files in the directory that is to be deleted .
•

	

Select the File menu and choose the Delete command . A
dialog box appears with as many of the selected filenames
in the text box as will fit.

•

	

Choose the OK button .
If the directory you want to delete is your current directory,
move to the next higher directory . You can't delete your
current directory.

•

	

Select the name of the directory you want to delete .
Select the File menu and choose the Delete command . A
dialog box appears with the selected directory name in the
text box .
Choose the OK button .

0

4

6

7

Select the directory name from the current directory listing .
•

	

Select the File menu and choose the Print command . A dialog
box appears. The text box contains the selected directory
name .
Choose the OK button .

Cancel the selection of any files or directories .
To cancel a selection, press the SPACEBAR . To cancel a selection
with the mouse, press and hold down the SHIFT key, click the
selected filename, then release the SHIFT key .

•

	

Select the File menu and choose the Print command . A dialog
box appears . The text box contains the current directory
name .

•

	

Choose the OK button .

Chapter 5: Using MS-DOS Executive 127

Printing directory
listings

Removing directories



128 Microsoft Windows User's Guide

Formatting a disk

Making a system disk

Working with Disks

You can use MS-DOS Executive to format disks, make system
disks, and run certain DOS programs .
Before you can use a new disk, you must prepare the disk by for-
matting it. If you format a used disk, any information already on
the disk will be erased. Once you have formatted a disk, you can
use it to store data or to make a system disk. A system disk con-
tains the files necessary for starting DOS. You cannot format hard
disks with MS-DOS Executive.
Here's how to format a disk :

0

4

0

4

Insert the new disk in the appropriate disk drive .
•

	

Select the Special menu and choose the Format Data Disk com-
mand. A dialog box appears .

Select drive to format

QB

r Cancel ,(OK)

•

	

Select the option button for the drive that contains the new
disk.
Choose the OK button .

The disk is now ready to store data .

To make a system disk, follow these steps :

Format a disk using the Format Data Disk command as
described in the previous procedure .

•

	

Select the Special menu and choose the Make System Disk
command. A dialog box appears.

•

	

Select the option button for the drive that contains the new
disk.
Choose the OK button . (If COMMAND.COM is not in your
Windows directory or on your Windows system disk, a dialog
box appears requesting that you insert your DOS system disk .)



Naming a Disk

To identify a disk by its contents, you can give it a volume name

	

Setting a volume
by using the Special menu's Set Volume Name command :

C Select the drive icon for the drive that contains the disk you
want to name .

C Select the Special menu and choose the Set Volume Name
command. A dialog box appears .

C Type a name in the text box .
Choose the OK button .

The volume name for the disk now appears after the drive letter
in the pathname.

Running DOS Utility Programs

Some DOS utility programs, such as FIND or DISKCOPY, can be
run in a window if the programs are in directories that are acces-
sible to Windows. See Chapter 9, "Using Standard Applications,"
for further information .
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name

You can also carry out DOS commands while using Windows by

	

Running
running COMMAND.COM :

	

COMMAND.COM

Insert a disk containing COMMAND.COM. (This file is on your
DOS disk.)
Display the directories for that disk .

C Run COMMAND.COM from the MS-DOS Executive window .
[1 Type the command you want to run in the COMMAND.COM

window (include any command-line arguments) and press the
ENTER key .
Type exit to leave the COMMAND.COM window when you are
finished . Then select the Control menu and choose the Close
command.

Note It is recommended that you run DOS utility programs
from MS-DOS Executive rather than from COMMAND.COM.
It is also recommended that you not use the DOS program
CHKDSK in Windows. If you do run it from Windows, do not
use the !F parameter. CHKDSK was not designed to run with
Windows, and using the IF parameter will close any files your
Windows applications are using (such as temporary files) .





6 Using Clipboard

In Microsoft Windows, you use Clipboard to hold information
being copied or moved. You can move or copy information from
one place in a window to another . For example, you can move
text around in a report as you edit . You can also move or copy
information from one window to another window . For example,
you can copy a paragraph from one report to another report . You
can even move or copy information from one application to
another application. For example, you can move a picture from
Windows Paint to a report in Windows Write .

L
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Displaying Clipboard

Clipboard is always available when you are running Windows .

Although you don't have to run a file to use Clipboard, you can

run a file to display the Clipboard contents .

Running Clipboard in

	

Follow this step to display Clipboard:

a window

Start CLIPBRD.EXE from the MS-DOS Executive window .

The Clipboard window appears. If the Clipboard is empty, a blank

window is displayed, as shown in the following figure .

Clipboard

Clipboard is empty .

: .~ ..{ iY

Cutting, Copying, and Pasting

To put information on the Clipboard, use the application's Cut or

Copy command. To insert information in your application from

the Clipboard, use the application's Paste command . Most applica-

tions require that you first select the information you want to cut

or copy. For more information about selecting, see the manual for

the application you are using.

Transferring

	

Though your application may have different names for the Cut,

information

	

Copy, and Paste commands, the commands should operate in this

way :

∎ The Cut command deletes the selected information from the

window and places it on the Clipboard .



• The Copy command makes a copy of the selected information
and places it on the Clipboard, leaving the selected informa-
tion in its original location .

•

	

The Paste command inserts information from the Clipboard in
a selected area in a window . If the window contains an inser-
tion point, the information appears to the left of the insertion
point. If the window contains a selection, the information on
the Clipboard replaces the selection . You can paste the same
information from the Clipboard as many times as you want .

Note Some standard applications have commands similar to Cut,
Copy, and Paste but don't use Windows Clipboard to transfer
information .

The following figure shows information that was copied from
a Notepad file to the Clipboard .

The copied text. . .

	

. . .appears on the Clipboard.

Notepad

	

DOTHIS .TXT

Clipboard

I

File Edit Search

TO 00

	

PRIORITY
Shop for new suit

	

B
Phone dentist

	

C
Take car in for tuneup

	

R
Make plane reservation

	

B
Pick up theater tickets B

How much?
Contact realtor

	

B

	

How much?
Clean garage

	

C
Flow lawn

	

B
Plan spring garden

	

B
Schedule vacation

	

R
Read "4)ar and Peace"

	

C
Write Grandma

	

C
Buy present for Martha

	

B
Talk to Fred

	

B
Take out garbage

	

B

Text

Pick up theater tickets

The bar below Clipboard's menu bar tells you what kind of infor-
mation appears on the Clipboard . In the previous figure, text is on
the Clipboard .
Generally, the formatting for your text is not stored on the Clip-
board. However, this can vary from application to application .
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Quitting Clipboard

Once you've finished viewing the Clipboard contents, you may
want to quit Clipboard .

Exiting from

	

To exit from Clipboard, follow this step :
Clipboard

a Select the Control menu and choose the Close command .

Although Clipboard is no longer running in a window, it con-
tinues to be available while you are working in Windows .



7 Using Control Panel

You use Control Panel to adjust Microsoft Windows system set-
tings such as the date and time, printer assignments, and baud
rates for communications devices . You can also use Control
Panel to specify screen colors .
Control Panel lets you adjust these settings quickly and easily
without running the Setup program again . Many of the changes
you make in Control Panel are reflected in the WIN.INI file. See
Appendix A, "Customizing Your WIN.INI File," for information
about WIN.INI .

cavv

f .
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Running Control
Panel

Adjusting the time

Starting Control Panel
Here's how to start Control Panel :

a Select and run CONTROL.EXE from the MS-DOS Executive
window.

When you start Control Panel, it creates a window containing four
sections : Time, Date, Cursor Blink, and Double Click .

MS-DOS Executive O0
File

A t

Uiew Special

PIF
ABC .TXT
CALC .EXE

CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE

CLOCK .EXE
CONTROL .EXE
COURA . FON

DOTHIS .TST
HELUA .IOM
MODERN . ION

MSDOS .EXE
NOTEPAD .EXE
PA INT .EXE

PRACTICE .WRI
READI'1E .TXT

REUERSI .ESE

L

C :CHRIS \WINDOWS

ROh1AN .ION
SCRIPT JON

SPOOLER .EXE

TERMINAL .EXE
TIISRA . ION
t IN .CO11

IIIN .INI

WIN2O0 .BIN
WIN200 .OUL

WINOLDAP .GRB
WINOLDAP .h10D
4IRITE .EXE

Control Panel

-Tine

/ :5 :O6 All

-Cursor Blink -1 rDouble Click

Slow

	

Fast

	

Slog!

	

Fast

4- 4

-Date

2121187

TEST

_nstallation Setup Preferences

Changing the Time
You can use Control Panel to change the system time . The time
you set from Control Panel will be reflected in any applications
(such as Clock or Calendar) that use the system time .
Here's how to change the time :

0 Press the TAB key to move to the Time section .

-Tine
8 :33 :5 AM

Use the RIGHT or LEFT key to select the part of the time (hours,
minutes, or seconds) that you want to change .



The system time changes when you move to another section or
quit Control Panel .

Follow these steps to change the time with the mouse :

Click the part of the time (hours, minutes, or seconds) that
you want to change .
Click the up arrow to increase the number or the down arrow
to decrease the number .

a

El

The system time changes when you click outside the Time section
or quit Control Panel .

Changing the Date

Some applications, like Notepad, use the system date . You change

	

Adjusting the date
the date the same way that you change the time :

0

a

II

•

	

Press the UP key to increase the number; press the DOWN key
to decrease the number .

Press the TAB key to move to the Date section .

Date

2121187

•

	

Use the RIGHT or LEFT key to select the part of the date (month,
day, or year) that you want to change .
Press the UP key to increase the number ; press the DOWN key
to decrease the number .

The system date changes when you move to another section or
quit Control Panel .

If you're using the mouse, follow these steps to change the date :

Click the part of the date (month, day, or year) that you want
to change .

•

	

Click the up arrow to increase the number or the down arrow
to decrease the number .

The system date changes when you click outside the Date section
or quit Control Panel .
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Adjusting the
cursor-blink rate

Changing the Cursor-Blink Rate

Some applications have an underscore (cursor) or insertion point
that blinks. The blink rate is the frequency at which the cursor
flashes.
Here's how to change the cursor-blink rate:

0

D

Press the TAB key to move to the Cursor Blink section .

-Cursor Blink
Slow

	

last

4- 4

Press the RIGHT or LEFT key to scroll to the setting you want .
The farther right you scroll, the faster the blink rate . The
vertical cursor within the Cursor Blink section reflects the
new setting.

Do the following to change the cursor-blink rate with the mouse :

Click the right or left scroll arrow in the Cursor Blink section .

You can also change the cursor-blink rate by dragging the scroll
box within the scroll bar .

Changing the Mouse Double-Click Rate

When you double-click the mouse button, Windows interprets
your action by the speed with which one click follows another.
You can change the expected speed by adjusting the setting in the
Double Click section .

-Double Click
Slow

	

last

4 -

TEST



Do the following to change the mouse double-click rate :

	

Adjusting the
double-click rate

CJ Click the right or left scroll arrow in the Double Click section .
The farther right you scroll, the faster the double-click rate .

You can also change the double-click rate by dragging the scroll
box within the scroll bar .
You can test the new double-click setting by double-clicking the
Test button . The button color will invert if Windows perceived
your pressing the mouse button as a double-click .

Adding and Removing Printers

When you first set up Windows, you select the printer you'll use
with your system. To change this selection, use the Installation
menu's Add New Printer and Delete Printer commands .

Adding a Printer

Follow these steps to add a new printer to your system :

Select the Installation menu and choose the Add New Printer
command. A dialog box appears prompting you for the disk
that contains printer-driver files .
Insert the disk that contains the printer-driver files you want
to install . (This is the Utilities disk for printer-driver files that
are included with Windows .)
Choose the OK button. A dialog box appears listing the
printer-driver files available on the disk.

Available Printers Printer File :

son .
aser et

IBM Graphics
IBM Proprinter
Okidata 97193 (IBM) ( Add

EPSOM .DRU

Cancel

4 Select the name of the printer that you want to add in the list
box. The name of the corresponding printer-driver file appears
in the Printer File text box at the right .
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Li Choose the Add button .
s

Ii

A dialog box appears prompting you to enter the drive or
directory you want to copy the printer-driver file to . Drive B
or your Windows directory appears in the text box. If you
want to change this, type the drive or directory you want in
the text box. (The directory must already exist.)
If you do not specify a drive or directory, the file will be
copied to the disk in drive B if you have a two-drive system .
The file will be copied to your Windows directory if you have
a hard-disk system .
Choose the Yes button.

Whenever you add a new printer to your system, you must let
Windows know which port the printer is connected to. See the
section called "Configuring Your System" later in this chapter for
more information on this procedure .

Removing a Printer

Deleting printers

	

To remove a printer from your system, use the Delete Printer
command :

0

Fl
4

Select the Installation menu and choose the Delete Printer
command. A dialog box appears listing the printers you have
set up .

Delete Printer Printer File :

aser et on
PostScript Printer on LPT2

(Delete)

EPSON . DRU

Cancel

Select the name of the printer you want to remove in the list
box. The name of the corresponding printer-driver file appears
in the Printer File text box .
Choose the Delete button .
A dialog box appears displaying the location of the printer-
driver file . If necessary, type an alternate location for the file
in the text box .
Choose the Yes button.



Note If other printers use the printer-driver file that appears in
the Delete Printer dialog box, that printer-driver file will not be
deleted from the named directory ; it will still be available to the
other printers .

Adding and Removing Fonts

The Windows Fonts disk(s) include fonts for a variety of output
devices. The Setup program installs fonts automatically, based on
your choices of graphics adapter and printer(s) . You can override
the automatic settings by adding or deleting fonts with Control
Panel. If you add a dot-matrix printer, you may want to check to
see if you need to add a font for your printer. You can do this by
viewing the dialog box that appears when you follow steps 1 and
2 of the following procedure.

Adding a Font

Follow these steps to add a font :

0

Fl

Select the Installation menu and choose the Add New Font
command. A dialog box appears prompting you for the disk
that contains the font files .
Insert the Fonts disk and choose the OK button . A dialog box
appears listing the fonts available on the disk . For more infor-
mation on the various sets of fonts, see the following section,
"Choosing a Font ."

Available Fonts

Courier 8
ourier ,

	

et
Courier 8,18,12 (Set #i)
Courier 8,18,12 (Set #S)
Helu 8 18 12 1t 18 2 (Set #2)

Font File

Add

COURA .FON

r
Cancel

Select the name of the font that you want to add in the list
box. The name of the corresponding font file appears in the
Font File text box to the right .
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Deleting fonts

l

n

s

Choose the Add button .
A dialog box appears prompting you to enter the drive or
directory you want to copy the font file to . Drive B or your
Windows directory appears in the text box. If you want to
change this, type the drive or directory you want in the text
box. (The directory must already exist .)
If you do not specify a drive or directory, the file will be
copied to the disk in drive B if you have a two-drive system .
The file will be copied to your Windows directory if you have
a hard-disk system .
Choose the Yes button .

Removing a Font

To remove a font, follow these steps :

C

Delete Font

our•l er•
ourier

	

,

	

,

	

et
Courier 8,10,12 (Set #4)
Courier 8,10,17 (Set #S)
Helu 8 10 12 14 18 24 (Set #2)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . ..
Font File

Delete

COURR . FON

Cancel ,
J

Select the name of the font that you want to remove in the list
box. The name of the corresponding font file appears in the
Font File text box .

ra Choose the Delete button .
4

Select the Installation menu and choose the Delete Font com-
mand. A dialog box appears listing the fonts you have set up .

A dialog box displays the location of the font file . If necessary,
type an alternate location for the font file in the text box.

[~ Choose the Yes button .

Choosing a Font

The Windows Fonts disk(s) provide two font types : raster fonts
and stroke (also known as vector) fonts . Raster fonts generally are
used only for devices such as dot-matrix printers or the screen .
They are available only in fixed sizes . Raster fonts look better and
may be drawn more quickly than stroke fonts on raster devices .
Stroke fonts typically are used if your output is going to a plotter .
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When you choose the Installation menu's Add New Font or Delete
Font command, you are prompted to insert the Fonts disk or to
specify where the font files are located . You then see a list of the
available fonts. The listing includes the font names, font sizes, and
the set numbers .
The font set number indicates the kind of devices that the font is

	

Raster and stroke
designed to be used with. Six sets of fonts are included on the

	

fonts
disk:

Set # 1 This set contains stroke fonts that can be used for
screen, printer, or plotter devices of any resolution .
Set #2 This set contains raster fonts designed for screen resolu-
tion of 640 x 200 . For example, if you are using the IBM Color
Graphics Adapter or a compatible adapter, you would select from
this set .
Set #3 This set contains raster fonts designed for screen resolu-
tion of 640 x 350. For example, if you are using the Hercules
Graphics Card or the IBM Enhanced Graphics Adapter, you would
select from this set. These fonts are also used by the CITOH 8510
(Portrait mode) printer.
Set #4 This set contains raster fonts designed for printers in
60 dpi (dots per inch) resolution, including the following :

•

	

Okidata 92, 93, 192, and 193 standard models (Portrait mode)
•

	

Okidata 92, 93, 192, and 193 standard and IBM-compatible
models (Landscape mode)

•

	

Epson MX-80, FX-80, and compatible models (Landscape
mode)

•

	

IBM Graphics (Landscape mode)
•

	

IBM Proprinter (Landscape mode)
•

	

Star Micronics SG-10 (Landscape mode)

Set #5 This set contains raster fonts designed for printers in
120 dpi resolution, including the following :

•

	

Epson MX-80, FX-80, and compatible models (Portrait mode)
•

	

IBM Graphics (Portrait mode)
•

	

IBM Proprinter (Portrait mode)
•

	

Okidata 92, 93, 192, and 193 IBM-compatible models (Portrait
mode)

•

	

Star Micronics (Portrait mode)
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Set #6 This set contains raster fonts designed primarily for
screen resolution of 640 x 480 .

Note Because applications handle fonts differently, some applica-
tions may not list all available fonts .

Windows font names

	

Fonts have names that represent their different characteristics .
Included on your Windows Fonts disk(s) are the following fonts :

Font

	

Description

Hely (Raster)

	

Proportional font (characters
have varying widths) without serifs
("sans serif")

Courier (Raster)

	

Fixed-width font (characters
have uniform widths) with serifs

Tms Rmn (Raster)

	

Proportional font with serifs
Roman (Stroke)

	

Proportional font with serifs
Modern (Stroke)

	

Proportional font without serifs
Script (Stroke)

	

Proportional font of slanted charac-
ters formed from nearly continuous
curved lines

The following fonts are not included on the Fonts disk(s), but you
may see them in some applications ; these fonts cannot be added
or deleted :

Font

	

Description

System (Raster)

	

Fixed-width default font designed
for menus and dialog boxes

Terminal (Raster)

	

Fixed-width font that is the same as
the font your computer displays in
DOS



In addition to the previously described fonts, an application may

	

Device fonts

list device fonts. These are the fonts that are provided by the

device. For example, on print-wheel printers, font names

correspond to wheel names . These fonts cannot be added or

deleted with Control Panel, but they may be listed when the out-

put device is selected. Since there may not be a corresponding

raster font for the screen, Windows will usually substitute a

screen font in the same class.

Configuring Your System

You use commands from the Setup menu to change printer port

assignments, set the system default printer and specify its output

modes, and set up serial communications ports .

Connecting Printers

Windows needs to know which port your printer is connected to .

You use the Connections command to assign or change the port

for your printer(s). For example, if you decide to move your

printer from port LPT 1 to port LPT2, you need to use Control

Panel to change the printer connections setting .

To change printer connections, follow these steps :

0

4

Select the Setup menu and choose the Connections command.

A dialog box appears displaying a list of printers and a list of

ports .

Select the name of the printer you want to change from the

Printer list box. The current port assignment for the selected

printer is selected in the Connection list box to the right .

Select the desired port from the Connection list box.

Choose the OK button .
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Selecting default
printers and output
modes

Setting Up Printers

You use the Setup menu's Printer command to specify the system
default printer and set its output modes . You also use it to set a
certain amount of time for printing problems to be corrected
before Windows sends you a message about the problem .
The system default printer is the printer used by applications
designed for Windows. Printer output modes are printer-specific
settings such as portrait (normal page orientation), landscape
(lengthwise page orientation), or color for plotters . These options
vary from printer to printer . If you have several printers installed,
you can use the Printer command to let Windows know which
printer you want to use .
The two Printer Timeouts settings let you adjust the amount of
time Windows waits before sending you messages about printer
problems. The Device Not Selected setting controls the amount of
time Windows waits before notifying you that a printer is off-line .
The default setting is 15 seconds . The Transmission Retry setting
controls the amount of time Windows waits for output characters
to be received by a printer before notifying you that it cannot
print to the device . The default setting is 45 seconds .
To select a system default printer or change printer output modes,
follow these steps :

0 Choose the Printer command from the Setup menu . A dia-
log box appears listing all available printers and their port
connections.



Fl To select a default printer, move to the Default Printer list box
and select the name of the printer that you want to serve as
the default .

C Choose the OK button . Another dialog box appears containing
the default mode settings for your printer .
If necessary, change the settings .
Choose the OK button .

4

To change the amount of time Windows waits before sending you Adjusting the printing
message delaymessages about printing problems, do the following ;

0 Choose the Printer command from the Setup menu . A dialog
box appears .
To change the Device Not Selected setting, move to that text
box and type the number of seconds you want Windows to
wait before sending you a message that the printer is off-line .
To change the Transmission Retry setting, move to that text
box and type the number of seconds you want Windows to
wait before sending you a message that it cannot print to the
device.
Choose the OK button . A dialog box appears showing the
default settings for your printer.
If necessary, change the settings .
Choose the OK button .6

Setting Up a Communications Port

You use the Communications Port command to set up a serial
communications port. You would want to do this if you are set-
ting up a communications device or a serial printer .

Note If you are setting up a serial printer, check your printer's
manual to make sure that the port settings you select are correct .

To choose a communications port, follow these steps :

	

Choosing a
communications port

C Select the Setup menu and choose the Communications Port
command. The Communications Settings dialog box appears
displaying the available serial ports and their port settings .
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4

Communications Settings

Baud Rate :

	

SS

Word Length QL1 05 g b QI Q 8

Parity

	

QEven

	

QOdd

	

~None

Stop Bits

Handshake

Port

C OK
l

0, .5

	

02

Q Hardware ® None

~ COM1 :

	

QCOM2 :

Cancel
1

Choose a port; the settings for that port appear .
Select the appropriate options .
Choose the OK button .

Selecting Screen Colors

You use the Preferences menu's Screen Colors command to adjust
the text and background colors on your screen . The Screen
Colors command also lets you adjust the shades of gray on the
screen. You can specify hue, brightness, and amount of color for
the following areas of your screen :

•

	

Screen background
•

	

Application workspace
•

	

Window background
•

	

Window text
•

	

Menu bar
•

	

Menu text
•

	

Active (selected) title bar
•

	

Inactive (unselected) title bar
•

	

Title-bar text
•

	

Active border
•

	

Inactive border
•

	

Window frame (the border that surrounds
•

	

Scroll bars
the window)



Here's how to select screen colors :

U

4

Select the Preferences menu and choose the Screen Colors
command. The Screen Colors dialog box appears .

Screen Colors

5cf~een Back
. .
round	0

pp ication or space
Window Background
Window Text
Menu Bar

I

Hue

Bright

Color

Sample
Actiue

File Edit

Window Text

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

(OK Reset I Cancel

In the list box, select the part of the screen or window for
which you want to adjust the color .
To change the hue, move to the Hue scroll bar . Available
colors are shown in the color palette above the scroll bar .
Scroll to the right or to the left to choose a color. The
Sample area simulates the window appearance .
Use the RIGHT or LEFT key to change settings in small incre-
ments. To move across the scroll bar more quickly, use the
PAGE UP or PAGE DOWN key. If you are using the mouse, you
can click the scroll arrows or drag the scroll box .
To change the brightness, move to the Bright scroll bar . Scroll
to the right to brighten the color (increase the amount of
white). Scroll to the left to darken the color .
If the Bright scroll box is at the extreme left of the scroll bar,
the color is black . If the scroll box is at the extreme right, the
color is white.
To change the color, move to the Color scroll bar . Scroll to
the right for a more vibrant, intense color . Scroll to the left for
less intensity or saturation .
If the Color scroll box is at the extreme left of the scroll bar,
adjustments to the Hue and Bright scroll bars will result only
in black, white, and shades of gray .

Chapter l: Using Control Panel 149

Adjusting screen

colors



150 Microsoft Windows User's Guide

Adjusting the window
border width

s When you have adjusted the screen colors to your satisfaction,
choose the OK button . If you have changed your mind and
want to return to the previous settings, choose the Reset but-
ton. This restores the original settings but does not close the
dialog box. To cancel the new settings and close the dialog
box, choose the Cancel button .

The Hue, Brightness, and Color controls are similar to those on a
color TV; adjust the controls until you have the effect you want .

Note You need to run the Setup program again if you want to
add or change graphics cards or change the resolution of the
graphics card you have already set up . You cannot use Control
Panel to make these changes in your system configuration. See
Chapter 1, "Getting Started," for information on running Setup .

Changing the Window Border Width

The Border Width command in the Preferences menu lets you
change the width of the border around a window . You cannot
change the width of a fixed-size window, such as the Control
Panel window .
Here's how to change border width :

0 Select the Preferences menu and choose the Border Width
command. A dialog box appears .

Border width :

OK) Cancel

The Border Width text box shows the current width of the
border. Windows automatically sets the value to 5 . To change
the border width, type a new number . The larger the number
the wider the border .
Choose the OK button .



Turning Off the Warning Beep

When you're using Windows, your computer sometimes beeps ; for
example, this occurs if you press the wrong key. You can turn off
the beep by using the Warning Beep command from the Prefer-
ences menu .
You can tell if the Warning Beep feature is in effect by looking at
the Preferences menu . A checkmark appears by the Warning Beep
command when the feature is active .

Preferences

Screen Colors . . .
Border _Width . . .

WWarning Beep
Mouse . . .

Country Settings . . .

To turn the beep on or off, do the following :

0 Select the Preferences menu and choose the Warning Beep
command .

Changing Mouse Options

The Mouse command in the Preferences menu lets you change
which mouse button you press and adjust how fast the mouse
pointer moves on the screen .
Windows generally uses only the left mouse button. You can
switch usage from the left mouse button to the right mouse but-
ton (and vice versa). With the Mouse Acceleration setting, you
can increase or decrease the speed at which the pointer moves
on the screen .
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Switching mouse
buttons

Follow these steps to switch mouse buttons :

Select the Preferences menu and choose the Mouse command .
A dialog box appears .

0

Adjusting the pointer

	

To change the speed at which the mouse pointer moves across
speed the screen, do the following :

0

Mouse Options

wa

	

e t ri

	

mouse u ons

-Mouse Acceleration

C none

	

medium

	

C high

(OK) Cancel

Set the Swap Left/Right Mouse Buttons option .
•

	

Choose the OK button .

Select the Preferences menu and choose the Mouse command .
A dialog box appears .

•

	

Choose the acceleration rate you want . The default is medium .
•

	

Choose the OK button .

Once you have set these options, they remain set until you
change them. If you have switched the mouse button function,
applications that normally use the right button for extended
usage will now use the left button to perform these functions .

Changing Country Settings

You can set variables (such as date, number, and time formats) for
a particular country by using the Preferences menu's Country Set-
tings command .



You can make changes to the following settings :

•

	

Country
•

	

Time format (12- or 24-hour)
•

	

Trailing string (A.M., P .M., etc . )
•

	

Time-separator symbol
•

	

Date format (month-day-year, year-month-day, etc .)
•

	

Date-separator symbol
•

	

Number-separator symbols
•

	

Number of significant decimal digits
•

	

List-separator symbol
•

	

Leading zero
•

	

Currency symbol

To change country settings, complete the following steps :

0 Select the Preferences menu and choose the Country Settings
command. You will see the Country Settings dialog box.

Country Settings

apan
Netherlands
Belgium
France

1

a
-Date Format

® MD9

	

ODMY

	

Q 9MD

Separator : !1

( OK ) Reset
J (

Cancel'

-Time Format

X12 hour 11 :59

-Number Format

1898 :

Decimal :

List :

-Currency Format

AM] 23 :59

Decimal digits :

Pleading Zero

PM

Q 2i hour Separator :

2

Symbol :

	

Prefix O Suffix
J

•

	

In the country names list box, select the appropriate country
name .
Notice that the country settings automatically change to
correspond to the country you select .

•

	

If you do not want to make any modifications to the country
settings, choose the OK button . The settings will be saved and
will become your default values . See the following section for
information about changing the settings . If you want to return
to the original settings, choose the Reset button .
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Making new country
settings

Creating New Country Settings
If the country name you want is not shown in the list box, you
can create your own country settings .
Here's how to do so :

Select Other Country in the country names list box .
The settings displayed are for your current country setting (for
example, the USA settings). You can change any of the settings .

a

Changing the Time Format

Adjusting the time

	

To change the time format, follow these steps :
format z--

11 Move to the Time Format section .

-Time Format

QQ 12 hour 11 :59 AM

Q2i hour Separator : [

23 :59 PM

•

	

Select the time format you want (12- or 24-hour) . Notice that
when you switch to the 24-hour format, the A.M./P.M . designa-
tions disappear .

[1 Move to the trailing-string text boxes (shown as 11 :59 and
23:59) and type the appropriate trailing string (for example,
AM) .

•

	

Move to the Separator text box and type the time-separator
character you want (for example, . ) .

Changing the Date Format

Adjusting the date

	

Here's how to change the date format :
format

•

	

Move to the Date Format Section .

-Date Format
®MDY

	

ODMY

	

QYMD

Separator : t



[l Select the date format you want (M stands for month, D for
day, and Y for year) .

4 Move to the Separator text box and type the appropriate date
separator (for example, I) .

Changing the Number Format

To change the number format, do the following :

Eli Move to the Number Format section .

-Number Format

1O :

Decimal :

List

Decimal digits :

Leading Zero

L Move to the 1000 text box and type the symbol used to
separate the 1 from the 000 .

L Move to the Decimal text box and type the symbol used to
separate integers from decimals .

C Move to the List text box and type the symbol used to
separate items in a list .
Move to the Decimal text box and type the number of decimal
digits you want to display .

L 1 Move to the Leading Zero check box . If you want a leading
zero in front of your decimal numbers, set this option .

Changing the Currency Format
Follow these steps to change the currency format :

Hi Move to the Currency Format section .

-Currency Format

Symbol : $

	

Q Prefix OSuffix
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In the Symbol text box, type the appropriate currency symbol .
Move to the Prefix or Suffix option button and select the
option that corresponds to your currency . If the currency
symbol precedes the number, select the Prefix option. If it
follows the number, select the Suffix option .

Saving Country Settings Changes

Saving country

	

Once you have adjusted the country settings to your satisfaction,
settings

	

you can save them by choosing the OK button in the Country Set-
tings dialog box. The settings you have indicated will become
effective immediately, and your WIN .INI file will be updated to
reflect the changes .
If you decide to return to your original settings and keep the dia-
log box on the screen, choose the Reset button . To cancel the
new settings and return to Control Panel's main window, choose
the Cancel button.

Quitting Control Panel

Once you have finished adjusting the different system settings,
you may want to quit Control Panel .

Exiting from Control

	

To exit from Control Panel, follow this step :
Panel

0 Select the Installation menu and choose the Exit command .



8 Using Spooler

In Microsoft Windows, files are printed by the Spooler program .
When you choose a print command in a Windows application,
the application creates a print-spool file, and Spooler automatically
starts to print the file on the printer .
After Spooler starts, its icon appears on your screen. Spooler
works in the background so that you can continue to work in
an application while your file is being printed .
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Viewing the print
queue

Displaying Spooler in a Window

You can enlarge the Spooler icon to a window to look at the list
of files being printed. The file listing, called the print queue, lists
files in the order they will be printed . The listing also contains
information about your printer, including its port, port status
(whether the printer's in use), and name . If necessary, you can
also work in the Spooler window to interrupt or cancel a print
job .
Spooler is used only for Windows applications . On a two-drive
system, the Spooler program is located on the Windows system
disk.
For information about setting up your printer, see your printer's
manual. For details on adding or removing a printer and on speci-
fying printer modes and options, see Chapter 7, "Using Control
Panel.
To look at the print queue, follow these steps :

0 Select the Spooler icon .
Select the icon's Control menu and choose the Restore com-
mand. The Spooler window appears containing information
similar to that shown in the following figure .

Port

Application name

Port status
Printer name

are ie-
'otepa '

/ Notepad - LETTER .TXT

Spooler

Job name



Follow this step to view the print queue with the mouse :

a Double-click the Spooler icon .

The first file in the list is the one that is currently printing .
Spooler works on one job at a time in the order that the jobs
are listed. If the entire list cannot fit on your screen, the win-
dow will have a vertical scroll bar that you can use to see the
remaining entries .

Specifying Printing Speed

You use the Priority menu commands to specify how fast you
want to print your work. These commands change the rate at
which information is transferred from Spooler to the printer
ports .
If you want Spooler to print a job faster, do the following :

Select the Priority menu and choose the High command .a
This setting uses more of your computer's processor time, causing
other applications to run more slowly .

If you want Spooler to print at a slower speed and free more
processor time for other applications, follow this step :

Select the Priority menu and choose the Low command .a

A checkmark next to the High or Low command on the Priority
menu indicates the current setting .

Halting or Canceling a Print Job

You use the Queue menu commands to temporarily halt or cancel
a print job .
Follow these steps to interrupt a print job :

Select the filename of the job you want to interrupt by press-
ing the UP or DOWN key or by clicking the filename with the
mouse .

0
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Resuming a print job

Canceling a print job

a

0

Select the Queue menu aild choose the Pause command . The
print-queue listing for that job now lists the port status as
paused.

Do the following to continue printing the file :

Select the Queue menu and choose the Resume command .

To cancel a print job, follow these steps :

Select the filename of the job you want to cancel .
Select the Queue menu and choose the Terminate command .
A dialog box appears asking you to confirm the cancellation .
Choose the Yes button .

Warning If you terminate a job that is printing in graphics
mode, you may need to reset your printer to ensure that the
buffer is cleared .

Spooler Messages

Displaying Spooler

	

Spooler sometimes displays information about the status of your
messages

	

printing jobs. If Spooler needs to display information, but the
Spooler window or icon is not selected, the title bar or icon will
flash. Select Spooler's window or icon to display the message .
Some of the messages Spooler sends depend on the settings you
specify in Control Panel's Setup menu . See the section called "Set-
ting Up Printers" in Chapter 7, "Using Control Panel," for more
information .

Note You can print from a Windows application without using
Spooler. This may be preferable when running Windows on a
two-drive system since it conserves disk space . To use this fea-
ture, you need to edit your WIN .INI file . See the section called
"Settings in [Windows]" in Appendix A, "Customizing Your
WIN.INI File," for more information .



Quitting Spooler

After the files in the print queue have been printed, you can quit
Spooler. If you quit Spooler while files are still in the print queue,
the remaining print jobs will be terminated .
To exit from Spooler, do the following :

	

Exiting from Spooler

0 Select the Priority menu and choose the Exit command .

If print jobs remain in the print queue, a dialog box appears ask-
ing you to confirm the cancellation .
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9 Using Standard Applications

In earlier chapters, you learned to use applications that were
designed to run with Microsoft Windows . This chapter explains
how to run applications that were not designed specifically for
Windows; these are known as standard applications. Applications
that run under DOS - such as Microsoft Multiplan®, Microsoft
Word, Lotus 1-2-3, and MultiMate- can run with Windows. You'll
find that it is faster, easier, and more efficient to work with your
applications when they are run with Windows .
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Introduction to Standard Applications

Running standard applications from Windows provides several
benefits, including the following :

•

	

You can run several applications simultaneously and switch
from one to another .

•

	

You can transfer information from a standard application to
another application .

•

	

Often, you can run your standard application in a window and
use Control-menu commands to manipulate the application .

Note Windows allows you to run only the applications that nor-
mally run on your computer . In other words, applications written
for operating systems other than DOS (XENIX, for example) will
not run with Windows .

How Windows Displays Standard Applications

How standard

	

When you run standard applications from Windows, they are
applications look

	

displayed on the screen in one of two ways : in a window or full-
screen. An application that runs in a window looks similar to Win-
dows applications and has many Windows features, including a
Control menu and a title bar . These applications are described
in more detail in the following section . A full-screen application
looks much the same as when you run it without Windows . (Gen-
erally, standard applications that display graphics are displayed
full-screen.) Details on these applications are given in the section
called "Using Full-Screen Applications" later in this chapter .
The way an application appears on the screen is determined by
the amount of computer memory that has been reserved for it,
the way it uses system resources and hardware, and the way it
has been set up to run. Some applications can run either in a
window or full-screen, while others can run only full-screen .

Using Applications That Run in a Window

Applications that run

	

There are many applications that can run in a window .
in a window



This standard application is running in a window .

hlultiplan
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COMMAND . Blank Copy Delete Edit Format Goto Help Insert Lock Moue
1Flame Options Print quit Run Sort Transfer Ualue Window 8ternal

Select option or type commanletter
R1C1

	

100 Free

	

Multiplan : TEMP

If your application has any of the following features, it probably
can run in a window :

•

	

The application can be set up to run with Windows, TopView,
or an American National Standards Institute (ANSI) device
driver. Check your application's installation instructions for
information on this feature .

•

	

The application software includes a TopView PIF file that
allows the application to run in a TopView window .

•

	

The application displays text by using standard DOS, ROM
BIOS (read-only memory/basic input and output system), or
ANSI call conventions . This feature may be difficult to deter-
mine. If you don't know this information, base your decision
on the two previously listed features .

If your application has none of the above features, you may need
to experiment to determine whether or not it runs in a window .
The section called "Determining Whether an Application Can Run
in a Window" later in this chapter gives details on how to do this .
When a standard application runs in a window, it has a title bar
and a Control menu, just like Windows applications do . However,
Windows adds several commands to your standard application's
Control menu; this is described in the section called "Transferring
Information" later in this chapter .
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5
6 Sales by Region (1,000's)
7
8 Region

	

1985 1986

10 North

	

1214 133
11 South

	

514 67
12 East

	

101 109
13 West

	

142 89
114
15 Total

	

321 398



166 Microsoft Windows User's Guide

Full-screen
applications

Standard applications that run in a window can also be run full-
screen. Full-screen applications are described in the following
section .

Note When you use the Minimize command or box to shrink a
standard application that is running in a window, you see an icon
for the application, just like you do for a Windows application .
The icon is a rectangle that contains an abbreviation of the
application's name .

. . . . . . . . .. . . . .. . . .

h1S-DOS Executive

File View Special

R C t C :CHRIS \WINDOWS

~ ~ REUERSI .EXE
ABC .TXT

	

ROMAN .FON
CALC .EXE

	

SCRIPT .FON
CALENDAR .EXE SPOOLER .EXE
CARDFILE .EXE TERMINAL .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA JON
DOTHIS .TXT
HELUA .FON
MOD ER N .FON
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACTICE .WRI
README .TXT

TMSRA . FON
W IN .CO M
WIN . IN!
WIN280 .BIN
WIN200 .OUL
WINOLDAP .ORB
WINOLDAP .MOD
WRITE .EXE

Icon for the standard application

Using Applications That Run Full-Screen
Some standard applications must be run full-screen. Applications
that display graphics on the screen, or those that have direct
access to the part of memory that is used by the screen, cannot
be run in a window.
When an application is running full-screen, Windows temporarily
removes itself from the screen . When you switch to another appli-
cation, the full-screen application becomes an icon . Moving from
one application to another is described in the section called "Mov-
ing Between Applications" later in this chapter .
When you run a full-screen application, all other applications,
including Windows applications, suspend operation. They resume
operation when you quit the full-screen application or shrink it to
an icon .



This standard application is running full-screen .

yLow to Prepare Cappuccino

A Bit of History

Cappuccino is said to be named for the Capuchin monks who
felt that a meal was not complete without this dessert
coffee . Cappuccino in the strictest sense is made up of
espresso topped with foamed milk, but you may want to try
adding a bit of cinnamon, nutmeg, cocoa, or whatever else
suits your taste .

Before You Start

- Check to see that the steam nozzle has been swung around
to the right . This gives you more freedom to moue the
pitcher as you foam the milk .

Use larger cups (4-6 oz . size) than you use for serving
espresso .

COMMAND Alpha Copy Delete Format Gallery Help Insert Jump Library
Options Print Quit Replace Search Transfer Undo Window

739 characters (6938624 bytes free)
Page l

	

{} Microsoft Word ; CAPP .DOC
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Using Memory-Resident Applications

Memory-resident applications are programs such as network

	

Memory-resident
servers, pop-up applications, expanded-memory managers, and

	

applications
disk-caching programs such as SMARTDrive . Most memory-
resident applications are special programs that extend the power
of your computer and add-on cards . They work silently and
require no interaction with the user . Fop-up programs, such as
Sidekick, are memory-resident applications that let you enter,
view, and process information . These programs temporarily
suspend your current application while you work with them,
then let you return to the suspended application .
If you want to use memory-resident applications, you must start
them before you start Windows . Once started, memory-resident
applications are always ready for use when you or DOS need
them. However, if your memory-resident application is a pop-up
program, you may not be able to use it while Windows applica-
tions are on the screen. You can, however, use the application
while running full-screen standard applications .
Windows Desktop applications provide many of the features found
in popular pop-up programs . You should consider using the Desk-
top applications instead of the pop-ups . If you do decide to run
pop-ups, be aware that some of them may not run properly with
Windows because they were not designed especially for Windows .
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Using Program Information Files

Using PIF files

	

Because standard applications were not written for Windows, they
require program information (PIF) files to run with Windows . PIF
files supply information to Windows about how an application
uses the screen, system zalemory, and other computer resources .
For example. Windows uses PIF files to learn how much memory
an application needs. You can recognize PIF files by their PIF
extension . For information on creating and editing PIE files, see
Chapter 10, '1 `sing PIF Editor ."
If there is no PIF file for an application, Windows uses a set of
default program characteristics to run the application . However,
you are encouraged to use PIF files with your standard applica-
tions because a PIF file allows you to run the application in the
most efficient way . A PIF file may also give your application more
capabilities than it is given when you rely on the default PIF set-
tings. For example, using the default settings prevents you from
switching to other applications unless you first exit from the
application you are running .

Running standard

	

You can start are application by running its PIF file ; this process is
applications from

	

described in the section called "Starting an Application from a PIF
PIF fibs

	

File" later in this chapter. Windows runs the application named in
the file and uses the resource settings listed there. A number of
PIF files for popular applications are provided on your Windows
disks. You may also find that your standard application's disk
includes a PIE file .
You can create more than one PIF file for an application so that
you can run it in different ways at different times . For example,
wlien you start Microsoft Multiplan to work on business, you may
want to be in a directory- you've set up for business data . When
you start Multiplan to work on personal data, you may want to be
in another directory . You can set up Multiplan to run both ways
by creating two different PIE files for starting the program, for
example, MP1 'ORK.PIF and MPHOME .PIF. Each PIF file starts
the same Multiplan program, but the first PIF file opens the pro-
gram iii the MPWORK directory and the second opens it in the
MPHOME directory .

Running standard

	

If you run a standard application from a batch file, you should
applications from

	

create an additional PIF file for the batch file . Set the options in
hatch files

	

the hatch PIE file to match those in the application PIF file, and
give the PIE file the same base filename as the batch filename
(the PIF file will have the .PIF extension) .
Occasionally when you are using a hatch file to run an applica-
tion, Windows displays a message saying "Not enough memory
to run." This may occur because the application's PIF file does
not specify enough memory to run both the batch file and the



application. To correct this, increase the amounts specified in the
KB Required and KB Desired text boxes in the PIF file to allow
adequate memory to run both files .

Starting Standard Applications

There are two ways to start a standard application . You can run
the application's PIF file, or you can run the application file (a file
with a .EXE, .COM, or .BAT extension). In both cases, you run the
file from the MS-DOS Executive window .
Whenever possible, you should use PIF files to start your standard
applications, then you can take advantage of the preset options
that make your application run more efficiently. In some cases,
you may want to have more than one PIF file for an application,
each with different options selected . In such cases in particular,
you should use the desired PIF file to start the application . (If you
use the application file, Windows by default uses the PIF file with
the same base filename and runs your application using those
options. These may not be the options you want to use at that
time.)
If you start an application from a PIF file, the PIF file must be in
the same directory as the application, or the application must be
in a directory listed in the PATH variable in your AUTOEXEC .BAT
file. As an alternative, you can list the full pathname of the applica-
tion in the PIF file . See Chapter 10, "Using PIF Editor," for details
on changing your PIF file .

Starting an Application from a PIF File

To use a PIF file to start your application, follow these steps ;

	

Starting applications
from PIF files

[i! Move to the directory that contains the PIF file . For PIF files
supplied with Windows, this is the PIF directory; it is created
when you install Windows.

[ Copy the PIF file to your standard application's startup disk
or directory, or make sure the directory containing the appli-
cation file is in your PATH variable .

L1 Select the PIF file and press the ENTER key or, with the mouse,
double-click the filename .
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Starting applications
by using their
filenames

Starting an Application by Using Its Filename

If you start the application by using its filename, you must first be
sure that any related PIF file has the same base filename so that
Windows can locate it . For example, if you use the file named
DBASE.COM to start dBASE II, the associated PIF file must be
DBASE.PIF.
Follow this step to start an application by using its filename :

a Select the application filename and press the ENTER key or,
with the mouse, double-click the filename .

Note An application may have more than one .EXE or .COM file
on its disk. You should have a separate PIF file for each one .

Determining Whether an Application
Can Run in a Window

You can determine whether a standard application can run in a
window by editing the application's PIF file and then running the
application .
Before trying the following procedure, you should close all other
applications, including Windows applications . Then if your appli-
cation doesn't run in a window and you have to quit Windows
temporarily, you will not lose any information from other appli-
cations.

Checking for window

	

You can check to see if your application can run in a window by
capabilities following these steps :

D Turn off the Directly Modifies Screen check box in the
application's PIF file . (For information on setting options in
the PIF file, see Chapter 10, "Using PIF Editor.")

•

	

Run the application.

If the application displays information outside the window, it can-
not run in a window .

Returning to Windows If the application does not run in a window, you can return to
Windows and correct the PIF file by doing the following :

11 Quit the standard application using its quit or exit command .
•

	

Quit Windows and then restart it .
•

	

Turn on the Directly Modifies Screen check box in the PIF file .



Displaying the Control Menu

If your standard application is running in a window, Windows
adds commands to the Control menu, for example, the Mark,
Copy, Paste, and Scroll commands. The other Control-menu com-
mands allow you to manipulate the standard application's window,
just as they do for Windows applications .

BASIC

0

Moue Alt+F7
Size A1t+F8
Minimize Alt+F9
Maximize

	

Alt+118

e square roof of
The square root of 9 is 3
Ok

These commands are added to the Control menu.

Even though your application is running full-screen, it may have a
Control menu (this usually is true for an application that allows
you to switch to other programs without quitting the application) .
To see if your full-screen application has a Control menu, follow
this step :

Press ALT, SPACEBAR.

If a full-screen application has a Control menu, you can shrink the
application to an icon by choosing the Minimize command from
the menu .
In standard applications, the Control menu contains commands for
transferring information between applications (Mark, Copy, Paste),
in addition to the Close command for closing the window . These
commands are described in the sections called "Transferring Infor-
mation" and "Quitting Standard Applications" later in this chapter .
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Checking for a
Control menu
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Note You can use the direct-access method to choose com-
mands from a menu in a full-screen standard application, just as
you can with applications that run in a window . The direct-access
method lets you choose a command by pressing the key that
corresponds to the underlined character in the menu-command
name. In full-screen applications, however, the character may not
be underlined ; the appearance of the character is determined by
the display device you are using .

Moving Between Applications

To switch from one standard application to another (or to a Win-
dows application), you can usually follow the regular Windows
procedures .

Switching from a

	

If you switch from a full-screen application to another full-screen
full-screen application application, the new application's screen is displayed. If you

switch to an application that runs in a window, the application's
window or icon is brought to the front of the screen and becomes
active. The full-screen application you just left is represented by
an icon on the screen and suspends operation until you return
to it .
Some full-screen standard applications may not allow you to
switch to any other applications until you exit from the applica-
tion. In this case, the system sounds a warning beep, and the
application remains on your screen . When you exit from the
application, you return to the Windows screen . You can then
switch to the other applications .

Switching from an

	

If you are working in an application that runs in a window, you
application that runs

	

switch to a full-screen application by following these steps :
in a window

1 Press ALT + ESCAPE. If you're using the mouse, you can click the
window or icon (you may need to do this several times) . This
selects the full-screen application's icon, and the application
name is displayed .
Press ALT, SPACEBAR (or click the icon with the mouse) to
display the icon's Control menu .

13] Choose the Maximize or Restore command .

Using ALT +TAB

	

You can also switch between applications by pressing ALT+TAB .
When you release ALT + TAB, the application window or screen is
restored .



Note if you are using a two-drive system and want to keep your
data files on separate disks, be sure that the correct dataa disk is in
the drive when you switch programs .

Transferring Information

`here are two ways to copy information between applications :
you can transfer a complete screenful of information from an
application, or you can transfer portions of information .
Information that you are transferring is stored on the windows
Clipboard . For information on Clipboard, see Chapter 6, "Using
Clipboard."

Copying an Entire Screen

'lo copy the entire screen from a standard application to the

	

Copying a screenful
Clipboard, follow these steles :

	

of information

Make sure that the information you want to copy is on the
screen .
Press ALT -+ PRINT,SCREEi'c .

I'his takes a "snapshot" of the screen . 'Clue information is now
available on the Clipboard and can be transferred to Windows
applications .

If von are unable to capture a graphics screen by pressing
ALT + I'R[N` S(TREEi , it may be for one of the following reasons :

•

	

Iii the application's PIF file, the Graphics/Text option in the
screen Exchange section is not selected . This option must be
selected to reserve space in memory for storing the screen
image .

•

	

If you are trying to copy from a medium resolution or high-
resolution screen, the memory required to store the screen
image may be too large for the image to be transferred .

You can experiment to see if your screen can be transt i'red to
the Clipboard . If it cannot be transferred, you will hear a beep
when you press ALT 1- PR1NTSCREEN

Copying Partial Screens

To transfer selected parts of the screen, use the Mark, Copy, and
Paste commands from the Control menu .
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Using the Mark Command

You use the Mark command to select information on the screen

so that you can copy it to the Clipboard .

Follow these steps to select information for copying :

n Select the Control menu and choose the Mark command .

A rectangular cursor appears at the upper-left corner of the

window .

Press the DIRECTION keys to move the cursor to the begin-

ning of the information you want to select . Press and hold

down the SHIFT key, then use the nIRECTION keys to select the

information .

For example, to select a paragraph, move the cursor to the

first character of the paragraph . Press and hold down the SHIM'

key. Use the RIGHT key to go to the end of the line, then use

the DOWN key to go to the last line of the paragraph .

Release the SHIFT key .

You use the Mark command to select text.
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Follow these steps to select information with the mouse :

Ii] Select the Control menu and choose the Mark command .

A rectangular cursor appears at the upper-left corner of the

window.



0

0

•

	

Drag the cursor across the information that you want to select .
•

	

Release the mouse button .

To cancel the selection, follow this step :

Press the ESCAPE key or, with the mouse, click outside the
selected area .

Using the Copy Command

After you've selected the information, you can copy it to the

	

Copying information
Clipboard by following this step :

Select the Control menu and choose the Copy command .

Using the Paste Command

You use the Paste command to transfer compatible information
from the Clipboard to another application or to another place in
the same application . You can paste text onto a full-screen stan-
dard application . However, you cannot paste graphics onto any
standard applications.
If an application has more than one mode, it must be in its text-
entry mode in order for text to be pasted onto it . For example, it
is Col imon for word-processing applications to have a text-entry
mode for typing text, and a command mode for controlling format
or insertion-point movement . You should change to the text-entry
mode before pasting text onto such an application .
To paste information from the Clipboard, follow these steps :

Move the application's insertion point to the area where you
want to insert the information.

•

	

Select the Control menu and choose the Paste command .

El

If you paste formatted text, the text will transfer but not the
formatting.
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This text was copied from Notepad . . .

Notepad - CRPP .TXT

Have ready a chilled pitcher (19-12 oz . size) that is 1/3
to 112 filled with cold milk . Regular milk (rather than 2) creates
the best foam .

felt that a meal was not complete without this dessert
coffee . Cappuccino in the strictest sense is made up of
espresso topped with foamed milk, but you may want to try
adding a bit of cinnamon, nutmeg, cocoa, or whatever else
sult.s your taste,

Before You Start

-- Check to see that the steam nozzle has been swung around
to the right . This gives ynu more freedom to move the
pitcher as you foam the milk .

- Use larger cups (4-6 oz . size) than you use for serving
espresso .

Have ready a chilled pitcher (18-12 oz, size) that is 1/3
to 1/2 filled with cold milk . Regular milk (rather than 2'.)
creates the best foam .
I

COMMAND : Alpha Copy Delete Format Gallery Help Insert Jump Library
Options Print Quit Replace Search Transfer Undo Window

Edit document or press Esc to use menu
Page l
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? Microsoft Word : CAPP .DOC

and ;pasted into Microsoft Word .



Scrolling the Window

In addition to the Mark, Copy, and Paste commands that Windows
adds to a standard application's Control menu, Windows may also
add the Scroll command .
When a standard application is running in a window, Windows
acts as a kind of viewer, displaying information inside the window
which would normally fill the whole screen . As a result, you may
not be able to see all the information, especially if the application
is sharing the screen with several other windows. You can use the
Scroll command to move the information in the window so that
you can see other parts of the file .
The Control menu's Scroll command is independent of com-
mands your application may have for scrolling information . The
application may have additional scrolling commands or keys for
moving to other parts of a file . See the application's manual for
this information .
To scroll a window, follow these steps :

	

Scrolling through
a file

Select the Control menu and choose the Scroll command .
[] Use the keys described in the following list to scroll in the

desired direction .

Press these keys to scroll through a file :

To scroll

	

Press

Up one line

	

UP

Down one line

	

DOWN

Left one character

	

LEFT

Right one character

	

RIGHT

Up one screen

	

PAGE UP

Down one screen

	

PAGE DOWN

To the beginning of a line

	

HOME

To the end of a line

	

END

To stop scrolling, follow this step :

Press the ESCAPE key or the ENTER key .

To scroll with the mouse, you can use the window's scroll bars .
See Chapter 4, "Techniques," for details .
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Swapping
applications

Running Multiple Applications

With Windows, you can run as many applications at the same time
as your system will allow . In addition, if you have a hard disk or a
memory-expansion card, Windows can run more standard applica-
tions than can fit in memory.
If you try to start a standard application and your system doesn't
have enough memory, Windows tries to share available memory
by temporarily moving another application (and even parts of
Windows itself) to the hard disk . This is referred to as "swapping ."
When you switch to the application that was swapped, Windows
moves another application out of memory and brings the selected
application back into memory .
Windows can also swap applications to expanded memory . To use
this feature, your expanded-memory manager must support Win-
dows 2 .0. You must also edit the [pif] section in your WIN .INI
file so that the /E option is specified in the swapdisk = entry . See
Appendix A, "Customizing Your WIN.INI File," and Appendix E,
"Special Notes on Using Windows," for more information on using
expanded memory.
To run multiple applications efficiently, run the largest application
first, or specify the size of the swap area in the WIN .INI file . See
Appendix A, "Customizing Your WIN.INI File," for details .
When your system has low memory, Windows may excessively
swap information from your disk, causing your system to run
more slowly than normal . When this occurs, it is recommended
that you close any applications that you do not need . This will
give Windows more memory to manage your remaining appli-
cations.
If you try to run a standard application and Windows displays a
message that there is not enough memory, try closing some of the
applications you are running, then try to run the program again.
You could also choose to reset the KB Required and KB Desired
options in the PIF file, as described in the next section .



RunningLarge Standard Applications
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Occasionally, you may want to run a standard application that

	

Freeing up memory
requires more memory than is available when Windows is run-
ning. When you try to run such an application, Windows displays
a message saying "Not enough memory to run ." You can free up
more memory to run the application by ensuring that Windows
automatically swaps out unused parts of itself when you start the
application. You can choose between two methods to do this :

∎ Set the KB Desired amount in the application's PIF file to -l .
When you run the application, Windows automatically frees up
additional memory for the application by swapping out unused
parts of Windows and any Windows applications; swapping
will not occur if the application uses a communications
(COM) port .

∎ Set the Directly Modifies Memory option in the application's
PIF file, then close all Windows programs except MS-DOS
Executive and run the application . Windows swaps out unused
parts of itself and gives the application most of the available
memory. A small amount of memory is reserved for transfer-
ring information to the Clipboard . When you are finished using
the application, you must quit the application to return to
Windows. When you quit the application, the Windows screen
returns .

Note There may be other cases when you will see the message
saying "Not enough memory to run ." For a list of these cases
and corrective actions you can take, see the section called "Not
Enough Memory to Run" in Appendix B, "System Messages ."
If your application runs in a window, you can set the amount of
memory without using a PIF file . To do this, create an entry in the
[pi] section of the WIN .INI file, as described in the section called
"Settings in [Pi]" in Appendix A, "Customizing Your WIN .INI File ."

iiTffiiig Standard Applications

To quit a standard application, you use the application's quit
or exit command . Normally when you quit an application, it is
removed from your screen. However in some cases, information
is left on the screen . If the application was running in a window,
parentheses surround the application's name in the title bar .
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Exiting from standard To remove the information from the screen, follow this step :
applications

Select the Control menu and choose the Close command .

Note When closing COMMAND.COM, you must first exit from
the program by typing exit in the command line . Then you can
close the window by using the Control menu's Close command .



10 Using PIF Editor

As you learned in the previous chapter, program information (PIE)
files are the files that tell Microsoft Windows how to run standard
applications in the most efficient way . II) create or revise PIF
files, you use PIF Editor . For example, you might use PIE Editor
to change the program settings in your application's PIF file to
give the application more of the machine's available memory .
This chapter explains how to use PIF Editor . For information on
using PIF files with your standard applications, see Chapter 9,
"Using Standard Applications ."
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Creating a PIF File

In some cases, your application will not have a PIF file and you
will need to create one. (Be sure to check the PIF directory to
see if Windows has supplied a PIF file for your application .)

Creating PIF files

	

To create a new PIF file, follow these steps :

0

Fl

4

D

Start PIF Editor by running the PIFEDIT .EXE file from the MS-
DOS Executive window. (The PIFEDIT.EXE program may be
located in the PIF directory.) Your PIF Editor screen will look
something like the following one .

Program Mane

Program Title :

Program Parameters :

Initial Directory :

Memory Requirements :

Directly Modifies

Program Switch

Screen Exchange

Close Window on exit

P

KB Required 52

	

KB Desired ~2

Screen

	

E. CtJM1

	

Cl Memory

Keyboard

	

COM2

Prevent

	

4 Text

Text

Type the application's filename in the Program Name text box .
Include the original extension (, exe, . corn, or . bat). If the appli-
cation is in a subdirectory, type the full pat name including
the drive letter, or make sure the directory is listed in your
PATH variable .
Select the options or values that apply to the program . (For
more information, see the section called "PIF File Options"
later in this chapter .)
Select the File menu and choose the Save command to save
the new PIF file .

To create another PIF file, do the following :

Graphics/Multiple Text

'ii Graphics/Text

Select the File menu and choose the New command . This
resets the PIF Editor screen .



Editing a PIF File

Usually you will not need to change the information in your PIF

	

Changing information
files unless you want to change the settings for a particular pro-

	

in PIF files
gram. The following is a partial list of situations that would
require editing an application's PIF file :

•

	

You want to set up an application to run in a window .
•

	

You want to give an application the maximum amount of avail-
able memory on your machine .

•

	

An application is not running as expected . You want to
increase the memory requirements to see if the program will
run better .

•

	

You want to free up more memory for running a large applica-
tion by having Windows swap unused parts of the Windows
program to the hard disk when the application is started .

•

	

Your application is located in a subdirectory and the PIF file
supplied for the application does not list the full pathname of
the program. You need to change the pathname listed in the
Program Name text box .

•

	

You want to specify a program parameter or change the
default directory that contains your application's data files .

Editing procedures for some of these situations are listed in the
section called "Situations Requiring PIF File Changes" at the end
of this chapter .
Before editing a PIF file, it is a good idea to make a backup copy
of the original. If your edited file does not run as expected, you
can go back to the original and start over .
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To edit a PIF file, follow these steps :

	

Editing a PIF file

0

4

Start PIF Editor by running the PIFEDIT .EXE program from the
MS-DOS Executive window. (The PIFEDIT.EXE program may
be located in the PIF directory .)

•

	

Select the File menu and choose the Open command . You will
see a dialog box listing the available PIF files .

•

	

Select the filename or type it in the text box, then choose the
Open button or press the ENTER key. If the filename is not
listed, type the full pathname of the file in the text box . To
open the file with a mouse, double-click the filename .
Change the options .

•

	

Select the File menu and choose the Save command to save
your changes.
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Program information

PIF File Options

The following sections describe the entries in a PIF Editor
window.
About the Program There are four entries for information
about your application program :

•

	

Program Name. Type the application's pathname, including the
filename extension - for example, a: dbase. corn .

•

	

Program Title. Type a descriptive name that will appear in the
window's title bar when you select the program's icon - for
example, IBM Writing Assistant.

•

	

Program Parameters. Type any parameters your program might
need. These are the same parameters you would type after the
application's filename when starting the program from outside
Windows. For example, to run Microsoft Word in text mode,
type /c.
If you want Windows to prompt you for parameters, type? .
When you try to run or load the application from the MS-DOS
Executive window, you will be prompted for the parameters .
Parameters can be filenames, letters, numbers, or any type of
information up to 62 characters. If your application requires
no parameters, or if you are uncertain, leave this option blank .
(You cannot use this entry to redirect I/O or to do piping .)

•

	

Initial Directory . Type the drive and directory you want Win-
dows to go to when the application is started . This is usually
the location of the application's data files .
Some programs require that certain files used by the program
be located in the default directory. You should specify an ini-
tial directory for these programs to make certain the program
can find the files .

Memory information

	

Memory Requirements These two items describe the memory
your application needs :

•

	

KB Required. Type the minimum amount of memory in kilo-
bytes (KB) that your application requires . Check the system
requirements of your application. If you don't know how much
is required, leave the default setting .
If Windows cannot provide the specified amount of memory,
and you are running other applications, you will see the mes-
sage, "Not enough memory to run ." You may need to close
some applications before continuing .



If you have a hard disk, you may be able to free up additional
memory by having Windows swap, or remove itself, tem-
porarily from memory . See the section called "Situations
Requiring PIF File Changes" at the end of this chapter for
more information on freeing memory .

•

	

KB Desired. Type the maximum amount of memory your pro-
gram can use. Some applications run more efficiently if more
than minimal memory is provided .
If you leave this entry blank or type zero, Windows will allo-
cate all available memory to the application.
If you enter -1 in this field and the application is set up to
run full-screen, Windows will attempt to swap itself to the
hard disk to make room to run the application . (If any applica-
tion is running that uses a communications port, Windows will
not be able to swap the application or itself. )

Note Some utility programs that check available memory may
not provide correct results when run from Windows . For exam-
ple, DISKCOMP may give you the message "Not enough memory
to run" when in fact, there is plenty of memory . If you see this
message, close some applications and try again, or run the utility
program from outside Windows .

Directly Modifies Many applications use system resources in
ways that cannot be shared with other programs . In the following
group, select any options that apply to your application :

•

	

Screen. Turn on this check box if the application writes
directly to the screen buffer (video memory) . Applications
that display graphics are in this category . Such applications
cannot be run in a window. Selecting this option will run the
application full-screen . If you are uncertain, select this option .

•

	

Keyboard. Turn on this check box if your application uses the
keyboard buffer . The keyboard buffer is the area where key-
strokes are saved until they are processed .
Selecting this option prevents the application from running in
a window or switching back to Windows when you press
ALT + ESCAPE . This option also prevents you from using Control
menu's Mark, Copy, and Paste commands . If you are uncertain,
do not select this option .

•

	

COM 1 . Turn on this check box if your application uses serial
communications port 1 (COMI ). If you select this box, Win-
dows cannot run any other application that uses COM 1 until
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you quit the first application . This prevents two applications
from trying to use the same communications port at the same
time .
Selecting this option also prevents the application from being
swapped to the hard disk. Some programs must remain in
memory at all times. Generally, you need to select this option
only if you are running a communications application .

∎ COM2. Turn on this check box if your application uses serial
communications port 2 (COM2) . If you select this box, Win-
dows cannot run any other application that uses COM2 until
you quit the first application . This prevents two applications
from trying to use the same communications port at the same
time .
Selecting this option also prevents the application from being
swapped to the hard disk. Some programs must remain in
memory at all times. Generally, you need to select this option
only if you are running a communications application .

∎ Memory. Turn on this check box if your application uses a
memory-resident application (for example, Sidekick) . These
programs usually load and remain in memory, and are acti-
vated while other applications are running . If you are uncer-
tain, do not select this box . For more information on this type
of application, see the section called "Using Memory-Resident
Applications" in Chapter 9, "Using Standard Applications ."
You may wish to set this option in order to run a very large
standard application . The option causes Windows to remove
itself temporarily from memory to make room to run the pro-
gram. To return to Windows, you must quit the application .
Selecting this option prevents data transfer to or from your
application . You must close this application before switching
to another .

Switching

	

Program Switch If your application is running full-screen, the
applications

	

following options determine whether you can switch back to Win-
dows by pressing AL.T+ESCAPE. If you are uncertain which option to
choose, choose Text.

∎ Prevent. Select this option to conserve memory for the appli-
cation, or if you find that Windows does not switch correctly .
If you select this option, you must quit the application to
return to Windows .



• Text. Select this option if your application works in text mode
only, or if it runs in text and graphics modes and you want to
conserve memory. Windows will reserve four kilobytes to save
the screen image .
If you select this option, you will be able to switch back to
Windows only when the application is in text mode . If the
application is in graphics mode, you must quit the program to
return to Windows ; Windows will beep when you press
ALT + ESCAPE .

•

	

Graphics/Multiple Text. Select this option if your application
works in graphics mode . If you select this option, Windows
allocates extra memory (16--36K) for you to switch back to
Windows when the application is in text or graphics mode .

You may not be able to switch from a standard application that
uses high-resolution color modes because of the extensive
memory that is required .
Screen Exchange These options let you specify the kind of

	

Exchanging data
data exchange (text or graphics) between Clipboard and applica-

	

using Clipboard
tions that require exclusive access to the screen . As described in
the section called "Transferring Information" in Chapter 9, "Using
Standard Applications," you press ALT + PRINTSCREEN to put "snap-
shots" of the screen on the Clipboard . This copies the entire
screen and requires Windows to reserve memory to save the
screen image . Text screens do not usually require muchh memory
(two kilobytes). However, low-resolution graphics screens gen-
erally require up to 32K of memory . You should keep this in mind
as you select options. If you are uncertain, choose Text .
You cannot take a snapshot of a high-resolution color screen
because of the extensive memory that is required .

•

	

None. Select this option to prevent any exchange of screen
data between a full-screen application and Clipboard . This con-
serves memory .

•

	

Text. Select this option to allocate memory to take snapshots
of text screens . If your application runs in a window, select
the Text option .

•

	

Graphics/Text. Select this option to allocate memory to take
snapshots of text and graphics screens .
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Close Window on Exit This option closes the standard applica- Closing a window
tion window when you exit the program, rather than leaving
information on the screen.
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Default settings

	

Default Settings

If you run an application and Windows cannot find a PIF file,
Windows uses the following settings :

•

	

Program Title : Ignored
•

	

Initial Directory: Ignored
•

	

Memory Required (KB) : 52
•

	

Memory Desired (KB) : All available memory
•

	

Directly Modifies : Screen
•

	

Program Switch: Prevent
•

	

Screen Exchange: Text
•

	

Close Window on Exit : Does not close

Changing a pathname
listing

Be aware that using the default settings for a PIF file may cause
problems with some programs . For example, some programs may
need an initial directory to run properly . Also, remember that
since Program Switch is set to Prevent, you cannot switch from
your application to Windows by pressing ALT + ESCAPE .

Situations Requiring PIF File Changes

The following are procedures for some common situations in
which you should edit your application's PIF file . See the section
called "Editing PIF Files" earlier in this chapter to learn how to
use PIF Editor to open a PIF file for editing .

Listing a Pathname for an Application

When an application is located in a subdirectory, the PIF file that
is supplied with Windows will probably not list the full pathname
of the program. For example, the PIF file for Microsoft Chart lists
CHART.EXE as the program name, yet you may have CHART .EXE
in a directory called CHART. You need to change the program
name to include the full pathname : 1CHARTICHART.EXE .
To edit the PIF file, follow these steps :

0 Use PIF Editor to open the PIF file .
2 Type the full pathname of the application in the Program

Name text box .
51 Select the File menu and choose the Save command to save

your changes.



Setting Up an Application to Run in a Window

Some applications have installation instructions that allow you
to set them up to run with Windows, IBM TopView, or an ANSI
device driver (ANSI.SYS). If the program otters any of these
options, you usually can run it in a window .
To run an application in a window, follow these steps :

	

Running an
application in a

Use PIE Editor to open the PIE file,

	

window
Turn off the Directly Modifies Screen check box .

[! Select the File menu and choose the Save command to save
your changes .

Do this for all related .COM or .EXI tiles included in the
application .

Freeing up Additional Memory
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You can instruct Windows to swap, or temporarily remove itself,
from memory when you run a standard application . This frees
additional memory that can be used for the application . You must
have a hard dishk for Windows to swap to .
To allow Windows to swap, follow these Steps :

	

Swapping

Use PiE Editor to open the PIE file .
Set hh Desired to

	

l .
' Select the File menu and choose the Save command to save
your changes .

Note Fhis swapping may not occur if y()u are running a Win-
dows application that uses a communications port (for example,
Terminal). `When Windows tries to swap itself to the hard disk,
any applications that are running are suspended . Swapping is
prevented in order to avoid probkins withi applications that use
communications ports .
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At times, you may want to give an application the maximum
amount of available memory so it will run better with Windows .

Changing available

	

To change the amount of available memory, follow these steps :
memory

Getting help
information

Giving an Application All Available Memory

0
Fl

a

Use PIF Editor to open the PIF file .
Change the amount in the KB Required option by typing 640
(or set the Directly Modifies Memory check box) .
Select None from the Screen Exchange options .
Select the File menu and choose the Save command to save
your changes .
Close all other applications except MS-DOS Executive and run
the application.

Getting Help with PIF Files

You can get on-line information about PIF files or about using PIF
Editor .
To read help information, follow these steps :

0 Press the F1 function key or click F1= Help in the menu bar .
Select a topic, then choose the Help button .



11 Commands

This chapter describes the commands you use to manipulate
windows, to work with files, to adjust your system settings, and to
print files. The command summaries are organized by menu; they
describe the functions of the commands in the Control menu,
MS-DOS Executive, Control Panel, and Spooler .
For details on procedures for these commands, see Chapter 4,
"Techniques"; Chapter 5, "Using MS-DOS Executive" ; Chapter 7,
"Using Control Panel"; and Chapter S, "Using Spooler ."
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0

Moue lilt +11

Alt+F$

Minimize Alt+F9

Maximize

	

Alt+110

Size

Close RIt+E

The Control Menu

The Control menu is comnioti to all moveable, sizeable windows .

It provides commands that you can use to control the size and

position of the window. A Control menu is also displayed in sonic

standard DOS appikations when they are run full-screen with

Windows .

Note Your application nlia)' append additional conitnarids to the

Control menu. See your application manual tar details on these

commands. Chapter 9, 'iJsing Standard Applicationscontains

irtc)rmation on standard commands that an application might

append.

Restore The Restore command restores a window to the size it

was before it was either enlarged to its maximum size or shrunk

to an icon .

Move The Move CO1Uh1J Jiid iris vOu nlUve a vindow tO another

position on the screen_

Size The Size command lets you change the size Of a window .

Minimize The Minimize (.unimand shrinks the selected window

to an icon .

Maximize use Maximize command enlarges the selected win-

dow to its maximum size (the size depends on the application ) .

Close The Close couaniaxid c .l%ases the application window . If

you close the last or main window (if an application, it may also

cause you to exit from the program .

MS-DOS Executive

The MS-DOS hxecutive window runs automatically when you start

Windows. You need to use the MS-1)OS Executive commands

whenever you want to run an application, end a Windows session,

or manage your tiles . See Chapter 5, "Using MS-DOS Executive"

for more detailed information .



The File Menu

Run The Run command runs an application, or a program you
have written. Use the Run command when you need to provide
additional information, such as a pathname or volume name, for a
program in order to run it .
Load The Load command starts an application as an icon in the
lower-left corner of your screen, instead of automatically running
the application in a window .
Copy The Copy command copies one or more files to a differ-
ent directory or disk . You can also use it to copy a single file to a
different filename.
Get Info The Get Info command displays the selected file's
name and extension, its size in bytes, and the date and time the
file was created or most recently changed.
Delete The Delete command deletes the selected file, files, or
directory.
Print The Print command prints the selected file or directory
listing on your printer .
Rename The Rename command lets you change the name of a
selected file .
Exit The Exit command quits MS-DOS Executive . If there are no
other MS-DOS Executive windows open, the Exit command also
ends your Windows session. You will see a dialog box asking you
to confirm that you want to end the session .
About MS-DOS Executive The About MS-DOS Executive com-
mand displays version and copyright information about Windows
and shows the amount of space currently available to the system .

The View Menu

The View-menu commands let you change the way you display
the directory listing . Checkmarks show which commands are
active . You can select one style characteristic from each group .
Short This is the default . The Short command displays a direc-
tory listing horizontally, by filename only .
Long The Long command displays a directory listing in one
long column, with name, extension, size in bytes, and date and
time last changed for each file listed . The information by which
the files are sorted (name, date, size, or kind) appears in bold .
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File
Run . . .
Load . . .
Copy . . .
Get Info
Delete . . .
Print . . .
Rename...

Exit
About MS-DOS Exec . . .

View

~Shor•t
Long

'All
Partial . . .
Pro gr •a ns

~By Mane
By Date
By Size
By Kind
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Special

End Session
Create Directors, . . .
Change Directory . . .
Format Data Disk . . .
Flake System Disk . . .
Set Uolume Mane . . .

All This is the default . The All command specifies that all the
files in a directory be listed .
Partial The Partial command lets you specify which files should
appear in a directory listing . For example, you could list all files
having the .MSP extension by typing *, msp in the text box.
Programs The Programs command specifies that only program
files will be displayed in a directory listing - these files have
.EXE, .COM, or .BAT extensions .
By Name This is the default . The By Name command sorts a
directory listing alphabetically by filename .
By Date The By Date command sorts a directory listing by the
date and time each file was created or most recently changed, list-
ing the most recent first .
By Size The By Size command sorts a directory listing accord-
ing to each file's size in bytes, from largest to smallest .
By Kind The By Kind command sorts a directory listing alpha-
betically by filename extension. Files with the same extension are
sorted alphabetically by name .

The Special Menu

End Session The End Session command ends your Windows
session. You do not need to shrink the windows that are ex-
panded or close the applications that are running before you
choose the End Session command .
Create Directory The Create Directory command lets you
create a new directory .
Change Directory The Change Directory command lets you
change directories .
`I'o move to a higher-level directory with a mouse, double-click
the section of the pathname (near the top of the MS-DOS Execu-
tive window) that you want to go to .
Format Data Disk The Format Data Disk command lets you
format a data disk from the MS-DOS Executive window .
Make System Disk The Make System Disk command lets you
create a bootable disk (containing the DOS system files) from the
MS-DOS Executive window .
Set Volume Name The Set Volume Name command lets you
give the current disk a descriptive name to identify its contents .



Control Panel

Control Panel controls some system settings . Most changes made
with Control Panel are reflected in the WIN .INI file (described in
Appendix A, "Customizing Your WIN.INI File"). See Chapter 7,
"Using Control Panel," for more detailed information .

The Installation Menu

The Installation-menu commands let you add or remove a printer
or font without rerunning the Setup program .
Add New Printer The Add New Printer command adds a printer
to your system by adding a printer-driver file to the specified disk
or directory .
Delete Printer The Delete Printer command removes a printer
you have already set up .
Add New Font The Add New Font command adds a font to
your system by adding a new font file to the specified disk or
directory.
Delete Font The Delete Font command removes a font you
have already set up .
Exit The Exit command quits Control Panel and removes the
program from system memory .
About Control Panel The About Control Panel command dis-
plays version and copyright information about the Control Panel
program .

The Setup Menu
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Installation

Add New Printer . . .
Delete Printer . . .
Add New Font . . .
Delete Font . . .

Exit
About Control Panel . . .

The Setup-menu commands let you change printer-port assign-

	

Connections . . .Th e Printer . . .
ments, set the system default printer and specify its output modes, 	ConnunicationsPort . . .

and set up serial communications ports .
Connections The Connections command lets you assign or
change printer ports .
Printer The Printer command lets you specify a default printer .
This command also displays dialog boxes for additional informa-
tion that a printer might require (type of paper, for example) .
Communications Port The Communications Port command
lets you specify a serial communications port and select parame-
ters, such as baud rate, word length, parity, and stop bits .

Setup
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Preferences

Screen Colors . . .
Border Width . . .
Warning Beep
blouse . . .
CoCountry Settings . . .

Priority

Exit
flbout Spooler . . .

/Low
High

The Preferences Menu

'The Preferences-menu commands let you control screen colors .
Screen Colors The Screen Colors command lets you specify
color adjustments to your screen .
Border Width The Border Width command lets you specify
how wide the window borders willl be . After you type a number
and confirm it by choosing the OK button, all the windows on the
screen are redrawn with the new border width .
Warning Beep The Warning Beep command lets you turn on
or off the beep that sounds in response to an invalid keystroke or
mouse click. When a checkmark appears next to the command,
the system beep is on . When no checkmark appears, the beep is
off.
Mouse The Mouse command lets you switch usage between the
left and right mouse buttons. It also lets you control the mouse
acceleration speed (how fast the mouse pointer moves) .
Country Settings The Country Settings command lets you set
variables (such as the formats for date, number, and time) for a
particular country .

P00 er

Spooler controls the printing of files. For more information on
Spooler, see Chapter 8, "Using Spooler ."

The Priority Menu

Low The Low command prints your file more slowly and frees
computer resources for other applications you are working with .
High The High command speeds up your printing job . It uses
more system resources for printing, so other applications will run
more slowly .
Exit The Exit command stops the Spooler program . If there are
any print jobs still in the queue, you will see a message warning
you that they will be terminated . You can either confirm or can-
cel the Exit command .
About Spooler The About Spooler command displays version
and copyright information about the Spooler program .



The Queue Menu

Pause The Pause command temporarily halts the job that is
printing.
Resume The Resume command restarts printing of a job that
was halted with the Pause command .
Terminate The Terminate command cancels a job that is print-
ing or that is in the queue .
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Appendix A
Customizing Your WIN .INI File

Your WIN.INI file contains settings for many Microsoft Windows
features and Windows applications. Windows checks the WIN .INI
file and uses the settings it finds there every time you start Win-
dows. When you make changes to these settings by using Control
Panel, the WIN .INI file is automatically updated to reflect the
changes .
You'll rarely need to work directly in your WIN .INI file to make
changes ; the instructions in this appendix are provided primarily
for special system customization. The settings in your WIN .INI file
may differ from those shown here .
Since Windows keeps important system settings in the WIN .INI
file, you should edit it carefully. Before you attempt to modify the
file, make a backup copy ; if you find that Windows does not run
properly with the modified WIN.INI file, you can revert to your
backup copy .
Changes you make directly to WIN .INI do not take effect until
Windows is restarted. To make the changes effective immediately,
quit Windows, then start it again .

Editing Your WIN .INI File
You can make changes directly to your WIN .INI file by using
Notepad. See the Microsoft Windows Desktop Applications User's
Guide for information on using Notepad .
When you open WIN .INI from Notepad, you will see a series of
sections that appear in the following format :

j section name]
keywordl = settingl setting2 . . .
keyword2 = settingl setting2 . . .
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Changing WIN.INI

settings

To change WIN.INI settings and make them effective immediately,

follow these steps :

0

4

Open WIN.INI from Notepad .

•

	

Locate the settings you want to change and edit them .

•

	

Save WIN.INI .

Quit and restart Windows .

Note You can also edit WIN.INI from another word-processing

application. When you save WIN.INI, be sure to save it as an ASCII

text file (unformatted). Windows will open a formatted text file

but may not be able to properly read it .

Using the Setup Program

Retaining settings in

	

At times you may need to run the Setup program again ; for exam-

the WIN .INI file

	

pie, you will need to do so if you add new hardware such as a

mouse or a graphics card, or if you update Windows . Windows is

designed so that when you run Setup, your existing WIN .INI file is

not automatically replaced. However, you may want to use some

information from the new WIN.INI file (the file that would be

created if you were running Setup for the first time) . Here's how

to save information you need from your old WIN .INI file and com-

bine it with information from a new WIN .INI file :

A

4

Make a copy of your old WIN.INI file and rename it WIN.OLD .

•

	

Delete your old WIN.INI file, then run Setup to reinstall the

Windows software .

•

	

Using Notepad or another text editor, copy the sections

of your new WIN.INI file that you want to keep into your

WIN.OLD file .

Delete your new WIN.INI file and rename WIN.OLD as

WIN.INI .

•

	

Quit and restart Windows .



Settings in [Windows]

The [windows] section of WIN.INI contains the following settings :

•

	

Spooler use
•

	

Double-click speed
•

	

Cursor-blink rate
•

	

Programs listed in MS-DOS Executive's directory listing
•

	

Applications that are run automatically when Windows is
started

•

	

System default printer selection
•

	

Mouse options
•

	

Printer-problem message delay

Windows automatically modifies the blink rate and double-click
speed in WIN .INI any time you change these settings in the Con-
trol Panel window. It is easier to change these settings by using
Control Panel than by editing WIN .INI. See Chapter 7, "Using
Control Panel," for more information.
The following settings are typical for the [windows] section in

	

Settings in [windows]
WIN.INI .

[windows]
spooler=yes
DoubleClickSpeed=58B
CursorBlinkRate=817
programs=com exe bat
Hu11Port=none
load=
run=
device=PCL/LaserJet,HPPCL,LPT1 :
SwapMouseButtons=No
xMouseThreshold=2
9MouseThreshold=2
MouseSpeed=1
beep=yes
Border Width=5
DeuiceMotSelectedTimeout=l5
TransmissianRetryTimeout=1j5

In the actual WIN .INI file, entries are often separated by comment
lines (any line beginning with a semicolon) . The comment lines
explain how to use the setting .
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The numbers that follow the equal sign in the DoubleClickSpeed
and CursorBlinkRate settings are read by Windows as millisec-
onds, and can range from 0 to--65535 . The higher the number, the
slower the rate. The device entry indicates the default printer (or
plotter), the device's printer-driver filename, and the device's
default port .

Printing Without the Spooler

Windows is designed to print files by using the Spooler program .
You can print from a Windows application without using Spooler
by editing the spooler= line in the [windows] section . Printing
without Spooler may be preferable when running Windows on a
two-drive system since it conserves disk space . However, printing
without Spoolerr slows down Windows' ability to work with other
applications while you are printing files .
When you first set up Windows, the spooler = line looks like the
following example .

spooler=yes

Changing the

	

To print without Spooler, follow this step :
spooler= line

[I] Change the spooler = line from yes to no .

Changing MS-DOS Executive's Programs Listing

When you choose the View menu's Programs command in MS-
DOS Executive, only files having the .EXE, .COM, and .BAT exten-
sions are listed. You can add or delete types of files shown by
the Programs command by editing the programs = line in the
[windows] section .
After you run Setup, your initial settings for the programs = line
look like the following example .

programs=com exe bat



load=ongoing .txt
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You may want to have other types of files listed, for example, files Changing the
with the .PIF extension. To change the programs = setting, follow programs = line
this step :

∎ Type the filename extension in the programs = line . Do not
type a period before the extension . Be sure to include a space
between filename extensions .

Starting Applications Automatically as Icons

MS-DOS Executive runs in a window automatically when you start
Windows. You can have Windows automatically start other appli-
cations as icons by editing the load = line in the [windows] sec-
tion. When you first set up Windows, the load = line is blank .
To add applications to the load = line, follow this step :

C:i] Type the filenames of the applications you want Windows to
start automatically as icons . The applications will have either a
.EXE, .CUM, or .BAT filename extension, but you do not need
to type the extension . Filenames can be up to eight characters
in length. Be sure to include a space or a comma between the
filenames.

For example, the following entry runs Clock, Control Panel, and
Clipboard as icons whenever you start a Windows session .

load=clock control clipbrd

If the filename that follows the equal sign in the load setting does
not represent an application, you must also include the file's
extension . Make sure that the file's extension is included as an
entry in the [extensions] section of your WIN .INI file. For more
information, see the section called "Settings in [Extensions]" later
in this chapter .
For example, if you have a Notepad text file of on-going activi-
ties that you want to update at the beginning of every Windows
session, you would need to put the complete filename into the
load = line, as shown in the following entry .

Adding applications
to the load = line
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Adding applications
to the run = line

When you provide only a filename in the load = line, Windows
searches the current drive and directory for the file . If the file is
not in your current drive or directory, you need to type a path-
name as the load = entry .

Note Do not list any applications that require a large amount of
memory or memory-resident applications in the load = line . For
more information on these applications, see Chapter 9, "Using
Standard Applications ."

Starting Applications as Windows
In addition to having some applications start as icons, you can
have Windows automatically start some applications as windows .
To do this, you add the appropriate filenames to the run = line
in the [windows] section of the WIN .INI file . The instructions
for adding filenames to the run = line are the same as those for
adding filenames to the run = line .
To add applications to the run = line, follow this step :

a Type the filenames of the applications that you want Windows
to automatically start as windows. The applications will have
either a .EXE, .COM, or .BAT filename extension, but you do
not need to type the extension . Filenames can be up to eight
characters in length. Be sure to include a space or a comma
between the filenames.

For example, the following setting runs Clock, Control Panel, and
Clipboard as windows whenever you start a Windows session .

run=clock ,control,clipbrd

If the filename that follows the equal sign in the load setting does
not represent an application, you must also include the file's
extension. Make sure that the file's extension is included as an
entry in the [extensions] section of your WIN .INI file. For more
information, see the section called "Settings in [Extensions]" later
in this chapter .
When you provide only a filename in the run = line, Windows
searches the current drive and directory for the file . If the file is
not in your current drive or directory, you need to type a path-
name as the run= entry .



Note Do not list any applications that require a large amount of
memory or memory-resident applications in the run = line . For
more information on these applications, see Chapter 9, "Using
Standard Applications ."

Changing Mouse Options

Several of the settings in the [windows] section affect the mouse .

	

Adjusting mouse
In Control Panel, you can adjust the mouse settings by using the

	

settings
Preferences menu's Mouse command . The following settings are
the defaults .

SwapMouseButtons=Ho
xMouseThreshold=2
yNouseThreshold=2
MouseSpeed=l

The SwapMouseButtons entry switches the mouse-button function
from the left to the right button or vice versa .
The xMouseThreshold =, yMouseThreshold =, and MouseSpeed =
settings let you change the speed at which the mouse pointer
moves across the screen .
The values of xMouseThreshold and yMouseThreshold set a num-
ber of pixels horizontally and vertically . If the mouse movement
doesn't exceed these values, there is a one-to-one correspondence
between the movement of the mouse pointer and the mouse
itself. If the mouse movement exceeds the values, then the
mouse-pointer speed equals 2 raised to the power of the
MouseSpeed value. The default value of MouseSpeed is l .

Setting the Warning Beep

The beep = line sets the warning beep that sounds when you

	

Adjusting the
press the wrong key or select the wrong option . When you set up warning beep
Windows, the beep option is active . The setting in the [windows ]
section of the WIN.INI file looks like the following entry .

beep =yes

You can turn this feature off by changing the line in the WIN .INI
file to beep = no .
In Control Panel, you can use the Preferences menu's \Warning
Beep command to turn the feature off or on .

Appendix A: Customizing Your WIN.INI File 205



206 Microsoft Windows User's Guide

Adjusting the window The BorderWidth = line specifies the window border width . The
border width

	

default value is 5 . When you set up Windows, the setting in the
[windows] section looks like the following entry .

Changing the Width of the Window Border

Border Width5

Higher values correspond to wider borders ; smaller values to nar-
rower borders. You can set the border width to any integer value
between 1 and 50. In Control Panel, you can change this setting
by using the Preferences menu's Border Width command .

Setting the Printing-Problem Message Delay

Adjusting the printing There are two additional settings in the [windows] section that
message delay

	

affect printing: DeviceNotSelectedTimeout = and Transmission-
RetryTimeout = . These settings determine the number of seconds
allowed to correct printing problems before Windows sends you a
message about the problem. The default settings are shown in the
following example .

DeuiceMotSelectedTimeout=l5
TransmissionRetryTimeout=~+5

The DeviceNotSelectedTimeout = setting specifies the amount of
time that passes before you see a message stating that the printer
is off-line .
The TransmissionRetryTimeout = setting specifies the amount of
time that passes before you see a message stating that the device
isn't ready. This message may be displayed under various circum-
stances and means that the printer is not reading the characters
that it is being sent .
In Control Panel, you can adjust these settings by using the Setup
menu's Printer command .



Settings in [Extensions]

Settings in [Colors]

The entries in the [colors] section of WIN .INI reflect the color

settings of various parts of the Windows screen . In Control Panel,

you can adjust these settings by using the Preferences menu's

Screen Colors command. The following entries are typical settings .
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Many applications supply a filename extension to the files you

	

Specifying filename

create with them. For example, Cardfile appends the extension

	

extensions

CRI) to the files you create with it . Windows puts this extension

information in the [extensions] section in the WIN .INI file .

This makes it possible for you to start an application by opening

one of the files you've created with it .

The following entries are a typical list of settings in [extensions] .

[extensions]

cal=calendar .exe " .cal

crd=cardfile .exe " .crd

trm=terminal .exe " .trm

txt=notepad .exe " .txt

You can increase the number of extensions associated with an

application by adding entries to the [extensions] section . For

example, if you want to be able to open files that have the exten-

sion .ASM from Notepad (or open a .ASM file and start Notepad at

the same time), you'd type the entry asm = notepad, exe ; asm on

its own line .

When you provide only a filename in an entry, Windows searches

the current drive and directory for the file. If the file is not in

your current drive or directory, you need to type a pathname in

the entry instead of just a filename .

Screen-color settings
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[colors]
Window=255 255 255
Windowlext1 8 8
Menu=255 255 255
MenuText1 9 8
Window1rame=8 00
TitleText=255 255 255
Actiuelitle 1 00
InactiueTitle=128 128 128
Scrol1bar=192 192 192
Background=127 127 127
AppWorkSpace=191 191 191
ActiueBorder=127 127 127
InactiueBorder=127 127 127

The three numbers on the right represent RGB (red, green, and
blue) settings respectively from 0 to 255 . Zero represents no
color (black); 255 represents fully saturated color .

Settings in [Pit]

In the [pif] section of WIN .INI, you can specify memory size for
standard applications that you run in a window . You can also use
this section to list information Windows will use when swapping
applications to a disk . When Windows swaps an application, it
temporarily transfers it from system memory to a disk .
To set the memory size for a standard application, you list the
application in the [pi] section of WIN .INI, as described in the
following section . By doing so, you can specie the amount of
memory you want the application to use without having to create
a PIF file . To run the program, Windows combines the memory
setting you listed with a group of default settings . For more infor-
mation on creating and using PIF files, see Chapter 9, "Using Stan-
dard Applications ."

Note You can create PIF settings in WIN .INI only for programs
that you are running in a window.



Creating a [Pif] Entry

To create a [pi] entry for an application, follow these steps :

Type fpi)7 on an empty line to create the [pi] section. This
entry indicates that the lines in the section contain program
information .
On the next line, type the name of the program, followed by
an equal sign, then the amount of memory (in kilobytes)
required to run the application. You can find the memory
requirements for your application in the application's manual .

El

For example, if you wanted to create entries for COMMAND.COM,
CHKDSK, and EDLIN, the [pi] section of your WIN .INI file would
look like the following example .

[pif]
command .com=32
chkdsk .com=52
edlin . com=b

Once you create a [pi] entry for a program, Windows uses the
following default settings :

•

	

Program Title : Filename without extension
•

	

Initial Directory: Ignored
•

	

Parameters: Ignored
•

	

Memory Required : Specified in the [pi] entry as described
previously

•

	

Memory Desired: Same as Memory Required
•

	

Directly Modifies : None

Specifying Swapping Information

The [pi] section in the WIN .INI file also lists the information that
Windows uses when swapping applications to a disk (see Chapter
9, "Using Standard Applications," for more information) .
The swapdisk = and swapsize = settings determine where Win-
dows swaps an application and what the minimum swap space
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Changing the
swapdisk = line

should be . When you set up Windows, the initial settings look
like the following entries .

swapdisk=?
swapsize=0

You can modify the swapdisk = line to change how Windows
swaps programs to a disk. The swapdisk = setting has the follow-
ing form :

swapdisk = drive :

This setting causes Windows to swap to the root (\) directory of
the given drive.
If you don't use the swapdisk = line in WIN .INI, Windows auto-
matically swaps to the drive and directory specified by the TEMP
environment variable. You can edit the WIN .INI file to list the
drive that contains your TEMP directory (for example,
swapdisk = c:) . If no TEMP directory is defined by the TEMP
environment variable, Windows swaps to the first hard disk in
your system . For more information on creating a TEMP directory,
see Chapter 5, "Using MS-DOS Executive ."

Note Do not set a floppy-disk drive as the swap disk .

Using expanded

	

If your computer has expanded memory, you can edit the swap-
memory

	

disk = line to take advantage of it. For more information on using
expanded memory, see Appendix E, "Special Notes on Running
Windows." To swap to expanded memory, change the swapdisk =
entry to the following line .

swapdisk=? le

If there is a shortage of expanded memory, Windows swaps to the
drive specified in the TEMP environment variable . You can also
use the /E option when swapdisk = is set to a drive ; for example,
swapdisk = c. /e. If there is no expanded memory available, Win-
dows swaps to the TEMP directory or, if no TEMP directory is
defined, to the root directory on the drive .
The setting swapdisk = 0 disables swapping completely .



When swapping applications, Windows allocates the amount of
memory reserved for swapping based on the first application that
is swapped. If swapsize = 0 (the default setting), Windows will set
the swapping size to the size of the first application that you run
that can be swapped. For this reason, you achieve best perfor-
mance by running the largest program first .
If you want to reserve a minimum amount of memory for swap-
ping, you can change the swapsize = entry to the preferred size in
kilobytes . You should reserve the program size and a 2K overhead
for saving information about the application's current state .

Settings in [Inti]

The [intl ] section in your WIN .INI file contains information about
formats for numbers, currencies, time, dates, and measures for the
particular country that Windows is installed for on your machine .
For example, the [ intl ] settings for the United States might look
something like the following entries .

[intl]
iCountry=8
iDate=B
iCurrency=9
iDigits=2
iTime=9
ilzero=8
51159=RM
x2359=PM
sCurrency=$
sThousand=,
sDecimal= .
sDate=1
slime= :
slist=,
dialog=yes

In Control Panel, you change the entries in the [intl] section by
using the Preferences menu's Country Settings command . You
most likely would edit these settings to supply information for
a country not shown in the Country Settings dialog box .
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Port settings

The following list describes the entries in the [id] section of
WIN.INI :

Setting

iDigits =

iTime =
iLzero =
s1159=
s2359=
sCurrency =
sThousand =
sDecimal =
sDate =
slime =
sList =
dialog =

Settings in [Ports]

Description

Country code; see your DOS manual for
details
•

	

for mdy (month, day, year), 1 for dmy, 2
for ymd
•

	

for currency-symbol prefix, no separation
1 for currency-symbol suffix, no separation
2 for currency-symbol prefix, one-character
separation
3 for currency-symbol suffix, one-character
separation
Number of significant decimal digits in
currency
•

	

for 12-hour clock, 1 for 24-hour clock
•

	

for no leading zeros, 1 for leading zeros
Trailing string from 0:00 to 11 :59
Trailing string from 12:00 to 23:59
Currency-symbol string
Thousands-separator string
Decimal-separator string
Date-separator string
Time-separator string
List-separator string
Always select yes. This adds the Country Set-
tings command to the Preferences menu .

This section of WIN.INI lists the ports available for your system .
A typical port setting might look like the following example .

[ports]
LPT1 :=
LTP2 :=
COM1 :=96O9,n,8,1,p
COM2 :=



The values to the right of the COM 1 : = entry represent Baud Rate,
Parity, Word Length, and Stop Bits options, in that order . See your
DOS manual for an explanation of these options .
The information in the [ports] section is automatically entered in
WIN.INI when you run Setup . In Control Panel, you can change
these entries by choosing commands from the Setup menu .

Sending Printer Output to a File

You can send printer (or plotter) output to a file rather than to
the printer by adding the file's name to the [ports] section . This is
useful if you want to format a document for a printer that you do
not have on your system (you don't need to have the printer to
use its printer-driver file) . For example, in the following [ports]
section, the line OUTPUT.PRN = has been added so that output
can be sent to the OUTPUT.PRN file .

[ports]
LPT1 :=
LTP2 :=
COM1 :=9688,n,8,1
COM2 :=9608,n,8,1
OUTPUT .PRM

To send printer output to a file, follow these steps :

Add the filename to the [ports] sections of your WIN .INI file .
Quit and restart Windows .
Run Control Panel.
Select the Setup menu and choose the Connections command .
A dialog box appears . The filename you added to WIN .INI is
displayed with the other ports in the Connections list box .
In the Printer list box, select the printer on which you eventu-
ally want to print the file .
Select the filename in the Connections list box .
Choose the OK button .

0

4

11

6

Ii

You can list up to eight entries (including your normal port list-
ings) in the [ports] section. Each time that you send printer out-
put to the file, the information that was previously in the file is
overwritten .
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Device settings

Settings in [Devices]

The [devices] section in WIN.INI lists your system's output (print-

ing) devices and their printer-driver files and port connections .

The settings in [devices] are set when you run the Setup program

and can be reset in Control Panel by using the Setup menu

commands .

A typical [devices] section looks like the following entries .

[devices]

PCLILaserJet=HPPCL,LPT1 :

Postscript Printer=PSCRIPT,LPT2 :

The left side of the setting specifies the printer name, and the

right side specifies the device's printer-driver file and port (if

one is assigned) .

Settings in [Fonts]

Font settings

	

The fonts available on your system are listed in the [fonts] section

of the WIN.INI file. In the following example of a [fonts] section

entry, italics represent characters to be typed exactly as shown

and bold represents placeholders whose actual names or numbers

you must supply . The format of an entry is as follows :

fontname pointsize(s) (Set #number) = font filename

The following line is a typical [fonts] entry.

Courier 8,10,12 (Set #2)=coura

In Control Panel, you can add and delete fonts by using com-

mands from the Installation menu .



Appendix B
System Messages

This appendix describes the messages that may appear with
Microsoft Windows in the middle of your window or MS-DOS
Executive screen. Messages are divided into two sections : those
that are generated by Windows and those that are generated by
MS-DOS Executive. The messages are listed alphabetically within
each section .
Many of the messages appear in dialog boxes that have an OK and
a Cancel button. Choose OK to make the dialog box and the mes-
sage disappear before you proceed. Some dialog boxes include a
Retry button . Choose this if you want to try the operation again .

Windows Messages

Cannot find program . Please insert in drive d
•

	

Windows needs a program or file that is not on the disk in the
active drive.
Insert the specified disk and choose the OK button .

Cannot read from device device
•

	

Windows is unable to read from the specified DOS device.
The specified device was not available for input. Be sure
the device is properly set up (and if appropriate, turned on) .
Choose the Retry button to try the operation again, or the
Cancel button to end the operation . Check your DOS man-
ual for further information about device names and errors .

Cannot read from drive d
•

	

There is no disk in the specified drive.
Insert a disk in the specified drive . Choose the Retry button to
try the operation again .

•

	

The disk-drive door may be open or the disk may not be
inserted properly (if a floppy-disk drive is specified).
Check to be sure the disk is inserted properly . Choose the
Retry button to try the operation again .
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∎ Windows could not read the disk in the drive you specified .
The disk may be defective, damaged, or unformatted.
Choose the Retry button to try the operation again . If you con-
tinue to receive this message, choose the Cancel button . You
may want to run the DOS CHKDSK program to check the disk .
For more information on CHKDSK, see Appendix E, "Special
Notes on Running Windows ." See your DOS manual for details
about disk errors .

Cannot write to device device
•

	

Windows is unable to write to the specified DOS device.
The specified device was not available for output . Be sure
the device is properly set up (and if appropriate, turned on) .
Choose the Retry button to try the operation again, or the
Cancel button to end the operation . Check your DOS man-
ual for further information about device names and errors .

Cannot write to drive d
•

	

There is no disk in the specified drive .
Insert a disk in the specified drive . Choose the Retry button to
try the operation again .

•

	

The disk-drive door may be open, or the disk may be improp-
erly inserted (if a floppy-disk drive is specified) .
Check to be sure the disk is inserted properly . Choose the
Retry button to try the operation again .

•

	

Windows could not write to the disk in the drive you speci-
fied. The disk may be defective, damaged, or unformatted.
Choose the Retry button to try the operation again. If you con-
tinue to receive the message, choose the Cancel button . You
may want to run the DOS CHKDSK program to check the disk .
For more information on CHKDSK, see Appendix E, "Special
Notes on Running Windows ." See your DOS manual for details
about disk errors .

No appropriate data in Clipboard
•

	

You have attempted to paste data from the Clipboard into a
standard application; however, the data on the Clipboard are
not transferrable (they may be graphics) .
Verify that the data you are attempting to paste are not graphics
(graphics cannot be pasted into a standard application) .



Not enough memory for Clipboard
•

	

You have too many applications running in Windows.
Close some applications. You could also try reducing the
amount in the Memory Required option in the application's
PIF file . Then try to run your application again .

Printer not ready
•

	

The printer may be out of paper or the printer is not on .
Be sure the printer paper is properly installed and that the
printer is connected and turned on .

Write protected disk in drive d
•

	

The disk in drive d is write protected,
To write to this disk, remove the write-protect tab and choose
the Retry button. Otherwise, choose the Cancel button .

MS-DOS Executive Messages

Application still active
•

	

A standard application is still open. This message will appear
if you attempt to end the Windows session while a standard
application is still running
Quit any standard applications that may be running . Use the
application's quit or exit command .

Cannot change directory to name
•

	

You have specified a filename instead of a directory name
Select or type a directory name, then retry the Change Direc-
tory command .

Cannot copy file to itself
•

	

You have attempted to copy a file to the same filename on
the same disk or in the same directory. This is not allowed
because it would destroy the file
Copy the file again, specifying a different filename .

Cannot copy more than one file to a single file
•

	

You have selected more than one filename and specified a
single file as the destination.
Select the file you want to copy and start again . To copy
multiple files, specify a directory to copy them into .
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Cannot create directory directory name
•

	

You tried to create a directory using a name that already
exists in the current directory .
Retry the command with a unique directory name .

∎ You tried to create a directory on a disk that is write-
protected
Remove the write-protection tab, then retry the command .

Cannot create filename
•

	

You tried to save your work to a read-only file .
Specify another filename when you save your work .

Cannot delete filename
•

	

You have tried to delete a file on a write protected disk .
Remove the write-protection tab and try again .

•

	

You have tried to delete a read-only file .
You cannot delete the file .

Cannot delete the current directory
•

	

You have attempted to delete the current directory. This is not
allowed, even if the directory is empty.
Move to the parent directory and start again .

Cannot find filename
•

	

You have chosen an action that requires a file, and MS-DOS
Executive cannot find the file in the directory or on the disk.
Make sure you typed the filename correctly . You may need to
change directories to locate the file, or you may need to type
the file's pathname . If the file is not on the disk, insert the disk
that contains the file in the drive . Choose the command and try
again.

Cannot format diskette
•

	

The disk is probably defective or read-only.
Replace the disk and try again .

Cannot print
•

	

Your printer is not properly installed (this includes having
proper settings in the WIN INI file) .
Check the printer connections and Control Panel printer set-
tings. Set your printer up properly and start again . (See Chapter
7, "Using Control Panel," for details about printer settings .)

Cannot put DOS system on the diskette
•

	

The disk cannot be formatted with the system files .
Put a blank formatted disk in the drive and retry the command .



Cannot rename name
•

	

The specified file does not exist in the current directory or on
the disk.
Make sure the filename exists, then retry the Rename command .
You cannot rename a directory .

Cannot run filename
•

	

An error has occurred while running a program .
Retry the Run command . If the command still does not work,
be sure you are trying to run the correct file .

Cannot run with other applications
•

	

The program you selected is a special application that loads
and stays resident or has the Modifies Memory option set in
its PIF file
You must close all applications except MS-DOS Executive
before you can start this program .

Cannot set volume name
•

	

The disk is write protected
Remove the write-protection tab .

∎ The disk is full.
Check the directory to see if any files can be removed, then try
again .

Cannot start this application
•

	

The standard application you are attempting to run cannot be
run because of an internal error.
Try to start the application again . If unsuccessful, check to be
sure the application runs under DOS . You may need to close
Windows, restart DOS, then restart Windows before trying the
application again.

COM1 is not available
•

	

The application you have selected requires access to serial
communications port 1 (COMI) .
To run the program you selected, you must close any other
application that accesses the COM 1 port .

•

	

You do not have a serial communications card installed as
COMJ.
If you don't have a serial port, you cannot run the selected
program .
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COM2 is not available
•

	

The application that you selected requires access to serial
communications port 2 (COM2).
To run the program you selected, you must close any other
application that accesses the COM2 port .

•

	

You do not have a serial communications card installed as
COM2.
If you don't have a serial port, you cannot run the selected
program .

COM1 or COM2 is not available
•

	

The application that you selected requires access to serial
communications port 1 or 2 (COMI or COM2) .
To run the program you selected, you must close any other
application that accesses the COM 1 or COM2 port .

•

	

You do not have a serial communications card installed as
COMJ or COM2.
If you don't have a serial port, you cannot run the selected
program .

Directory is not empty
∎ The directory that you tried to delete still contains files

Delete the files from the directory, or move them to a different
location, and start again .

directory name has no files in it
•

	

You tried to copy files from an empty directory .
Check to see that you used the correct directory name .

Disk is full
•

	

You have tried to save a file, or have carried out an action
that requires creating a new file (such as copying), and the
disk is full.
Insert another disk, or delete any unwanted files and directories
from the disk, and try again .

Initial directory not found
•

	

The initial directory for this program cannot he found or is
invalid.
Check the PIF file for the program and be sure that the initial
directory setting is correct .

Multiple destinations not allowed
•

	

You have attempted to copy a single file to more than one
new file, or to rename a single file with more than one new
name.
Copy or rename the file to a single destination .



Multiple files not allowed

•

	

You have specified too many filenames for a command

Retry the command with only one filename specified .

Need more disk space

•

	

You attempted to load a standard application that required

that Windows swap another application to disk. There was

insufficient disk space for swapping

Close one of the other standard applications you have run-

ning and try the command again. If there is still limited space

remaining on the swap disk, you might consider deleting some

files.

Need WINOLDAP files to run program

•

	

The program you selected requires the Windows system files

WINOLDAP. MOD and WINOLDAP. GRB to run.

These files should be in the same directory as your other Win-

dows system files. Check the directory to make certain that

they are available, and then try running the program again .

Not enough memory

•

	

You have carried out an action, such as copying a file, that

requires more memory than Windows currently has available.

Close one or more applications and try again .

Not enough memory to display entire directory

•

	

MS-DOS Executive requires more memory than is currently

available to display the directory in full.

If you want to see the entire directory, close one or more

applications .

Not enough memory to run filename

•

	

Windows tried to run a program that requires more memory

than is currently available.

See the following section called "Not Enough Memory to Run"

for a detailed explanation of this message .

This will end your Windows session

•

	

You chose either the Close, Exit, or End Session command, and

Windows is asking you to confirm that you want to end the

session.

Choose the OK button to end the session . Choose the Cancel

button to cancel the Close, Exit, or End Session command and

continue working with Windows .
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Not Enough Memory to Run

Since standard DOS applications vary considerably from one to
the next, there may be various circumstances under which Win-
dows will display a message stating that there is not enough
memory to run an application. This section describes several pos-
sible situations, and gives corrective actions you can take to make
your standard application run or run better with Windows .

Not enough memory to run filename
•

	

Windows tried to run a standard application that requires
more memory than is currently available .
Close one or more applications, then try to run the application
again.

•

	

The Memory Required option in the application's PIF file is
set too low. The application fails in its attempt to load and
execute.
Check the amount of memory used by the application and be
sure the Memory Required option is set for at least the
required amount .

•

	

The Memory Required option in the application's PIF file is
set too high. Windows attempts to allocate that amount of
memory from its available system memory; if the amount is
more than is available, the application will not load .
Check the amount of memory used by the application and be
sure the Memory Required option is not set excessively higher
than the required amount .

•

	

The swapsize setting in the fpifJ section of the WIN.INI file is
set too low. Swapsize determines how much memory is set
aside to run full-screen standard applications. Swapsize must
be set high enough to allow for the program size, plus space
for screen exchange, screen switching any temporary files, and
a 2K overhead for saving information about the application's
current state.
Determine the amount of space in kilobytes that you think the
application will need, based on the above requirements . Edit
the WIN.INI file to set swapsize equal to this amount .
You can also set swapsize = o (default setting) and run the larg-
est full-screen standard application first . Windows assigns a par-
tition size that will accommodate the first full-screen standard
application .



• The Memory Desired option in the application's PIF file is set
too low. Windows gives the application the necessary memory
up to the desired amount, Memory Desired must be set high
enough to allow for the program size as well as data space
used by the program.
Set the Memory Desired amount higher .

•

	

You are attempting to run a standard application that
requires more system memory than is available .
To check available memory, select the File menu from the MS-
DOS Executive window and choose the About MS-DOS Execu-
tive command . You may need to close some applications, then
try running your application again .

•

	

There may be other applications running that do not swap to
the partition (the amount of memory set aside to run full-
screen standard applications) because they directly modify
memory; communications ports, or the keyboard. (Applica-
tions that can be swapped modify the screen .) The system may
be running out of memory.
Close some or all of these applications and try running your
application again .

•

	

You may have one or more memory-resident applications
loaded in your system that are causing problems with the
application you're attempting to run .
Close the memory-resident applications before trying to run
your application again .
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Appendix C
Speeding Up Windows
with SMARTDrive

Using SMARTDrive

•

	

An IBM PS/2, IBM PC XT, IBM PC AT, or IBM PC-compatible
with a hard disk

•

	

An expanded memory board or an extended memory board

Expanded memory is memory beyond 640K that uses page-
switching technology (such as INTEL Above Board and AST
RAMPage) and that can be used in most personal computers .

SMARTDrive is a disk-caching program for computers that have a
hard disk and expanded or extended memory . Disk-caching pro-
grams are designed to reduce the amount of time your computer
spends reading data from your hard disk . SMARTDrive, unlike
other disk-caching programs, cooperates with Microsoft Windows
to provide the most effective use of the expanded or extended
memory .
SMARTDrive is ideal for users who work with many applications

	

Advantages of
and files at once. It is especially useful when running multiple

	

SMARTDrive
standard applications that require swapping- copying applica-
tions to and from the hard disk to make room for all applications
in memory. Although SMARTDrive can be used in conjunction
with applications that use expanded or extended memory, it
should not be used with other memory-disk or disk-caching
programs.
This appendix describes the following :

•

	

What you need to use SMARTDrive and how it works
•

	

How to set up and use SMARTDrive
•

	

The messages you may see from SMARTDrive

To use SMARTDrive with your computer, you need the following : Hardware
requirements

225
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Installation of the expanded-memory-board hardware and a special
program called the expanded memory manager give Windows and
its applications access to the additional memory .

Extended memory

	

Extended memory is memory beyond one megabyte on PC AT
or compatible systems. This memory is generally not accessible
to DOS- and Windows-based programs but can be used by mem-
ory-disk programs such as IBM VDISK or Microsoft RAMDrive .
Extended memory boards such as the AST RAMPage AT or INTEL
Above Board/AT can be set up for either expanded or extended
memory (or both) if the correct software is installed .

Determining which

	

SMARTDrive works best with expanded memory, but will also
memory to use

	

provide good results with extended memory . To determine which
type of memory to use with SMARTDrive, follow these rules : if
you have only expanded memory, use expanded ; if you have only
extended memory, use extended ; if you have a memory card that
can be set up to use as expanded or extended memory, set it up
as expanded; and if you have both expanded and extended
memory cards, use extended memory for SMARTDrive and leave
expanded memory for Windows . When using expanded memory,
follow the instructions provided by your memory-board manufac-
turer for installing the expanded memory manager. It is recom-
mended that you set up your memory board to provide the max-
imum amount of space for expanded memory .

How SMARTDrive Works

Saving time

	

SMARTDrive reduces the amount of time it takes for Windows and
and space with

	

standard applications to read information from your hard disk . To
SMARTDrive

	

do this, SMARTDrive saves information read from or written to
your hard disk in your computer's expanded or extended mem-
ory. SMARTDrive then supplies this information directly from
memory whenever an application makes a request to read the
information from your hard disk, a relatively time-consuming pro-
cess. SMARTDrive always copies new or modified information to
the hard disk as well as to expanded or extended memory, so
there is no danger of losing information when you turn off your
computer .
SMARTDrive works closely with Windows to conserve space, sav-
ing information in memory only if that information is needed . For
example, if you quit an application, SMARTDrive removes any
information used by that application and makes the space available
for the next application you start .



SMARTDrive and Other Disk Programs

When running Windows, you should use SMARTDrive as a

	

Replacing other
replacement for any memory-disk program (such as VDISK)

	

memory-disk
or any disk-caching program (such as Vcache or LIGHTNING) .

	

programs
Although these programs are designed to make use of your
expanded or extended memory, none is designed to work with
Windows to make the best use of the memory in your computer .
If you are already using a memory-disk or disk-caching program,
you must modify your CONFIG.SYS file to remove any command
lines associated with that program . See the documentation pro-
vided with the program for information about its CONFIG .SYS
command lines.

Using SMARTDrive for Swapping

SMARTDrive automatically provides its time-saving features when-
ever you specify your hard disk as the swap disk for standard-
application swapping. There are no special settings required in
your WIN.INI file to make SMARTDrive work. SMARTDrive carries
out its work transparently .

Setting Up SMARTDrive

To set up your system to use SMARTDrive, follow these steps ;

0 Install your expanded- or extended-memory hardware accord-
ing to the manufacturer's instructions .

1 Add an appropriate SMARTDrive command line to your
CONFIG.SYS file. The command-line format is described in
the following section.
If you do not have a CONFIG .SYS file, use a text editor to
create one in your hard disk's root directory . For information
about CONFIG.SYS, see your DOS reference manual .
If you have an expanded memory board, the SMARTDrive
command line must follow any CONFIG .SYS command lines
that are used to install and prepare the software required to
use the expanded memory . For information about these com-
mand lines, see the documentation provided with your
expanded memory board .
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4

6

Delete any command lines associated with other memory-disk
or disk-caching programs from the CONFIG .SYS file .
Save the CONFIG.SYS file in your hard disk's root directory .
Copy the SMARTDRV.SYS file from the Windows Utilities disk
to the directory specified in your SMARTDrive command line .
Restart your computer to start SMARTDrive . From now on,
SMARTDrive will start each time you start DOS .

Using the SMARTDrive Command Line

The SMARTDrive

	

You add a SMARTDrive command line to your CONFIG .SYS file
command line

	

to tell your computer where the SMARTDrive program file is,
how much memory you want SMARTDrive to use, and whether
SMARTDrive should use expanded or extended memory . In the
following description of the SMARTDrive command line, brackets
([])surround optional fields and italics represent names to be
typed exactly as shown (any combination of uppercase and lower-
case can be used) .
The SMARTDrive command line has the following form :

device = [d : ] 1path]smartdrv, sys [size] [la]

DEVICE = Tells DOS to install a device driver. In this case,
SMARTDrive is the device-driver program .
d : The disk drive where you store the SMARTDRV.SYS file . If the
file is on the disk you use to start DOS, you don't need to include
a disk-drive designation .
path The directory where you store the SMARTDRV.SYS file . If
the file is in the directory you use to start DOS, you don't need to
include a pathname .
SMARTDRV.SYS The name of the SMARTDrive program file .
You must include this part of the command line .
Size The amount of memory you want SMARTDrive to have . If
you don't specify an amount of memory, SMARTDrive will receive
256K (the default size) . If you plan to run a standard application
that uses expanded or extended memory, you should specify a
size that leaves enough memory for that application .
IA Use this switch if you have expanded memory or if you want
to use your extended memory board as expanded memory .



Sample SMARTDrive Command Lines

The following are two sample SMARTDrive command lines with
explanations of their effects .

Sample One

device=c :\winlsmartdru .sys 19214 la

This command line gives SMARTDrive 1024K (one megabyte) of
expanded memory. DOS looks for the SMARTDRV.SYS file in the
WIN directory on drive C : .
When SMARTDrive is set up, the following message will appear :

Microsoft SMARTDrive RAM Cache version x.xx
Cache Size : yyyyK in Expanded Memory

In this message, yyyyK is the amount of memory in kilobytes that
SMARTDrive was able to obtain .
If the memory specified is not all of the available memory, then
the memory remaining can be used by other programs running
with Windows .

Sample Two

device=smartdru .sys

This command line gives SMARTDrive all available extended
memory. DOS looks for the SMARTDRV.SYS file in the drive or
directory you start DOS from .
When SMARTDrive is set up, the following message will appear :

Microsoft SMARTDrive RAM Cache version x.xx
Cache Size : yyyyK in 80286 Extended Memory

In this message, yyyyK is the amount of memory in kilobytes that
SMARTDrive was able to obtain .
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SMARTDrive Messages

The following messages may appear when you start the SMART-
Drive program. Most messages indicate some problem that needs
correction before SMARTDrive can be installed and operate prop-
erly. Messages are listed in alphabetical order .

Bad or missing d:path SMARTDRV.SYS
•

	

The drive letter (d :) or the pathname (path) is incorrect, The
SMARTDRV.SYS file is not in the drive or directory shown in
the SMARTDrive command line.
Edit your CONFIG.SYS file and type the correct drive and path-
name in the SMARTDrive line .

Microsoft SMARTDrive RAM Cache version x .xx
Cache Size : yyyyK in Expanded Memory
•

	

This SMARTDrive message appears when DOS sets up SMART-
Drive, x .xx is the version of SMARTDrive and yyyy is the
amount of memory in kilobytes that SMARTDrive was able
to obtain.

SMARTDrive: Expanded Memory Manager not present
•

	

You included the /A switch in the SMARTDrive command line
but SMARTDrive could not find the expanded memory man-
ager. Your system boot disk did not install the expanded
memory manager. Your CONFIG.SYS file did not contain the
appropriate information.
Consult the documentation for your expanded memory hard-
ware for correct installation instructions .

SMARTDrive: Expanded Memory Manager Status shows
error
•

	

While trying to set up SMARTDrive in expanded memo?y,
DOS detected an error. DOS will not install the SMARTDrive
program.
Run your expanded memory diagnostics to check your
expanded memory. Take the appropriate corrective action
as instructed in your expanded memory manual .

SMARTDrive: Computer must be PC-AT, or PC-AT
compatible
•

	

You do not have extended memory because you don't have
an IBM PC AT or PC AT-compatible computer. DOS will not
install the SMARTDrive program.
If you have expanded memory, use /A on the SMARTDrive com-
mand line . If you have neither extended nor expanded memory,
you can't use SMARTDrive .



SMARTDrive : Incorrect DOS version
•

	

S1llARTDrive runs only on 2.x and ,3.x versions of DOS DOS
will not install the SMARTDrive program .
Because Microsoft Windows requires DOS 2 .x or later, you
need to switch to a 2 .x or later version of DOS so that you can
run Windows as well as SMARTDrive .

SMARTDrive: Insufficient memory
•

	

Your system has insufficient memory available for SMART-
Drive. DOS will not install the SMARTDrive program .
If you want to use the SMARTDrive program, You must add
memory to your system .

SMARTDrive : Invalid parameter
•

	

The command line contains too many parts such as more
than one number or more than one pathname.

•

	

The size number is out of the range of permitted numbers For
example, you may have the SMARTDrive size set for 8k; which
is too small. DOS will not install the SMARTDrive program.
Edit your CONFIG.SYS file and change the incorrect SMART-
Drive line .

SMARTDrive: I/O error accessing drive memory
•

	

DOS detected an error while trying to set up SMARTDrive. DOS
will not install the SMARTDrive program.
Run memory tests to check the memory where SMARTDrive is
set up .

SMARTDrive: No extended memory available
•

	

Your system has no memory available for SMARTDrive. DOS
will not install the SMARTDrive program .
If you want to use the SMARTDrive program, you must add
memory to your system .

SMARTDrive : No hard drives in system
•

	

Your system has no hard disk. DOS will not install the
SMARTDrive program. SMARTDrive only works with hard
disks.
If you want to use the SMARTDrive program, you must add a
hard disk to your system .

SMARTDrive: Too many bytes per track on hard drive
•

	

Your system has a hard disk that SiTfARIDrive does not under-
stand DOS will not install the SMART Drive program .
You can't use SMARTDrive on your system .
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Appendix D
Using Special Characters

You can add special characters such as a fraction, an accented
letter, a foreign currency symbol, or a ligature to the documents
you create in Microsoft Windows.
Your computer uses character sets to translate your keystrokes
into the symbols you see on your screen or in the files you create .
These sets vary between computer manufacturers .
Windows uses the American National Standards Institute (ANSI)

	

The ANSI character
8-bit character set, which allows you to represent up to 256 char- Set
acters (0-255). The ANSI character set is split into two parts :
0-127 and 28-255 .
The first part of most 8-bit character sets (0-127) matches the
ANSI character set and corresponds to the letters and symbols
you see on a standard US keyboard . The second 128 characters
(128-255) represent special characters such as letters in foreign
alphabets, accents, currency symbols, or fractions . Computer
manufacturers often differ in their definitions of the second part
of 8-bit character sets .
This appendix explains how to do the following :

•

	

Type special characters in Windows using the ANSI character
set

•

	

Use your computer's character set with Windows applications
•

	

Type special characters in standard applications

Using Special Characters
in a Windows Application

Since Windows uses the extended ANSI character set, you can
type any of the ANSI characters in files you create with Windows .
The ANSI character set is shown on the following chart .
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* No conversion for this character.
* * Values 8, 9, and 13 convert to the backspace, tab, and carriage-return
characters, respectively .

ANSI Character Set

ANSI character chart *0 32 64 @ 96 128 1 160 192 h 224
1 33 t 65 A 97 129 1 161 193 ii 225
2 * 34 66 B 98 130 1 162 194 A 226
3 * 35 67 C 99 131 1 163 195 227
4 * 36 68 d 100 132 i 164 196 228
5 * 37 I 69 E 101 133 1 165 197 229
6 * 38 70 F 102 134 1 166 198 R 230
7 * 39 71 C 103 135 1 167 199 c 231
8 ** 40 I 72 H 104 136 1 168 200 E 232
9 ** 41 7 73 I 105 137 1 169 201 233

10 * 42 74 J 106 138 1 170 202 E 234
11 * 43 75 K 107 139 1 171 203 E 235
12 * 44 76 L 108 140 1 172 204 I 236
13 ** 45 77 M 109 141 1 173 205 f 237
14 * 46 78 N 110 142 1 174 206 1 238
15 * 47 79 0 111 143 1 175 207 I 239
16 * 48 80 P 112 144 1 176 208 240
17 * 49 81 Q 113 145 1 177 209 B 241
18 * 50 82 R 114 146 1 178 210 242
19 * 51 83 S 115 147 1 179 211 4 243
20 * 52 84 T 116 148 1 180 212 $ 244
21 * 53 85 U 117 149 1 181 213 4 245
22 * 54 86 V 118 150 1 182 214 246
23 * 55 87 W 119 151 1 183 215 1 247
24 * 56 88 X 120 152 1 184 216 0 248
25 * 57 89 Y 121 153 1 185 i 217 U 249
26 * 58 90 Z 122 154 1 186 0 218 A 250
27 * 59 91 I 123 155 1 187 219 u 251
28 * 60 92 1 124 156 1 188 I 4 220 U 252
29 * 61 93 l 125 157 1 189 221 253
30 * 62 94 " 126 158 1 190 222 254
31 * 63 95 _ 127 159 1 191 4 223 U 255



To type a special character while you are using Windows, follow

	

Typing special
characters in
Windows

these steps :

II

4

For example, to type the English pound symbol (,) in a Windows Typing a sample
special characterfile or a text box, follow these steps :

0

4

Locate the character you want on the ANSI chart and its
corresponding numeric value in the column to left .

•

	

Press and hold down the ALT key.
•

	

Using the numeric keypad to the right of your keyboard, type
0 and then the 3-digit number from the ANSI chart .
Release the ALT key.

Find the number on the ANSI chart that corresponds to the
symbol (163) .

•

	

Press and hold down the ALT key.
•

	

Type 0163 on the numeric keypad .
Release the ALT key.

The £ symbol appears on your screen .

Note If you want to save a file using a special ANSI character in
the filename, make sure the character exists in your computer's
character set as well. If the character does not exist in your com-
puter's character set, Windows substitutes another character .

Using Your Computer's
Character Set in Windows

You can continue to use your computer's character set when you
work in Windows, as long as the special characters you use have
an ANSI equivalent . Windows performs the conversion to ANSI for
you. If there is no corresponding ANSI character, Windows dis-
plays an arbitrary character .
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Typing characters

	

To type a character from your computer's character set in Win-
with your computer's
character set

doors, follow these steps :

0

4

Check your computer's manual for the character's value .
•

	

Check the preceding ANSI chart to make sure the character is
included.

•

	

Press and hold down the ALT key.
Using the numeric keypad on the right of your keyboard, type
the three-digit number from your computer's character set .

•

	

Release the ALT key.

Windows converts the special character to its ANSI equivalent and
the character appears on your screen .
As an example, the following chart shows part of the IBM PC
extended character set . These characters have a corresponding
ANSI character .

IBM PC Extended Character Set
PC character chart

128 G 144 160 176 192 + 208 + 224 240
129 t 145 161 1 177 193 + 209 + 225 13 241
130 c 146 11 162 0 178 194 + 210 + 226 242
131 a 147 a 163 u 179 I

	

195 + 211 + 227 243
132 a 148 0 164 n 180 + 196 - 212 + 228 244
133 a 149 0 165 181 + 197 + 213 + 229 245
134 150 u 166 182 + 198 + 214 + 230 ii 246
135 c 151 u 167 a 183 + 199 + 215 + 231 247
136 c 152 y 168 C 184 + 200 + 216 + 232 248 a

137 e 153 169 185 + 201 + 217 + 233 249
138 c 154 U 170 186 I 202 + 218 + 234 250
139 1 155 171 187 + 203 + 219 235 251
140 i 156 £ 172 188 + 204 + 220 236 252 n
141 1 157 173 4 189 + 205 = 221 237 253 2

142 158 p 174 tt 190 + 206 + 222 238 254
143 159 £ 175 191 + 207 + 223 239 255



Here's how to type the English pound symbol (£) in Windows
using the IBM PC extended character set :

n Press and hold down the ALT key .
•

	

Type 156.
•

	

Release the ALT key.

Windows converts the £ symbol's value in the computer's charac-
ter set to its equivalent value in ANSI, and the ANSI £ symbol is
displayed on your screen .

Note If, after typing special characters in Windows, you work on
your files with a non-Windows application, you may find that dif-
ferent characters are substituted for your special characters . This
is because the ANSI character values correspond to different
values in your computer's character set .

Using Special Characters
in a Standard Application
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Typing a sample
special character

Applications that were not written specifically for Windows (Stan- Special characters in
dard applications) use your computer's character set, but the pro- standard applications
cedure for typing the character's value differs slightly from what
you may be used to .
In a standard application, type a special character by following
these steps :

0

4

Check your computer's manual for the character's value .
•

	

Press and hold down the ALT key.
•

	

Using the numeric keypad on the right of your keyboard, type
o and the 3-digit number from your computer's character set .
Release the ALT key .

The special character appears on your screen .
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Typing a sample

	

For example, to type the English pound symbol (£) in a Word
special character

	

document on a computer that uses the preceding IBM PC
extended character chart, you do the following :

0
Fl

Press and hold down the ALT key .
Type 0156.
Release the ALT key .

The £ symbol appears in your Word document .

Using Special Characters
in a Non-Windows Document

If you work in Windows on files created with other applications,
you may find that any special characters appear as arbitrary char-
acters - for example, a black rectangle (I) . Windows attempts to
translate these characters, but you will probably need to convert
each character to its corresponding ANSI character .
Microsoft Write has an automatic conversion feature that converts
characters in non-Windows files to the ANSI character set . See the
Microsoft Windows Write User's Guide for more information .



Appendix E
Special Notes
on Running Windows

This appendix contains additional information on the following
topics :

•

	

Running Microsoft Windows with certain hardware
•

	

Running certain standard applications
•

	

Using expanded memory with Windows
•

	

Using CHKDSK with Windows
•

	

Using SHIFT + PRINTSCREEN with Windows

Notes on Hardware

Maynard Hard Disk

If you have a Maynard hard disk, it is recommended that you use
only version 2.4 or greater of the hard-disk software. An early ver-
sion of the Maynard hard-disk software may contain an error that
prevents it from working correctly with Windows .

Pointing Devices

If you have a Microsoft Bus Mouse, and Windows does not
respond to mouse movements, you may need to change the
jumper on the Bus Mouse Adapter. Generally, you should set
the jumper to IRQ2 for the IBM PC XT and IRQ5 for the IBM
PC AT. See the Microsoft Mouse User's Guide for details on how
to change the jumper .

TI Printers

If you have a TI850 or 855 printer, set the mode switch for draft-
quality text when you use the printer with Windows . On the TI-
855, you can only use the default character set since this is the
one supported by the Windows device driver. Font cartridges for
the 11855 are not supported .
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Running Applications with Display Adapters

Your display adapter may have additional features beyond those
supported by the display driver, and your standard application
may use some of these features . If so, you will probably be able to
run the application, but screen switching and taking "snapshots" of
the screen won't work correctly. To correct this problem, set up
the software when you install it so that it does not use the display
adapter's special features .
If you are using a standard application with an enhanced graphics
adapter (EGA) card that is running in high-resolution mode, your
application will not switch. If you want your application to be
able to switch, you should install or run the application in
character/text or low-resolution graphics mode .

Notes on Standard Applications

Since these applications were not originally designed to run with
Windows, there are some tips you should follow to make them
run smoothly .

Running BASIC and BASICA with Windows

The PIF files for BASIC that are included with Windows, BASIC .PIF
and BASICA.PIF, have been set up to prevent conflicts between
BASIC and other communications programs you may be running .
(COM options have been set in these PIF files .) There are two
results that you should be aware of:

Running multiple

	

∎ Setting the COM options prevents you from running multiple
copies of BASIC

	

copies of BASIC at the same time . If you wish to run more
than one copy of BASIC, use PIF Editor to turn off the COM
check boxes .

Running BASIC

	

∎ When you attempt to run BASIC or BASICA without a com-
without a eommuni-

	

munications port installed on your system, you will receive a
cations port

	

message indicating that the communications ports are unavail-
able. Although the message itself does not cause any action,
you may want to avoid getting this message each time you
start BASIC . If so, use PIF Editor to turn off the COM check
boxes.



Using Lotus Symphony with Windows

When using the Symphony program with Windows, be aware that
the Paste command (Control menu) will not work for character
strings longer than 40 characters . Symphony doesn't process char-
acters until the end of the string and Symphony's internal buffer
limit is 40 characters .

Using Lotus 1-2-3 with Windows

When run with Windows, Lotus 1-2-3 may not close the printer
file properly . To print over a network, you will need to press
CONTROL + ALT + PRINTSCREEN, which closes the printer file.

Using Expanded Memory with Windows

You can use your computer's expanded memory to store and
run applications with Windows . Expanded memory, found on
expanded memory boards, increases the size of your computer's
available memory beyond the 640K that DOS makes available to
applications. Computers that use expanded memory must load
and run a special program called an expanded memory manager .
Windows can use expanded memory for applications and data if
your computer's expanded memory manager has special support
for Windows .
If you plan to use expanded memory with Windows, you may
want to change the memory configuration of your computer to
take the best possible advantage of your expanded memory board .
Sometimes expanded memory works best if you disable some of
your computer's main memory. For tips on whether you should
change your memory configuration and for an explanation of how
to change the configuration, see the README .TXT file provided
on the Microsoft Windows Write Program disk .

Note Windows cannot use extended memory . Extended mem-
ory is memory used with computers such as IBM PC AT and
compatibles that provides program and data storage beyond the
one megabyte limit of these computers . If your computer has
extended memory, you can use it indirectly with Windows by
using the SMARTDrive program . SMARTDrive is a disk-caching
program that uses your extended or expanded memory to reduce
the amount of time that is required for Windows to read informa-
tion from your hard disk . See Appendix C, "Speeding Up Windows
with SMARTDrive," for more information about SMARTDrive .
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Setting up Expanded Memory
for Use with Windows

To use expanded memory with Windows, follow these steps :

Check the README.TXT file included on your Microsoft Win-
dows Write Program disk or consult the documentation for
your expanded-memory hardware to make sure your expanded
memory manager supports Windows. Although your manufac-
turer provides an expanded memory manager with your board,
not all managers support Windows .
Install the expanded memory board according to your
manufacturer's instructions .
Install the expanded memory manager according to your
manufacturer's instructions. You may be required to modify
your computer's CONFIG.SYS file. If so, follow your manufac-
turer's instructions carefully and be prepared to restart your
computer to make sure the expanded memory manager is
loaded.

0

When installing the expanded memory manager, reserve as much
of your expanded memory as possible to use with Windows (and
SMARTDrive ). Avoid reserving memory for programs, such as
memory disks and print spoolers, that may compete with Win-
dows for expanded memory. The more expanded memory you let
Windows have, the more efficiently Windows can use the memory
for your applications .
Once expanded memory has been installed, you can start Win-
dows. Windows will then use expanded memory automatically
there are no additional steps you need to take .

Running Standard Applications
that Use Expanded Memory Specifications

The special expanded memory manager that is required for Win-
dows support is upwardly compatible with popular expanded
memory specifications (EMS). This means that standard applica-
tions that access memory using the expanded memory specifica-
tions supported by INTEL Above Board or AST RAMPage can still
access memory to store data when they are run with Windows . If
expanded memory is available, Windows provides the application
with the memory it requests through the EMS interface .



Using CHKDSK with Windows

It is recommended that you not use the DOS CHKDSK program
in Windows . If you do run it from Windows, do not use the /F
parameter. CHKDSK was not designed to run with Windows, and
using the /F parameter will close any files your Windows applica-
tions are using (such as temporary files).

Using SHIFT+PRINTSCREEN with Windows

Windows does not change the operation of SHIFT + PRINTSCREEN,

which is used to print images of standard applications . Since Win-
dows uses the graphics mode, you should see your DOS manual
for information on how to print a graphics screen . (You should
not press SHIFT + PRINTSCREEN unless you have a printer attached
and on line .) For general information on using SHIFT +PRINTSCREEN,
see your DOS manual .

Appendix E: Special Notes on Running Windows 243





Terms

Active Describes a window or icon that is selected ; the window
or icon to which the next keystroke or command will apply .

ANSI character set The American National Standards Institute
8-bit character set . It contains 256 characters .

Application A program used for a particular kind of work, such
as word processing or database management . See Windows appli-
cation, Standard application, Memory-resident application .

ASCII character set The American Standard Code for Informa-
tion Interchange 8-bit character set. The set consists of the first
128 (0-127) characters of the ANSI character set .

Boot To start up your computer, or to restart it, loading the
DOS operating system .

Check box A small square box that appears in a dialog box and
that can be turned on or off. Check boxes generally represent
multiple options that you can set .

Choose To perform an action that carries out a command in a
menu or dialog box. See Select.

Click To press and release a mouse button quickly . When you
click a mouse button, you may hear and feel a faint click .

Clipboard A storage area for holding text or data that you are
copying or moving .

Command A word or phrase, usually found in a menu, that you
choose in order to carry out an action .

Command button A large rectangular button that appears in a
dialog box and carries out or cancels an action when chosen . The
Cancel button always cancels the command. The OK button car-
ries out the command. Occasionally, instead of OK, the button
that carries out the action will have a label that describes the
action - for example, Open .

Control menu The menu that appears on every application that
runs in a window and on some full-screen standard applications .
Icons and some dialog boxes also have a Control menu . For
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applications running in a window and for icons and dialog boxes,
Control-menu commands move, change the size of, and close win-
dows. For full-screen standard applications, the Control-menu
commands are used for transferring information as well as for
other miscellaneous functions .

Control-menu box The small box that is located at the left in a
window's title bar. If you have a mouse, you can click this box to
display the Control menu or double-click it to quit Windows .

Copy To put a copy of the selected text or item on the Clip-
board so you can transfer it to another location . Many Windows
applications have a Copy command that performs this task . If you
are using a standard application, Windows adds the Copy com-
mand to the Control menu .

Default Describes an option, command, or device that is auto-
matically selected or chosen by the system . For example, in most
dialog boxes that contain command buttons, one of the buttons
is selected when the dialog box appears, indicating that it is the
default and will be chosen automatically if you press the ENTER
key. You can override a default by selecting the appropriate
option, command, or device .

Device driver A program that controls how your computer and
a device, such as a printer or monitor, interact . A device driver
enables you to use devices with your computer .

Dialog box A rectangular box that appears when Windows
needs further information before it can carry out a command or
when Windows is providing you with certain information. For
instance, if you choose the Delete command from the File menu
in the MS-DOS Executive window, a dialog box appears asking
for the name of the file that you want to delete .

Direct-access method A way to choose a command or to
select a menu or option by pressing the key that corresponds to
the underlined letter in the command, menu, or option name .

Directory Part of a structure for organizing your files into
convenient groups . A directory is like a file drawer that holds
a particular group of files . A directory can contain both files
and subdirectories .

Double-Click To rapidly press and release a mouse button twice
without moving the mouse . This action carries out a command .

Drag To press and hold down the mouse button while moving
the mouse. For example, you can move a window to another loca-
tion on the screen by dragging its title bar .



Drive icon The small symbol in the upper-left corner of the
MS-DOS Executive window that represents your computer's
disk drive .

Expanded memory Memory beyond the 640 kilobytes that
DOS makes available to applications . To use it you must install
an expanded memory board and special software .

Extend To select more than one item in a window .

Extended memory Memory beyond the usual 1-megabyte limit
of computers such as the IBM PC AT and compatible models . To
use it you must install an extended memory board and special
software . Extended memory generally is not accessible to DOS-
based applications (which include Windows applications) but can
be used by memory-disk programs such as IBM VDISK and Micro-
soft RAMDrive .

Extension The period and three letters at the end of a filename .
An extension identifies what kind of information a file contains .
For example, the extension .EXE, .COM, or .BAT indicates that a
file contains an application. Some applications append an exten-
sion to the files that you create with them. For example, files that
you create with Calendar have the extension .CAL .

Filename The name of a file. Windows uses DOS filenaming
conventions ; therefore filenames usually consist of a base name
containing no more than eight characters and a three-character
extension . For example, TERMINAL .EXE is the name of the file
that contains the Terminal application . See Extension.

Format To prepare a disk so that it can hold information . For-
matting a disk erases whatever information was previously on it .

Full-screen Describes a standard DOS application that takes up
the entire screen when it is run with Windows . It is not displayed
in a window .

Grayed Describes a command or option that is listed in a menu
or dialog box but cannot be chosen or selected . The command or
option appears in gray type. For example, after you have enlarged
a window to its full size, the Maximize command in the Control
menu is grayed .

Highlighted Indicates that the object is selected and will be
affected by your next action . A highlighted object appears in
reverse video. A highlighted icon is outlined in white and the
application's name is displayed .

Terms: C-H 247

F

G

H



L

M

248 Microsoft Windows User's Guide

N

Icon A small symbol that represents an application that is run-
ning in memory. You can enlarge an icon to a window when you
want to use the application . See Drive icon.

Inactive Describes a window or icon that is not selected . See
Select.

Insertion point The place that text will be inserted when you
type. The insertion point usually appears as a flashing vertical line
in an application's window or in a dialog box . The text you type
appears to the left of the insertion point, which is pushed to the
right as you type.

List box A box within a dialog box that lists all items that a
command could affect - for example, the filenames of all printer
drivers on a disk . Files are indicated by their filenames. Drives and
directories are indicated with brackets . Hyphens distinguish drives
from directories. For example, [-A-] represents drive A; [MYDIR]
represents the MYDIR directory . The parent directory (the next
higher directory) is represented by two periods within brackets
([ . . ] ) . If there are more choices than can fit in the list box, the list
box will have a vertical scroll bar.

Maximize box The small box containing an up arrow that is
located at the right of the menu bar . Mouse users can click the
Maximize box to enlarge a window to its maximum size .

Memory-resident application An application that is loaded into
the system and stays there until you remove it or turn off your
computer (also known as a terminate-and-stay-resident applica-
tion). You should start this kind of application before you start
Windows and use it from a full-screen standard application .

Menu A group listing of available Windows or application com-
mands. Menu names appear in the menu bar near the top of the
window. You use a command from a menu by selecting the menu,
then choosing the command .

Menu bar The horizontal bar that lists the names of an appli-
cation's menus . The menu bar appears below the title bar of a
window.

Minimize box The small box containing a down arrow that is
located at the right of the menu bar . Mouse users can click the
Minimize box to reduce a window to an icon .

Non-switching Describes a full-screen standard application that
you must quit before you can return to Windows . See Standard
application.



Open To make a file's contents available to work in ; it usually
refers to a file you created with an application and not to an appli-
cation file . For example, while working in Notepad, you could
open MEMO.TXT, a text file you created with Notepad. You could
also open MEMO.TXT and start Notepad at the same time by run-
ning MEMO.TXT from the MS-DOS Executive window .

Option button A small round button that appears in a dialog
box and selects an option when set . Within a group of related
option buttons, you can make only one selection .

Paste To transfer the contents of the Clipboard to an applica-
tion. Many applications have a Paste command that performs this
task .

Pathname A description of the location of a directory or file
within the system . For example, the pathname of a file consists
of a drive letter, followed by a directory name, one or more sub-
directory names if applicable, and a filename . Each name is
separated from the previous one by a backslash .

PIF file A program information file ; it contains information about
how a standard application uses system resources and memory . If
Windows cannot find a PIF file for an application, it uses default
PIF settings to run the application .

Point To move the pointer on the screen until it rests on the
item you want to select or choose .

Pointer A small symbol that appears if you have installed a
mouse and that indicates which area of the screen will be affected
when you click the mouse button. The pointer usually is shaped
like an arrow but changes shape during certain tasks .

Restore box The small box containing down and up arrows that
appears at the right of the menu bar after you have enlarged a
window to its full size . Mouse users can click the Restore box to
return the window to its previous size .

Run To start an application .

Save To store a file or changes to a file on a disk .

Scroll To move text or graphics up or down, or left or right, to
see parts of the file that cannot f t on the screen .

Scroll bar A bar that appears at the right side and/or bottom of
some windows and in some dialog boxes . The scroll bar contains
a scroll arrow at either end and a scroll box that moves within
the scroll bar, reflecting your position in a file . Mouse users can
click parts of the scroll bar to scroll a file .
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Select To indicate the item that the next command you choose
will affect. See Choose and Highlighted.

Shortcut key A special key or key sequence available for some
commands that you can press to execute the command without
first selecting a menu .

Spooler A Windows program that is automatically run when
you choose a print command. It allows you to print files and to
view and control the jobs in the print queue .

Standard application An application that runs under DOS but
was not designed especially for Windows .

Swap To temporarily transfer an application or information from
system memory to your computer's hard disk .

Switch To move from one application to another, bringing the
second application to the front of the screen and making it active .
This usually refers to moving from a standard application to
another standard application or to a Windows application . See
Non-switching

Text box A box in a dialog box in which you type information
needed to carry out a command. The text box may be blank
when the dialog box appears or may contain text if there is a
default option or if you have selected something applicable to
that command.

Title bar The horizontal bar across the top of each window that
contains the name of the application and/or file in that window .
The title bar also contains the Control-menu box and the Maxim-
ize and Minimize boxes or the Minimize and Restore boxes .

Wildcard character A character that can be included in a file-
name to indicate any character or group of characters that might
match that position in other filenames . In Windows you can use
the asterisk (*) as a wildcard character . For example, * .EXE
represents all files in the directory that end with the .EXE
filename extension .

Window A rectangular area on your screen in which you view
an application. Every window has a title bar and may have a menu
bar and one or two scroll bars .

Windows application An application that was designed espe-
cially for Windows and uses all Windows features (such as menus
and dialog boxes) .

Work area The area of a window that displays the information
contained in the file .



Index

1-2-3, running 241

About Control Panel command 195
About MS-DOS Executive command 193
About Spooler command 196
Accent characters 233
Active

See also Inactive
defined 245
icon 81
window 81

selecting 32
title bar 32, 65

Add New Font command 141, 195
Add New Printer command 139, 195
All command 17-18, 55, 122, 194
ALT key

Control menu 88
dialog box 92
previewing windows 83
selecting menus 12, 13-14, 17, 85
shortcut keys 89
special characters 235, 237
with underlined letter 17, 85

ALT, SPACEBAR 12, 37, 88
ALT+o 235, 237
ALT +ESCAPE 33, 8 3
ALT + F4 89
ALT + F5 89
ALT + F7 89
ALT + F8 89
ALT + F9 89
ALT+FIO 89
ALT + PRINTSCREEN 173
ALT + SHIFT + ESCAPE 83
ALT +SHIFT +TAB 84
ALT + TAB

previewing windows 83
restoring window 102
standard application 172

ANSI
call conventions 165
character set 233-235, 245
device driver 165

Application
See also Standard application
adding a command 192
Control menu 12, 48, 84
defined 245
disk 80
DOS-compatible 164
filename 113
graphics 185
information display 193
large 179, 186
loading 203
memory requirements 183, 184, 209
memory-resident 167, 186, 204, 205
mode 187
multiple 81, 178
name display 110
non-switching 248
pathname 183
PIF file 182
program parameters 184
quitting
Close command 192
Exit command 63
keyboard method 30, 106
mouse method 107

running
automatically 201, 203, 204
command 193
hard-disk system 11, 21
two-drive system 10, 20

running as icon
command 193
keyboard method 114
mouse method 115

screen exchange 187
special application 186
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Application (continued)
special character
non-Windows 237
"ets 233

standard See Standard application
starting

directory 184
keyboard method 80, 113, 114
mouse method 55, 81, 114
opening a file 115

window
display 114
fixed size 74, 96
inactive, message from 105

Windows-compatible 164
work disk 2

Arrow
four-headed
Move command 95
Size command 34, 98

scroll 105
two-headed

mouse pointer 66
Size command 35
window size 98

Arrow pointer See Mouse
Asterisk (*) See Wildcard character
AUTOEXEC.BAT file

standard application 169
startup disk 2
temporary files 120

Background color 148, 149, 207
BACKSPACE key 125
BASIC, running 240
BASICA, running 240
.BAT extension 15, 50
Batch file 129, 168
Baud rate 147, 195, 213
Beep, warning

message from inactive window 105
standard application 172
turning off 151
WIN.INI file 205

Bold type in syntax statements xvi
Booting defined 245
Border See Window
Border Width command 150, 196

Buffer
keyboard 185
screen 185

Build disk 2, 3
Bus Mouse

See also Mouse
jumper setting 239

By Date command 123, 194
By Kind command 123, 194
By Name command 123, 194
By Size command 123, 194

Cancel button
clicking 5 3
using 2 3

Canceling
command 86
dialog box 24, 95
menu 49, 50, 55, 86
Move command 38
printing 160

Capital letters xvi
Case sensitivity xvi
CGA card 143
Change Directory command 124, 194
Changes, saving 29, 62
Changing

border width 150, 196, 206
currency format 155
date format 154
directory

keyboard method 124
mouse method 125

disk drives
keyboard method 20, 31
mouse method 54, 64

filename 118
mouse button 151
mouse options 205
number format 155
PIF file 183
size of window See Window
time format 154
WIN.INI file 199
window

keyboard method 32
mouse method 65

Character sets
ANSI 233, 235



Character sets (continued)
description 233
extended ANSI 233
IBM PC extended 236
non-ANSI 235, 237

Check box
defined 245
description 91

Checkmark 14, 86, 122, 193
CHKDSK
command 3
program 216, 243

Choosing
command

basic method 13, 85
description 12, 48, 84
direct-access method 17, 85, 246
mouse method 50, 86

command button
keyboard method 94
mouse method 94

defined 245
CITOH printers 143
Clicking
command name 50, 86
Control-menu box 246
defined 245
description 8
dialog-box area 92
double-click rate 138, 200
drive icon 54, 126
icon 88
menu name 86
pathname 125

Clipboard
contents display 132
copying screen 173
defined 245
description 131
formatted files 133
information transfer 133
message 216
quitting 134
running automatically 203, 204
screen exchange 187
standard application 173
starting 132
swapping 179

CLIPBRD.EXE 132

Clock
icon 37, 71
running automatically 203, 204
setting time 136
starting

keyboard method 31
mouse method 64

Close command
application 107
confirmation 221
description 192
dialog box 95, 119
shortcut keys 89

Closing window 192
Color
command 196
monitor xiii
screen 148-150
WIN.INI file 207

Color Graphics Adapter 143
.COM extension 15, 50, 80, 113
.COM file, multiple 170
COMI 185
COM2 185
Comma (,) with keynames xvi, 12, 37, 88
Command
See also individual command names
About Control Panel 195
About MS-DOS Executive 193
About Spooler 196
Add New Font 141, 195
Add New Printer 139, 195
All 17-18, 55, 122, 194
appending 192
Border Width 150, 196
By Date 123, 194
By Kind 123, 194
By Name 123, 194
By Size 123, 194
canceling

keyboard method 86
Change Directory 124, 194
checkmarks 14, 86, 122, 193
CHKDSK 3
choosing

basic method 13, 85
description 12, 48, 84
direct-access method 17, 85, 246
mouse method 50, 86
shortcut keys 89

Index 253
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Command (continued)
clicking 50, 86
Close

application, closing 107
confirmation 221
description 192
dialog box 9 5, 119
shortcut keys 89

Communications Port 147, 195
Connections 145, 195
Control menu 192
Control Panel 195
Copy

Clipboard 133
description 193
file copying 116
information transfer 133
standard application 175

Country Settings 152, 153, 196
Create Directory 121, 194
Cut

Clipboard 132
using
keyboard method 28
mouse method 61

defined 245
Delete

description 193
directory 127
file 119

Delete Font 142, 195
Delete Printer 140, 195
dialog box 89
End Session

confirmation 108, 221
description 194
using
keyboard method 19, 43
mouse method 77

Windows, quitting 107
Exit

application 30, 106
confirmation 221
description 193
keyboard method 30
MS-DOS Executive 126
mouse method 63

File menu 193
Format Data Disk 128, 194
Get Info 118, 193

Command (continued]
grayed 88, 91, 247
High 159, 196
highlighted 13, 48
Installation menu 195
listing 191, 192, 194
Load 115, 193
Long 122, 193
Low 159, 196
Make System Disk 128, 194
Mark 174
Maximize

description 192
grayed 41
shortcut keys 89
using 40, 99

menu bar 6, 12, 48
Minimize

description 192
shortcut keys 89
using 36, 101

Mouse 151, 196
Move

description 192
shortcut keys 89
using 37, 95

MS-DOS Executive 192--194
Open

dialog box 23
keyboard method 23
mouse method 57

organization 12
Partial 122, 123, 194
Paste

Clipboard 133
standard application 175

Pause 160, 197
Preferences Menu 196
Print

description 193
directory listing 127
file listing 127
file 117

Printer 146, 195
Priority menu 159, 196
Programs

description 122, 194
using 14, 50
WIN.lNI file 202

Queue menu 159, 197



Command (continued)
Rename 118, 193
Restore

description 192
grayed 41
shortcut keys 89
using 41, 102

Resume 160, 197
Run 114, 193
Save 29, 62
Save As 29, 62
Screen Colors 148, 149, 196
Scroll 177
selected 48
Set Volume Name 129, 194
Setup Menu 195
Short 122, 193
Size

canceling 36
description 192
shortcut keys 89
using 34, 97

Special menu
description 194
selecting 19, 54

Spooler commands 159, 196
Terminate 160, 197
View menu

description 193, 194
selecting 18
WIN.INI file 201, 202

Warning Beep 151, 196
WIN 80

Command button
choosing 94
default 94
defined 245
description 90

Command name
clicking 50
underlined letter 17

COMMAND.COM 129
Communications port See Port
Communications Port command 147, 195
Communications programs 240
CONFIG.SYS file
SMARTDrive 227
startup disk 2

Configuring system 145
Connections command 145, 195

CONTROL key
drive, changing 126
selecting drive 111
selecting files 112
shortcut keys 89

Control menu
canceling

keyboard method 13
mouse method 49

commands 192
defined 245
description 12, 48
dialog box 95
grayed command 41
icon 82
selecting

keyboard method 40, 88
mouse method 48, 88

standard application
displaying 171
extra commands 171
window 166

using 87
Control Panel
commands 195
country settings 152
quitting 156
running 135
running automatically 203, 204
settings adjustment 135-156
starting 136

Control-menu box
description 6, 84, 246
selecting 48, 88

CONTROL.EXE file 136
CONTROL+PAGE DOWN 105
CONTROL + PAGE UP 105
Conventions xvi
Copy command

Clipboard 133
description 193
file copying 116
information transfer 133
standard application 175, 185

Copying
Clipboard 131
defined 246
file 116, 193
information transfer 133
message 217, 220
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Copying (continued)
multiple files 117
partial screen 173
prevented 186
printer file 139
screenful 173
WIN.INI file 199, 200

Corners, moving See Window
Country Settings command

canceling 153
changes, saving 156
description 152, 196
WIN.INI file 156, 211

Courier font 144
Create Directory command 121, 194
Currency format, changing 155
Currency settings 153, 211
Currency symbols 153, 233
Current directory
pathname 110, 121
printing 127

Cursor
blink rate

keyboard method 138
mouse method 138
WIN.INI file 201

dragging 175
standard application 174

Cut command
Clipboard 132
using

keyboard method 28
mouse method 61

Data disk See Disk
Date

format 154, 211
setting 137

Default
Country Settings command 152
defined 246
directory 184
printer 146

Definitions
mouse terms 8
parts of window 6
terms 245-250

Delete command
description 193

Delete command (continued)
directory 127
file 119

Delete Font command 142, 195
Delete Printer command 140, 195
Deleting

directory
message 218
procedure 127

file
command 193
filename 116
message 218
procedure 119

multiple tiles 119
printer-driver file 140
text

keyboard method 28
mouse method 61

Desktop Applications disk
contents xiii
listing xi
running application 20, 54
safekeeping 3
setup 3

Device driver defined 246
Device Not Selected setting 147
Device settings 214
Dialog box

areas 90
canceling 24, 95
closing 119
Control menu 95
defined 246
description 57, 90
moving in 21, 91
Open 57
PIF Editor 183
Save As 30
selecting area 24, 25, 92
selecting within area 92
using 89

Directly Modifies Memory option 179, 185
Directly Modifies Screen box 170, 185
DIRECTION keys

See also individual keynames
choosing commands 85
description xvi
dialog box 92
menus, selecting 13



DIRECTION keys (continued)
moving icon 38
moving insertion point 26
moving window 95
MS-DOS Executive 80
scrolling 104, 177
selecting filename 21, 111
Size command 34
standard application 174, 177
window border 98

Directory
changing
command 194
keyboard method 124, 125
message 217
mouse method 125, 194

creating
command 194
message 218
procedure 121
write protection 218

current
list box 5 7
pathname 110, 121
printing 127

defined 246
deleting

message 218
procedure 127

description 121
display 14, 50, 55
double-clicking 125
higher level 125
list box 90
listing

appearance 121, 122, 123
description 111
display 193, 194
options 121, 122, 123
other disks 126
printing 127, 193
programs 50
WIN.INI file 201

message 217, 220
multiple, display 126
name change 219
parent 90
pathname 110, 121
PIF file 168, 169, 182, 183
selecting 111

Directory (continued)
subdirectory

display 121
list box 23, 57, 90
pathname 110

temporary files
root 120
swapping 210

Windows 80
Disk

application 80
Build 2, 3
checking 216
contents display 126
damaged 216, 218
Desktop Applications

contents xiii
running application 20, 54
setup 3

erasing 128
faulty 216, 218
floppy 215
Fonts xiii, 2, 3, 141, 144
formatting
command 194
message 216, 218
procedure 128

full 219, 220
messages 215, 216, 218, 219, 221
naming 129, 194
Setup 2, 3
startup 2, 4, 80
system 2, 4, 80
Utilities

contents xiii
printer-driver files 139
setup 2, 3

work disk 2
Write xiii, 3
write-protected 217, 218

Disk drive See Drive
Disk-caching See SMARTDrive
Disk-drive icon See Drive icon
Display adapter 240
Document, saving edited 29, 62
DOS
CHKDSK command 3, 243
command execution 129
filename length 29, 62
returning to 107
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DOS (continued)
Windows version requirement xiii

Dotted box
dialog box 24, 58
MS-DOS Executive 112

Double-clicking
Control-menu box 246
defined 246
description 8
directory 125
filename 55, 81, 114, 116
icon 76, 103
pathname 126
rate 138, 200
Spooler icon 159

DOWN key
date adjustment 137
moving in command list 14
standard application, scrolling 177
time adjustment 137

Dragging
border 66
cursor 175
description 8
defined 246
I-beam 61
title bar 72, 95

Drive
icon 7
list box 57, 90
messages 215, 216
selecting

keyboard method 20, 31
mouse method 54, 64

Drive icon
clicking 126
defined 247
description 7, 110
highlighted 54
selecting
keyboard method 20
mouse method 54
MS-DOS Executive 111, 126

EGA card 143, 200
END key

list box 93
standard application, scrolling 177
text box 93

End Session command
canceling

keyboard method 20
mouse method 5 3

confirmation 108, 221
description 194
using

keyboard method 19, 43
mouse method 77

Windows, quitting 107
Enlarging

icon
keyboard method 99
mouse method 100

window
command 192
keyboard method 40, 99
mouse method 74, 99

ENTER key
application, running 80
choosing command 15, 85
command button 94
Move command 39, 95
selecting menu 14
Size command 36
standard application, scrolling 177
window size 98

Epson printers 143
Erasing

See also Deleting
disks 128

ESCAPE key
ALT + ESCAPE 8 3
canceling command 38, 86
canceling menu 13, 49
canceling selection 175
closing dialog box 119
scrolling standard application 177

.EXE extension 15, 50, 80, 113

.EXE file, multiple 170
Executive See MS-DOS Executive
Exit command

application 30, 106
confirmation 221
Control Panel 195
description 193
MS-DOS Executive 126
Spooler 196
using

keyboard method 30



Exit command (continued)
using (continued)
mouse method 63

Expanded memory
defined 247
SMARTDrive 225
swapping 178, 210
using 4, 241

Extending defined 247
Extended ANSI character set 233
Extended memory

defined 247
SMARTDrive 226, 242

Extension See Filename

File
AUTOEXEC.BAT 2, 120, 169
batch 129, 168
change date 118, 123, 193
contents 116
copying
command 193
message 217, 220
procedure 116
two-drive system 116

creation date 118, 123
deleting
command 193
filename 116
message 218
procedure 119

directory
creating 121
default 184
deleting 127

font 142
information 118, 193
list box 57, 90
listing

location 110
options 121-123, 202
printing 127
programs 50

message 217, 218, 220
multiple

copying 117
deleting 119

opening
keyboard method 23, 115

File (continued)
opening (continued)

mouse method 58, 116
one step 115, 207

PIF See PIF file
printer output 213
printer-driver

adding 139
deleting 140
multiple printers 141

printing
canceling 160
command 193
procedure 117
Spooler 157, 158, 159, 160, 196
without Spooler 160, 202

read-only 218
renaming 193
sample 25, 58
saving 29, 62
scattered

selecting with keyboard 112
selecting with mouse 113

selecting
keyboard method 21, 111, 112
mouse method 111, 113
MS-DOS Executive 111

size display 118, 123, 193
temporary 7, 120

File menu
commands 193
selecting
keyboard method 25
mouse method 57

Filename
ANSI characters 235
changing 118, 193
conventions 116
copying to same 217
defined 247
display 118, 193
double-clicking 55, 81, 114, 116
existing, saving under 29, 62
extension

defined 247
PIF Editor 182
programs 15, 50
required 116
setting 207
.TMP 7

Index 259
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Filename (continued)
length 29, 62
list box

clicking 58
highlighted 25

listing
location 110
options 121-123, 202
printing 127

message 218, 221
new, saving file under 29, 30, 63
selected 21, 58, 80
special character 235
standard application, starting 170
temporary 7, 120
text box 58, 63

Floppy disk 215
Font

adding 141, 195
deleting 142, 195
device 145
listing 144
names 144
raster 142
set number 143
settings 214
stroke 142

Font file
adding 142
deleting 142
purpose 141

Fonts disk xiii, 2, 3, 141, 144
Format Data Disk command 128, 194
Formatted text 133, 175
Formatting

defined 247
disk

message 218
procedure 128

disk message 216
Four-headed arrow
Move command 95
Size command 34, 98

Fractions 233
Full-screen application

defined 247
switching between 172

Function key See Shortcut keys

Get Info command 118, 193
Glossary 243, 244, 245, 247
Graphics

monitor xiii
printing termination 160
standard application 166
transferring between applications 173

Graphics card 150, 200
Grayed command 88, 91, 247

Hard-disk system
Maynard 239
space needed by Windows 3
swapping 178
Windows setup 3
Windows startup 5

Hardware requirements xiii
Hely font 144
Hercules Graphics Card 143
High command 159, 196
Highlighted

command 13, 48
defined 247
filename 58
selection 6, 110
text 61

holding down key combination 31
HOME key

list box 93
standard application, scrolling 177
text box 93

I-beam
dragging 61
moving 59

IBM Color Graphics Adapter 143
IBM Enhanced Graphics Adapter 143
IBM PC extended character set 236
IBM printers 143
Icon

active 81
application, running
automatic 203
command 193
keyboard method 114
mouse method 115
WIN.INI file 203

clicking 88



Icon (continued)
Control menu 82, 88
defined 248
drive

description 7
selecting with keyboard 20
selecting with mouse 54

double-clicking 76, 103
enlarging

keyboard method 99
mouse method 100

flashing 160
full-screen application 172
inactive, message from 105
menu, displaying 37
moving

keyboard method 37, 38, 95
mouse method 71, 95

position on screen 37, 71
restoring

keyboard method 102
mouse method 76, 103

selecting
keyboard method 37, 83
mouse method 83
order 83
title bar 31, 71, 82

shrinking window to
command 192
keyboard method 36, 101
mouse method 69, 101
purpose 101

Spooler 157
standard application 166
starting application as 193
title bar 37, 39, 71, 82

Inactive
command 88, 91
defined 248
window

message 105
title bar 32, 65

Input See Text
Inserting text
keyboard method 26
mouse method 59

Insertion point
blink rate 138, 200
defined 248

Insertion point (continued)
moving

keyboard method 26
mouse method 59

standard application, copying to 175
text box 24, 90

Installation Menu 195
International settings See Country Settings

command
Italic type in syntax statements xvi

Jumper 239

KB Desired 169, 179, 185
KB Required 169, 184
Key

See also individual keynames
combination xvi, 31, 83
keynames xvi
sequence xvi, 37, 88
shortcut 89

Keyboard buffer 185
Keynames xvi

Landscape mode 146
LEFT key

color setting 149
standard application, scrolling 177

Ligatures 233
List box

defined 248
description 90
moving in 93
Open dialog box 23, 5 7
scroll bar 90
selecting in

keyboard method 93
mouse method 94

List-separator symbols 153
Load command 115, 193
Loading application 203
Long command 122, 193
Lotus 1-2-3, running 241
Lotus Symphony, running 241
Low command 159, 196
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Make System Disk command 128, 194
Mark command 174, 185
Maximize box

defined 248
description 6
using 74, 99

Maximize command
icon 100
description 192
grayed 41
shortcut keys 89
standard applications, switching between 172
using 40, 99

Maynard hard disk 239
Measures settings 211
Memory

available, changing 190
copying screen 173
expanded

defined 247
swapping 178, 210
using 226, 241

expansion card 178
extended 226, 242, 247
message 221, 222
not enough 179, 168, 184, 221
PIF entry 209
requirement

application 184
standard application 208
Windows xiii

screen, direct access to 166
special application 186
standard application, running 179
swapping See Swapping

Memory-disk programs 226
Memory-resident application 167, 248
Menu
See also individual menu name
canceling

keyboard method 13, 86
mouse method 49, 50, 55, 86

color settings 148, 207
Control menu 87, 243
defined 248
drop-down x
File menu 25, 193
icon 37
Installation Menu 195

Menu (continued)
name

clicking 86
underlined letter 17

Preferences Menu 196
Priority menu 159, 196
Queue menu 159, 197
selecting

basic method 12, 13, 85
description 12, 48, 84
direct-access method 17, 85, 246
mouse method 49, 86

Setup menu 195
Special menu 194
View menu

description 193, 194
using 14, 122
WIN.INI file 201, 202

Menu bar
defined 248
description 6, 12, 48, 84, 110
moving across 14

Message
display 105
MS-DOS Executive 217
printing 160, 206
SMARTDrive 229
Spooler 160
Windows 215

Minimize box
defined 248
description 7
using 69, 101

Minimize command
description 192
shortcut keys 89
using 36, 101

Mnemonic See Underlined letter
Mode, application 187
Modern font 144
Mouse

application
quitting 107
running as icon 115
starting 81, 114

button
changing 151, 196, 205
using 8

clicking
defined 245



Mouse (continued)
clicking (continued)

description 8
Control menu 88
cursor-blink rate adjustment 138
date adjustment 137
defined 246
description 8
dialog box 92
directory

changing 125, 194
selecting 111

disk contents display 126
double-clicking

defined 245
description 8
rate adjustment 138, 139, 200

dragging
defined 246
description 8

Exit command 106
file, selecting 111-113
icon xvii, 8
installation 151, 200
jumper setting 239
Move command 88
moving 8
options

changing 151, 205
default 205
WIN.INI file 201

pointer
defined 249
description 6
I-beam 59
speed 152
two-headed arrow 66

pointing
defined 249
description 8

scrolling 105
Size command 88
speed 152, 205
support xiv, 239
techniques 8
text box 93
time adjustment 137
unresponsive 239
window

enlarging 99

Mouse (continued)
window (continued)
moving 95
shrinking to icon 101
size, changing 98

Mouse command 151, 196
Move command

canceling 38
description 95, 192
mouse 88
shortcut keys 89
using 37

Moving
dialog box, in 91
icon

keyboard method 37, 95
mouse method 71, 95

information 131
window
command 192
keyboard method 37, 95
mouse method 71, 95

MS-DOS Executive
application files

hard-disk system 21
two-drive system 47

application, running 113, 114
commands 1.92-194
description 12, 109
directory display 14, 17, 50
disk formatting 128
duplicate, quitting 126
file maintenance 7
multiple windows 126
parts 110
printing files 117
running automatically 203
selection, highlighted 110
space available 193
starting 47
starting Windows 80
system disk formatting 194
use 109

Naming disk 129, 194
Non-ANSI character set 237
Non-switching 248
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Notepad
filenames

extension 207
list box 2 3

Inserting text
keyboard method 26
mouse method 59

quitting 30, 63
starting

keyboard method 21
mouse method 55

WIN .INI file 199
Numbers settings 152, 153, 155, 211

Object
highlighting 111
moving to 111

OK button
choosing

keyboard method 20
mouse method 53

End Session command 19, 53
Okidata printers 143
Open button

clicking 58
using 23

Open command
dialog box 23, 57
using

keyboard method 23
mouse method 57

Opening a file
defined 249
keyboard method 23, 115
mouse method 58, 116

Option
check box 91
checkrnark 14, 86
default 91
grayed 91

Option button
defined 249
description 91
moving button 94
selecting 94

PAGE DOWN key
color setting 149

PAGE DOWN key (continued)
list box 93
scrolling 105 177

PAGE UP key
color setting 149
list box 93
scrolling 105, 177

Parameters See Program parameters
Parity 147, 195, 213
Partial command 122, 123, 194
Paste command

Clipboard 133
standard application 175, 185

Pasting defined 249
PATH variable 169
Pathname

application, running automatically 204
clicking 125, 194
Copy command 116
defined 121, 247
description 110
display 121
double-clicking 126
PIF file 169, 183
Run command 114

Pause command 160, 197
PIF directory 169, 182, 183
PIF Editor
Clipboard 187
dialog box 183
pathname 182
piping 184
purpose 181
starting 182

PIF file
application, starting 168
backup 183
changing 183
creating 182
default settings 188, 209
defined 249
editing 170, 183, 188
EGA card 240
help 190
listing 183
message 219
multiple 168, 169
options 184
pathname 183
PIF settings 208



PIF file (continued)
standard application

Directly Modifies Memory 179
KB Desired 179
running 168

TopView 165
.PIF extension 168
Piping 184
Placeholder xvi
Plus sign (+) with keynames xvi, 31, 83
Pointer, mouse

defined 249
description 6
I-beam 59
speed 152
two-headed arrow 66

Pointing
defined 249
description 8
menu name 49

Pop-up programs 167
Port

adding printer 140
BASIC 241
communications 147, 195
message 219, 220
printer 145, 195
serial 185
settings

Control Panel 147, 195
WIN.INI file 212, 213

swapping 185, 189
Portrait mode 146
Preferences Menu 196
Previewing

icon 83
order 84
window 83

Print command
description 193
directory listing printing 127
file listing 127
file 117

Printer
adding
command 195
fonts 143
port 140
procedure 139

color 146

Printer (continued)
connections 145
default 146, 195, 201
dot-matrix

adding 141
raster fonts 142

fonts settings 141, 143
message 215, 216, 218
options 146
ports 140, 145, 147, 195, 213
print-wheel 145
raster fonts 143
removing 140, 195
resetting 160
serial communications port 195
serial printer 147
settings 201, 214
setup 118, 145, 146, 147
status 160
TI 239

Printer command 146, 195
Printer Timeouts settings 146
Printer-driver file

adding 139
multiple printers 141
removing 140

Printing
background 157
canceling 160
current directory 127
directory listing 127
file
command 193
Spooler commands 196
without Spooler 160

file listing 127
files 117
interrupting 159
message delay 206
messages 160, 218
order 158
priority 159
queue 158
sending to file 213
speed control 159
stopping 159
without Spooler 202

PRINTSCREEN key 173, 243
Priority menu 159, 196
Program See Application
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Program parameters
PIF Editor 184
PIF file 183

Program, running
DOS utility program 129
message 219

Program Switch options 186
Programs command

description 122, 194
using 14, 50
WIN.INI file 202

Queue menu 159, 197
Queue, printer 158
Quitting

application
keyboard method 106
mouse method 107

Clipboard 134
Control Panel 156
MS-DOS Executive, duplicate 126
Spooler 161
standard application 179

Quitting Windows
command 193
confirmation 108, 221
End Session command 43, 77
Exit command 30, 64
keyboard method 19
mouse method 52
procedure 107
shortcut 107
temporary files 7

RAM disks 243
Raster fonts 142, 143
Read-only file 218
README.TXT file xiv, 242
Rectangle, empty 38, 71
Redirecting 1/0 184
Rename command 118, 193, 219
Resolution

screen, copying 173
switching applications 187, 240

Restore box
defined 249
enlarged window 100
using 75, 102

Restore command
description 192
grayed 41
shortcut keys 89
standard applications, switching between 172
using 41, 102

Restoring
icon
keyboard method 102
mouse method 76, 103

window
command 192
keyboard method 102
mouse method 75, 102

Resume command 160, 197
Retry button 215
Retry option 147, 213
RIGHT key

color setting 149
standard application, scrolling 177

ROM BIOS 165
Roman font 144
Run command

description 193
message 219
using 114

Run setting 204
Running application
command 193
defined 249
hard-disk system 21
two-drive system 20

Sample file, editing 25, 58
Save As command 29, 62
Save command 29, 62
Saving

changes 29, 62
defined 249
WIN.INI file 200

Screen
capturing 173
colors 148, 149, 150, 196
copying 173
directly modifies 185
full 166
memory, direct access 166
partial, copying 173
quitting standard application 179



Screen (continued)
resolution, fonts 143
snapshot 173, 187, 240
startup, display 6

Screen buffer 185
Screen Colors command 148, 149, 196
Screen Exchange options 187
Script font 144
Scroll arrow 94, 105
Scroll bar

defined 249
description 7, 105
list box 90, 94
MS-DOS Executive 111
presence 7

Scroll box 105
Scroll command 177
Scrolling

defined 249
keyboard method 104
mouse method 105
standard application 177

Selecting
Control menu 88
defined 250
description 81
dialog-box area 92
directory 111
drive
keyboard method 20, 31, 111
mouse method 54, 64

file 111
icon
keyboard method 37, 83
mouse method 83
order 83

in standard application 174
in text box 93
menu

basic method 12, 13, 85
description 12, 48
direct-access method 17, 85, 246
mouse method 49, 86

multiple files 112
scattered files

keyboard method 112
mouse method 113

text
keyboard method 28
mistake 28

Index 267

Selecting (continued)
text (continued)
mouse method 61

window
keyboard method 68, 83
mouse method 83
order 83

Selection
canceling

keyboard method 28, 111
mouse method 61, 111

deleting 28, 61
drive icon 126
extension 245
highlighted 6, 110
highlighting 111
indicated 81

Semicolon ( ;) in WIN.INI file 201
Serial communications card 219
Serial communications port

message 220
settings 147, 195

Serial mouse
See also Mouse
support xiv, 239

Set Volume Name command 129, 194
Settings

colors 148, 149, 196, 207
communications port 147, 195, 212
Control Panel 135-156
country See Country Settings command
currency 211
cursor-blink rate 138
date 137, 211
default 188
devices 214
fonts 214
international See Country Settings command
measures 211
mouse
WIN.INI file 205
double-click rate 138, 139

numbers 211
ports 147, 212, 213
printers 139, 140, 145, 146, 195, 201, 214
Spooler 200, 202
system 195
time 136, 137
time zone 211
WIN.INI file 199-214
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Setup
directory 80
disk 2, 3
hard-disk system 3
two-drive system 2
when to use 4

Setup menu 195
SHIFT key

canceling selection 111, 127
dialog box 92
previewing windows 84
selecting scattered files 113
selecting windows 83
standard application 174
text box 9 3

SHIFT +ENTER 115
SHIFT + PRINTSCREEN 243
SHIFT+TAB 92
Short command 122, 193
Shortcut keys 89, 250
Shrinking window to icon
command 192
keyboard method 36, 101
mouse method 69, 101

Size
command 34
ENTER key 36
fixed 96
window

changing with keyboard 97
changing with mouse 98

Size arrow See Size command
Size command

canceling 36
description 192
four-headed arrow 34
mouse 88
shortcut keys 89
using 34, 97

SMARTDrive
command line 228
expanded memory 225, 241
extended memory 226, 242
hard-disk system 231
hardware requirements 225
messages 229
setting up 227
swapping 227
working with Windows 226

Snapshot 173, 187, 240

Space available 193
SPACEBAR

canceling selection 111
Control menu, selecting 12, 88
list box 93

Special application
message 219
restriction 204, 205

Special character sets 233, 235, 237
Special characters
non-Windows document 238
typing 235

Special menu 19, 43, 194
Spooler

background work 157
commands 159, 196
defined 250
icon 157, 159
message delay 147, 201
messages 160
printing without 202
purpose 158
queue, viewing 158
quitting 161
startup 157
two-drive system 158
window 158

Standard application
Clipboard 173, 216
closing window 187
Control menu 166, 171
Copy command 175
copying from 173, 174
cursor 174
default program characteristics 168
defined 250
Directly Modifies Memory option 179
display 164, 170
display adapter 240
expanded memory 243
full-screen

Control menu 171
defined 247
icon 172
running 166
selecting in 175

icon 166
insertion point 175
KB Desired 179
large 179, 186



Standard application (continued)
memory

all available 190
PIF file 168
WIN.INI file 208

memory-resident, using 167
menu, direct-access method 172
message 217, 221
mode 175
moving between See Switching
multiple, running 178
Paste command 175
pathname 188
PIF file

default settings 188
directory 169
editing 170
editing required 188
multiple 168
running 168

PIF settings 208
pop-up program 167
quitting 179
returning to Windows 170
running

from batch file 168
in a window

determining whether it can 165, 170
PIF Editor 189

order 178
screen-sharing ix
scroll bars 177
Scroll command 177
scrolling 177
selecting in

canceling 175
keyboard method 1- 4
mouse method 174

SMARTDrive 225
special characters 237
starting

filename 170
PIF file 169
preferences 169

swapping 178, 179, 189
switching 172, 173
title bar 166, 179
viewing 177
window

capabilities 170

Standard application (continued)
window (continued)

switching to full-screen 172
Star Micronics printers 143
Starting

application
keyboard method 80, 113
mouse method 55, 81, 114

Clock 31, 64
PIF Editor 182
standard application

filename 170
PIF file 169

Windows 80
Startup 4
Startup disk

creating 2
removing 54
using 4, 80

Stop bits 147, 195, 213
Stroke fonts 142
Subdirectory See Directory
Swapping

communications port 179, 185
defined 250
description 178
disabling 210
expanded memory 210
floppy-disk drive 210
hard disk 185
message 221
order 211
PIF Editor 183, 189
prevented 186
settings 209
SMARTDrive 225, 227
swap area 209

Switching
applications 186, 240
defined 250
peI'nlitted viii

Symphony, running 241
Syntax statements xvi
System

font 144
resources 185
settings 135, 195

System disk
creating 2, 128, 194
defined 128
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System disk (continued)
formatting 128
using 4, 80

TAB key
dialog box 92
moving in dialog box 24
previewing windows 83

TEMP directory 210
Temporary files 7, 120
Terminal extension 207
Terminal font 144
Terminate command 160, 197
Text

color setting 207
deleting

keyboard method 28
mouse method 61

filename extension 207
formatted 133, 175
highlighted 28, 61
input, conventions xvi
inserting

keyboard method 26
mouse method 59

moving between applications See Standard
application

selected, canceling 28, 61
selecting

keyboard method 28
mouse method 61

Text box
defined 250
description 90
filename 63
insertion point 24
KB Desired 169
KB Required 169
moving in 93
selecting in 93

TI printers 239
Tilde (") character 7, 120
Time

format, changing 154
setting
keyboard method 136
mouse method 137

Time zone settings 211
Times Roman font See Tms Rmn font

Title bar
color setting 207
darkened 32, 65, 81
defined 250
description 6, 110
dragging 72, 95
flashing 160
gray 32, 65
icon 37, 39, 71, 82
standard application 166, 179

.TMP extension 7, 120
Tms Rmn font 144
TopView 165
Transferring information See Copying
Transmission Retry setting 146, 147
Two-drive system

setup 2
startup 4

Two-headed arrow
dragging mouse 68
Size command 35
window size 98

.TXT extension 23, 57
Typeface See Font

Underlined letter 17, 85, 92
uP key

date adjustment 137
moving in command list 14
standard application, scrolling
time adjustment 137

Utilities disk
contents xiii
printer-driver files 139
safekeeping 3
Windows setup 2, 3

Utility program
running 129
memory checking 185

Vector fonts See Stroke fonts
View menu
commands 193-194
selecting

direct-access method 17
mouse method 49

using 14, 122
WIN.INI file 201, 202

177



Volume name 219

Warning Beep command 151, 196
Wildcard character 123, 250
WIN application

screen-sharing ix
Spooler 157

WIN command 80
WIN.INI file

changes, effect of 199
color settings 207
comment lines 201
Control Panel changes 135
copying 199, 200
country settings 156, 211
customizing 199-214
device settings 214
editing 199, 200
extension settings 207
font settings 214
PIF settings 208
port settings 212
printer settings 1 95
program settings 202
re-installing Windows 200
run setting 204
saving 200
sections 199
Spooler setting 202
standard application 179
updating 200
window settings 200, 201

WIN.OLI) file 200
Window

active
description 81
selecting
keyboard method 32
mouse method 65

title bar 32, 65
application, display 114
border

changing width 150
dragging 66
moving with keyboard 34, 98
moving with mouse 66, 98
selecting with keyboard 34
Size command 34

border width 150, 196, 206

Window (continued)
bringing to front 33
capabilities 170
changing

keyboard method 32
mouse method 65

closing 192
color settings 148, 149, 196, 207
Control menu 87
Control-menu box 6
corner

moving with keyboard 36
moving with mouse 68, 98
selecting with keyboard 36

defined 250
definitions 6
description ix
drive icon, description 7
enlarging
command 192
keyboard method 40, 99
mouse method 6, 74, 99

fixed size 74
icon, position 71
inactive

message 105
title bar 32

invisible, selecting 68, 83
manipulating

keyboard method 31
mouse method 64

Maximize box
description 6
fixed-size window 74

menu bar 6
Minimize box 7
moving
command 192
keyboard method 37, 95
mouse method 71, 95

overlapping 22, 68
previewing 83
restoring
command 192
keyboard method 102
mouse method 75, 102

running application in 204
scroll bar 7
scrolling standard application 177

Index 271



272 Microsoft Windows User's Guide

Window (continued)
selecting

description 81
keyboard method 33, 68, 83
mouse method 65, 83
order 83
visible 66

shrinking to icon
command 192
keyboard method 36, 101
mouse method 69, 101
purpose 101

size
changing with keyboard 97
changing with mouse 66, 68, 98
command 192
DIRECTION keys 34

standard application, closing 187
title bar 6
transferring information between 131
WIN.INI settings 200, 201, 204
work area 6

Windows
character sets 233, 235, 237
configuration 145, 146, 147
description vii
directory 80
expanded memory 4
Maynard hard disk 239
mouse

button 8
description 8
moving 8

package contents xiii
quitting

confirmation 108, 221
End Session command 43, 77, 194
Exit command 30, 63, 193
keyboard method 19
mouse method 52
procedure 107
shortcut 107
temporary files 7

setup 2, 3, 200
slow response 178
space needed on hard disk 3
starting

description 80
WIN.INI file 199

startup 4, 5, 203

Windows (continued)
startup disk, creating 2
system disk, creating 2
unresponsive to mouse 239
updating 200
utility programs 185

Windows application, defined 250
WINOLDAP file 221
Word length 147, 195, 213
Work area

description 6
defined 250

Work disk 2
Write disk xiii, 3
Write protection 217, 218, 219

Zooming See Enlarging
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